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Important Safeguards

 

For your protection, please read all these instructions regarding your Cobalt 
Qube 3 and retain for future reference. 

 

1. Read Instructions

 

Read and understand all the safety and operating instructions before operating 
the appliance.

 

2. Ventilation

 

The Cobalt Qube 3’s bottom vents and fan opening are provided for ventilation 
and reliable operation of the product, and to protect it from overheating. These 
openings must not be blocked or covered. This product should not be placed in a 
built-in installation unless proper ventilation is provided.

 

3. Lithium Battery

 

The lithium battery on the system board provides power for the real-time clock 
and CMOS RAM. The battery has an estimated useful life expectancy of 5 to 10 
years. If your system no longer keeps accurate time and date settings, it may be 
time to change the battery. Contact Cobalt for service information.    

 

Warning: 

 

There is a danger of explosion if the battery is incorrectly 
replaced or replaced with the wrong type of battery. Replace only 
with the same or equivalent type recommended by the equipment 
manufacturer. Dispose of used batteries according to 
manufacturer’s instructions. 

 

Avertissement : 

 

Il y a danger d’explosion s’il y a remplacement 
incorrect de la pile. Remplacer uniquement avec une pile du même 
type ou d’un type équivalent recommandé par le fabricant. Mettre 
au rebut les piles usagées conformément aux instructions du 
fabricant. 

 

Achtung: 

 

Explosionsgefahr wenn die Batterie in umgekehrter 
Polarität eingesetzt wird. Nur mit einem gleichen oder ähnlichen, 
vom Hersteller empfohlenen Typ, ersetzen. Verbrauchte Batterien 
müssen gemäß den Anweisungen des Herstellers verwertet werden. 
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4. Power Cord    

5. Electrical Shock

 

To reduce the risk of electrical shock, do not disassemble this product. Take it to 
a qualified service person when service or repair work is required. Opening or 
removing covers may expose you to dangerous voltage or other risks. Incorrect 
reassembly can cause electric shock when this product is subsequently used.

 

6. Browsers

 

Both Netscape Navigator® and Microsoft® Internet Explorer have bugs that can 
cause intermittent, unexplained failures. When using a Web browser to interact 
with your Cobalt Qube 3, you may occasionally experience a browser failure. 
Released product versions of the browsers are usually more reliable than beta 
versions and later versions typically work the most reliably. A browser program 
failure, although annoying, does not adversely affect your Cobalt Qube 3’s data.

To use the Qube 3, you need a personal computer (attached to the network) that 
uses a Web browser (for example, Netscape Navigator, version 4.7 or later, or 
Microsoft Internet Explorer, version 5.0 or later). To manage the Qube 3 from the 
Server Desktop, you must enable cookies, cascading style sheets and Javascript 
on your browser (these features are normally enabled by default). 

!

 

Caution: 

 

The power-supply cord is used as the main disconnect 
device. Ensure that the socket outlet is located or installed near the 
equipment and is easily accessible. 

!

 

Attention : 

 

Le cordon d’alimentation sert d’interrupteur général. La 
prise de courant doit être située ou installée à proximité du matériel 
et offrir un accès facile. 

!

 

Achtung: 

 

Zur sicheren Trennung des Gerätes vom Netz ist der 
Netzstecker zu ziehen. Vergewissern Sie sich, dass die Steckdose 
leicht zugänglich ist. 



 

Cobalt Qube 3 User Manual v

 

Regulations and Information

 

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

• Re-orient or re-locate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help. 

In order to maintain compliance with FCC regulations, shielded cables must be 
used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is 
cautioned that changes and modifications made to the equipment without the 
approval of manufacturer can void the user’s authority to operate this equipment.

This equipment is in compliance with Underwriters Laboratories (UL) and is 
UL-listed.
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Preface

 

This user manual is for anyone who will set up the Qube 3 network server 
appliance for a group of users. You should be familiar with Microsoft® 

Windows

 

™

 

, Macintosh® or other operating systems, and Netscape Navigator®, 
Microsoft® Internet Explorer or other Web browsers.

This manual consists of the following chapters and appendices:

 

Chapter 1

 

 — “Introduction” on page 1 includes an overview of the Qube 3’s 
features. 

 

Chapter 2

 

 — “Setting up the Qube 3” on page 11 describes the hardware setup 
of the Qube 3 and the process to integrate the Qube 3 into the network. 

 

Chapter 3

 

 — “Qube 3 Services” on page 37 explains the features available on 
the Qube 3. 

 

Chapter 4 

 

— “Users Site” on page 63 explains the Qube 3 Web Mail and 
Address Book features. 

 

Chapter 5 

 

— “Administration Site” on page 95 explains the features of the 
Qube 3 Administration screen. 

 

Appendix A

 

 — “Using the LCD Console” on page 195 explains the LCD 
console functions. 

 

Appendix B

 

 — “Product Specifications” on page 207 lists the Qube 3 technical 
specifications.

 

Appendix C

 

 — “Upgrading the Qube 3” on page 211 explains how to upgrade 
the Qube 3 hardware.

 

Appendix D

 

 — “Advanced Information” on page 221 provides information on 
the high-speed serial port and the directory structure.

 

Appendix E

 

 — “Domain Name System” on page 227 gives an in-depth 
explanation of the DNS service.

 

Appendix F

 

 — “Licenses” on page 249 lists licensing information.

 

Appendix G

 

 — “Glossary” on page 257 provides a glossary of terms used in the 
Qube 3 manual. 
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 Chapter 1

 

Introduction

 

The Cobalt Qube 3 is a powerful and versatile network server. It fits easily within 
an existing network, and it enhances workgroup activities by providing many 
communication and collaboration services. 

 

Qube 3 services 

 

Here is a sample of what you can do with the Cobalt Qube 3: 

•

 

Web publishing. 

 

You can access a broad range of Web publishing 
capabilities for users and groups.

•

 

Email. 

 

The Qube 3’s email service allows you to communicate internally 
and externally to individuals and groups. It includes auto-forward and 
auto-response capabilities. You can even create mailing lists that include 
external users. To access your email on the Qube 3, you can use any standard 
email client software or the Qube 3’s integrated email client called WebMail. 

•

 

Shared access to the Internet.

 

 You can use the high-speed serial port to 
connect through an external analog modem or an Integrated Services Digital 
Network (ISDN) terminal adapter, or the second ethernet port to connect 
through a local area network (LAN), a cable modem, a digital subscriber line 
(DSL) or a leased line connection. Multiple clients can access the Internet 
through the Qube 3. 

•

 

File sharing. 

 

By displaying the Qube 3 on the desktop as a shared network 
device, you can move files easily to and from the Qube 3, using standard 
file-sharing capabilities.

•

 

Archived mailing lists.

 

 The Qube 3 creates an archive of the email 
messages between members of a mailing list. You can review the archive in 
the integrated WebMail client. 

These services can be used within an extranet or an intranet environment, or 
across the Internet. 



 

Chapter 1: Introduction

2 Cobalt Qube 3 User Manual

 

Documentation 

 

You can access the user manual in PDF format from the browser-based 
user interface (UI), known as the Server Desktop. If you have installed 
third-party software on the Qube 3, the relevant documentation is 
available on this screen. 

To access the PDF file for the user manual, click on the help icon in the top right 
corner. A separate browser window opens displaying a list of PDF files in the 
languages available. Click the link for the PDF in your preferred language; you 
can open the PDF file in the browser window or save it to your personal 
computer. 

 

Qube 3 hardware 

 

Figure 1 show the Qube 3 controls, indicators and connectors. 

The indicator light bar on the front of the Qube glows green when the Qube 3 is 
powered on. 

 

Figure 1.   

 

Qube 3 rear view  
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1. The 

 

PCI slot shield

 

 covers the PCI expansion slot of the Qube 3. This shield 
is removed when a PCI expansion card is plugged in. (See “Adding 
components to the Qube 3” on page 216.) 

2. The 

 

SCSI connector

 

 provides an Ultra SCSI connection (optional). 

3.

 

On/Off 

 

power switch. 

4. You can use the recessed 

 

Reset Password

 

 button if you forget the Qube 3 
Administrator password. (See “Resetting the Qube 3 Administrator 
password” on page 103.) 

5. The 

 

USB port

 

 provides a Universal Serial Bus connection. 

6. The 

 

Secondary Network Interface

 

 accepts a 10/100 BaseT network cable. 

7. The 

 

Primary Network Interface

 

 accepts a 10/100 BaseT network cable. 

8. The high-speed 

 

Serial port

 

 allows you to connect a standard 
(Hayes™-compatible) external analog modem, an Integrated Services 
Digital Network (ISDN) terminal adapter or a console. 

9. The 

 

Power socket

 

 receives the power connector from the power adaptor. 

10. The 

 

LCD Console

 

 allows you to enter network configuration information, 
reboot the Qube 3, reset the network configuration, reset the IP firewall 
filtering rules and power down the Qube 3. 

11. The 

 

LCD screen

 

 displays messages and values entered. Use the arrow 
buttons to toggle between choices or to enter values. (See “Using the LCD 
console to configure the network” on page 13.) 

12. The 

 

Security lock hole 

 

allows you to secure your Qube 3 with a standard 
security cable. 
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Qube 3 Server Desktop 

 

You access the Qube 3 Server Desktop with a Web browser such as Internet 
Explorer or Netscape Communicator. The Qube 3 Server Desktop consists of the 
the 

 

Administration

 

, 

 

BlueLinQ

 

, 

 

Programs

 

 and 

 

Personal Profile

 

 screens. These 
are described in the following sections. 

 

Administration screens 

 

If you are the Administrator and log in with the user name 

 

admin

 

, there are 
additional Administration and BlueLinQ buttons in the top menu bar which open 
the Administration screen (see Figure 2) and the BlueLinQ screen (see Figure 3). 
The Administration screen has a left menu bar with sub-menus under each 
category. The BlueLinQ screen provides tools for updating and installing the 
Qube 3 software and third-party software. These screens are described in 
Chapter 5, “Administration Site.”

 

Figure 2.   

 

Administration screen 
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Figure 3.   

 

BlueLinQ screen

 

Programs screen 

 

The 

 

Programs

 

 screen (Figure 4) is where you access the WebMail feature and 
manage the address book. The 

 

Programs

 

 screen is where Qube 3 users will 
spend most of their time when using the Qube 3.

 

Figure 4.   

 

Programs screen 
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Personal Profile screen 

 

The 

 

Personal Profile

 

 screen (Figure 5) is where users access and configure the 
personal settings on the Qube 3. 

 

Figure 5.   

 

Personal Profile screen  

 

Qube 3 usage requirements 

 

To use the Qube 3, you need:

• A 10/100BaseTX Transmission Control Protocol/Internet Protocol (TCP/IP) 
-based local area network (LAN). 

• A personal computer (attached to the network) that uses a Web browser (for 
example, Netscape Navigator, version 4.7 or later, or Microsoft Internet 
Explorer, version 5.0 or later). 

To manage the Qube 3 from the Server Desktop, you must enable cookies, 
cascading style sheets and Javascript on your browser (these features are 
normally enabled by default). 

• Network parameters, which you can obtain from your system or network 
administrator; these include the Qube 3’s assigned IP address, the subnet 
mask of your network and, if communicating with other networks, a gateway 
or router address. 

• An Internet service provider (ISP), if you plan to connect to the Internet.
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Customer Service and Technical 
Support

 

For Cobalt product information, visit the support section of the Cobalt Web site at 
http://www.cobalt.com/support/. The site includes a Knowledge Base that 
customers can query; a list of Frequently Asked Questions (FAQs) that provide 
additional information is also available through the Knowledge Base. 

 

General Cobalt information

 

In the U.S.A., call (888) 70-COBALT or (888) 702-6225, or send email to 
info@cobalt.com.

Outside the U.S.A., call +1 650 623-2500, or send email to info@cobalt.com.

In Europe, the Middle East and Africa, call +31 71 565 7000 (The Netherlands), 
or send email to info-emea@cobalt.com.

In Japan, send email to info-japan@cobalt.com.

 

Cobalt Technical Support and Service

 

Email contact 

 

You can contact Cobalt Networks Technical Support by email using the Online 
Email Support Form. This form provides us all the information we need to 
service your request in a timely fashion. 

Go to the URL http://www.cobalt.com/support/ and click on the 

 

Contact Support

 

 link. 

 

Technical Support telephone numbers 

 

In the United States, call (800) 266-4378. 

In Europe, Middle East and Africa, call +31 (71) 565-7070 (The Netherlands).

Customers in Japan can send email to support-japan@cobalt.com.
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Further resources and information 

 

Cobalt also offers the following additional resources and information.

 

Solutions that extend the functionality of the 
Qube 3

 

For solutions that extend the functionality of the Qube 3, visit the Online 
Solutions Directory on Cobalt’s Web site at the following URL:

http://www.cobalt.com/solutions/

 

Cobalt Developer Network

 

Cobalt provides a wide range of resources, such as technical notes and white 
papers, for developers of Linux applications for Cobalt platforms. Premium 
resources are also available. 

To register with the Cobalt Developer Network at no cost, visit the Web site at 
http://developer.cobalt.com/.

 

Discussion Groups 

 

Cobalt has made available a number of discussion groups through which users 
can share information. 

To view the current list of Cobalt discussion groups, type the URL 
http://www.cobalt.com/support/resources/usergroups.html in your Web browser. 
The names of the discussion groups show up as hypertext links. 

To subscribe to or unsubscribe from a discussion group, or to view previous 
postings to a group, click on the group name. A new browser window opens, 
displaying information about the discussion group.

New discussion groups are added periodically. The current groups include:

• an announcement list concerning Cobalt products 

• an information list for developers working on Cobalt products

• a user list for sharing information between users of Cobalt products 

• a security list for users to address network security issues on Cobalt products
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The Knowledge Base

 

Cobalt offers access to its online database of common installation and 
configuration problems and solutions. You can access the site at http://
www.cobalt.com/support/kb/. 

 

Online technical papers

 

For customers looking for more in-depth technical information, there are a 
number of technical papers available on Cobalt Networks’ Web site at 
http://www.cobalt.com/support/. 

 

Education

 

For those who desire a premium level of technical expertise with Cobalt 
Networks products, we offer a number of training courses. The intended audience 
includes end users, Cobalt resellers, system and network administrators, systems 
engineers, product developers, support technicians, consultants and trainers. You 
can access the site at http://www.cobalt.com/support/education/index.html/.

 

Solutions 

 

For customers looking for business-case information concerning Cobalt products, 
there are also a number of white papers available on Cobalt’s Web site at 
http://www.cobalt.com/solutions/.

 

Developers 

 

If you are a software or hardware developer, look for information at http://
developer.cobalt.com/.
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Before contacting Cobalt Networks 
Technical Support  

 

First, make an effort to resolve the problem on your own. Take note of all actions 
you perform and any error messages so that, if necessary, you can describe them 
to a member of the Technical Support team.

Refer to the user manual and to the Web-based resources such as Cobalt’s 
Knowledge Base, the online technical papers and the Solutions page, as 
described above.

 

To speed up your support call 

 

When contacting Cobalt Networks Technical Support, the more information you 
can provide, the better. Before you call or email, have the following information 
ready. 

• the serial number, located on the back panel, or the MAC address of the 
primary network interface, accessible through the Server Desktop, of your 
Qube 3 

• any additional software installed on your system

• any peripherals connected to your system

• any error messages you have received and the time when they occurred

• the process you were running or the changes you had made when the error 
occurred

• the steps you have taken to resolve the problem 

 

✍

 

Note:

 

 To receive Technical Support, you must first register your 
Cobalt product.
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 Chapter 2

 

Setting up the Qube 3

 

This chapter guides you through the process of connecting and configuring the 
Cobalt Qube 3 for your network and user community. A typical setup process 
takes less than 15 minutes, after which you can begin using all of the Qube 3 
services.

If the Qube 3 has been configured previously for a different network, refer to “Set 
up network” on page 196.

 

Qube 3 setup

 

The setup process occurs in two phases.

• “Phase 1: Making the connection” explains the physical connection of the 
Qube 3 to a power source and the network.

• “Phase 2: Setting up with the Web browser” explains the network integration 
process and allows the administrator to select services and create users and 
groups, using a computer with a valid Web browser.

 

Phase 1: Making the connection

 

Connecting to the network

 

Connect the primary network interface (10/100 BaseTX) of the Qube 3 to your 
local are network (LAN) with a twisted-pair ethernet cable; see Figure 6.
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Figure 6.   

 

Network connectors  

 

Connecting the power supply 

 

There are two parts to the power supply: the power supply unit and the 
country-specific AC power cord. 

Connect the power supply unit to the Qube 3 by pushing the connector into the 
multiple-source DC power socket; see Figure 6. Plug one end of the AC power 
cord into the power supply unit and the other end into an electrical outlet. 

 

Powering on the Qube 3 

 

Turn on the power by pressing the 

 

On/Off

 

 switch on the back of the Qube 3; see 
Figure 1 on page 2.

The hard disk spins up and the fan turns on. The light bar on the front of the unit 
blinks a few times and then glows steadily.

A number of status messages are displayed on the LCD screen as the Qube 3 
completes its boot process. 

!

 

Caution

 

: It is important to follow the proper power-down procedure 
before turning off the Qube 3. Refer to “Power down” on page 203.

Primary
network
interface

Secondary
network
interface

Serial
port

Power
socket
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Configuring network settings 

 

Now that you have made the network and power connections, you can configure 
the network settings. 

The Qube 3 requires specific network information in order to function properly. 
Depending on the network environment, the Qube 3 may be able to obtain all of 
the necessary information from a Dynamic Host Configuration Protocol (DHCP) 
server on the network. If so, the Qube 3 tries to configure itself with information 
from the DHCP server. The second option is to have the Qube 3 configure itself 
automatically. Finally, you have the option of configuring the Qube 3 manually, 
using the LCD console on the back panel; see Figure 7. 

Before you proceed, make sure you have the following information: 

• the IP address assigned to the Qube 3 

• the subnet mask of your network  

 

Using the LCD console to configure the network

 

Figure 7 shows the LCD console for the Qube 3. 

The LCD screen on the back of the Qube 3 displays two lines of text. The top line 
of the LCD presents instructions on data to enter; the bottom line displays the 
data already entered. Use the arrow buttons below the LCD screen to enter the 
required network information manually. 

Appendix A, “Using the LCD Console,” on page 195 provides more information 
about the LCD console.

 

✍

 

Note: 

 

A gateway or router address is not required for a Qube 3 that 
is only connected to a local area network (LAN). If you connect to 
another network through the Qube 3, you require a gateway 
address. If you connect to the Internet with a modem, you do not 
require a gateway. 



 

Chapter 2: Setting up the Qube 3

14 Cobalt Qube 3 User Manual

 

Figure 7.   

 

LCD console  

 

During startup, the LCD screen on the back of the Qube 3 displays status 
information about the boot process itself. When setting up the Qube 3, you use 
the LCD console to enter network configuration information. Once the Qube 3 is 
running, the LCD console is used to change network configuration information, 
reboot the unit and power down the unit. 

The arrow buttons function as follows:

The 

 

Left

 

 arrow button moves the cursor to the left. 

The 

 

Right

 

 arrow button moves the cursor to the right. 

The 

 

Up

 

 arrow button increases the digit located at the cursor position. 

The 

 

Down

 

 arrow button decreases the digit located at the cursor position.

The “select” button displays the next option.

The “enter” button accepts the information entered or the options 
displayed.
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Configuring the Qube 3 with a DHCP server on 
the network 

 

The Qube 3 first checks to see whether a DHCP server is present on the network. 
If there is a functioning DHCP server that is set up to serve leased IP addresses, 
the Qube 3 configures itself with the information received from the DHCP server. 
Once the boot process is completed, the top line of the LCD screen displays the 
fully qualified domain name of the Qube 3 and the bottom line displays the 
leased IP address.  

 

�

 

Important:

 

 To function properly over long periods of time, the 
IP address of the primary network interface on the Qube 3 must 
remain fixed, meaning that the DHCP server must not assign this 
IP address to a different machine at a later date. Unfortunately, 
some DHCP servers do not honor requests for permanent 
IP addresses. As a result, your Internet service provider (ISP) or 
network administrator may need to assign a different (and 
permanent) IP address to the Qube 3. If so, you will need to change 
the network configuration information. 

Coordinate any changes to the IP address, subnet mask or gateway 
address with your ISP. If your Qube 3 is integrated into a larger 
network, consult with your network administrator for this 
information. 
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Configuring the Qube 3 with the 
auto-configuration feature  

 

The auto-configuration feature allows you to set up a network through the 
Qube 3. The Qube 3 assigns itself an IP address and a subnet mask on the 
primary network interface. It also provides an internal host name (myserver) for 
the Qube 3 and a domain name (mydomain) for the new network. The Qube 3 
acts as a DHCP server and provides IP addresses to clients on the network.  

To use the auto-configure feature, select this option on the LCD screen after the 
Qube 3 has completed its boot process.  

• The Qube 3 assigns itself “10.6.18.1” as the primary IP address and 
“255.255.255.0” as the subnet mask. If 10.6.18.1 is not available, the Qube 3 
tries 10.6.18.2 and so on in succession until it finds one that is available. 

• If 10.6.18.1 through 10.6.18.5 are not available, the Qube 3 assumes that the 
10.6.18.x network is in use and aborts the auto-configuration procedure. The 
LCD screen prompts you to manually enter an IP address. Refer to 
“Configuring the Qube 3 manually” on page 17. 

!

 

Caution: 

 

The auto-configuration feature on the Qube 3 launches a 
DHCP server on your network. If you already have a network set 
up, do not use the auto–configuration feature. If you do not have a 
network set up, Cobalt recommends the auto-configuration method 
over the manual method. 

 

� Important: If you want to be able to send email out over the public 
Internet, you must have a valid external domain name. The 
“mydomain” domain name generated by the auto-configuration 
feature is not valid for external email. 

When you have obtained a registered domain name, change the 
domain name on your Qube 3. To do so, see “TCP/IP” on page 162. 

For more information on registering a domain name and a list of 
accredited registrars, visit the Internet Corporation for Assigned 
Names and Numbers (ICANN) at http://www.icann.org. 

✍
Note: The Qube 3 first looks for an existing DHCP server on the 
network. If it does not find one, it then offers the auto-configuration 
option on the LCD screen.
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• If the Qube 3 auto-configures successfully, it acts as a DHCP server and 
assigns to the clients IP addresses in the range 10.6.18.30 through 
10.6.18.249, a subnet mask of “255.255.255.0”, a primary DNS server 
address of “10.6.18.1” and a gateway or router address of “10.6.18.1”. 

• Once you have completed the browser-based setup of the Qube 3, change the 
TCP/IP settings for the clients on your network to “Use a DHCP server” 
(Apple) or “Obtain an IP address automatically” (Windows). 

Continue the setup process with “Phase 2: Setting up with the Web browser” on 
page 20. 

Configuring the Qube 3 manually  

If the Qube 3 is unable to find a DHCP server on the network and you do not 
choose the auto-configuration option, the LCD display reads: 

PRIMARY IP ADDR: 
000.000.000.000 

A blinking cursor appears on the second line of the LCD display. The following 
steps explain how to enter the required network information for the primary 
network interface. The secondary network interface is configured through the 
Web browser as described in the next section. 

�
Important: In this phase, you configure only the primary network 
interface. To complete this phase, you must know:

• the IP address assigned to the Qube 3

• the subnet mask of your network

✍
Note: A gateway or router address is not required for a Qube 3 that 
is only connected to a local area network (LAN). If you connect to 
another network through the Qube 3, you require a gateway 
address. If you connect to the Internet with a modem, you do not 
require a gateway. 
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An IP address consists of four numbers, ranging from 0 to 255, separated by 
periods (for example, 192.168.25.77); this is often referred to as “dot-quad 
notation”. 

To enter the IP address for the Qube 3: 

1. Use the arrow buttons on the LCD console to enter the IP address assigned to 
the Qube 3. 

2. Press the  button to accept the IP address. 

If the IP address is valid, the following prompt appears: 

PRIMARY NETMASK: 
000.000.000.000 

3. Enter the netmask of your network. 

4. Press the  button to accept the entry. 

If the netmask is valid, the following prompt appears: 

ENTER GATEWAY: 
000.000.000.000 

5. Enter the IP address of the gateway for your network. If your network does 

not have a gateway, do not enter a number. Press the  button to accept 

the default value of “000.000.000.000”.  

✍
Note: A gateway or router address is not required for a Qube 3 that 
is only connected to a local area network (LAN). If you connect to 
another network through the Qube 3, you may require a gateway 
address. If you connect to the Internet with a modem, you do not 
require a gateway. 
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6. Press the  button. 

The LCD displays: 

[S]AVE [C]ANCEL 

7. To save the configuration information, use the left and right arrow buttons to 

select [S]ave, and then press the  button. It pauses for a moment and 

then you will see:

Setting up Network  

After verifying and saving, the Qube 3 completes the boot process. The LCD 
screen shows several messages in succession before displaying the IP address 
assigned to the Qube 3. 

Configuration is complete when the LCD screen displays the IP address assigned 
to the Qube 3, for example: 

IP ADDRESS: 
192.168.25.77 

✍ Note: Selecting [C]ancel cancels the configuration and the 
LCD screen displays PRIMARY IP ADDR: again. You must repeat 
the entry process. 
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Phase 2: Setting up with the Web 
browser

 

The remainder of the setup process is performed through a Web browser on a 
computer on your network. Use one of the standard Web browsers such as 
Netscape Navigator (version 4.7 or later) or Microsoft Internet Explorer 
(version 5.0 or later) to do this. Once the setup process is complete, the Qube 3 
can be managed from any computer on the network with a valid Web browser. 

To use the browser to set up the Qube 3, follow these steps:

1. Launch a standard Web browser on a computer connected to the network.

2. Enter the IP address of the Qube 3 (displayed on the LCD screen on the back 
of the Qube 3) in the URL field of your browser, for example: 

3. Press 

 

Return 

 

(or 

 

Enter

 

) on your keyboard. 

If you configured the Qube 3 network settings successfully, the Cobalt Welcome 
screen appears; see Figure 8. 

The Setup Wizard synchronizes with the language preference configured in 
settings of your Web browser and displays the Welcome screen in that language. 
If the language selected in the browser preferences is not available on the Qube 3, 
the server defaults to the Administrator's choice of language.  

 

✍

 

Note:

 

 You cannot use accented characters (for example, ä, é, ñ) in 
the following items: 

• user names 

• group names 

• email addresses and email aliases 

• host names and domain names 

• the names of email folders in the WebMail program 

You can use accented characters.in descriptive fields, for example, 
in the Full Name field for a user or in the Remarks field describing a 
group. 
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Active Assist — Online Help 
Active Assist provides real-time context-sensitive help on the Server Desktop. 
When you move the mouse pointer over a context-sensitive area of the screen, a 
description of the item appears at the bottom of the browser page. 

Configuring the Qube 3 with the Setup Wizard 
To configure the Qube 3, enter information into the fields on the Setup Wizard 
screens. These fields are described in the sections that follow. 

The Setup Wizard is a series of screens that guide you through the setup process. 
After completing each step, click on the right arrow at the bottom to apply the 
changes and move on to the next step. You can click on the left arrow to return to 
a previous screen.

  

The Qube 3 performs automatic checks on the information entered and alerts you 
when an illegal value or a problem is encountered. When the information is 
entered correctly at each stage, the Qube 3 enters the changes in its configuration 
files before proceeding to the next step. Changes may take several seconds to 
complete.

Click Start to begin the Setup Wizard.  

✍ Note: For help with a particular item in the Setup Wizard, move the 
pointer over the item on the screen; help text appears at the bottom 
of the screen.



Chapter 2: Setting up the Qube 3

22 Cobalt Qube 3 User Manual

Figure 8.   Qube 3 Welcome screen  
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Language selection 

On the first screen of the Setup Wizard, you can select a different language for 
the Server Desktop UI. Select a language from the pull-down menu.  

The selected language applies to the Server Desktop UI, the messages and 
commands on the LCD screen and the alert messages that Active Monitor sends 
to the Qube 3 Administrator. 

Once the Qube 3 has been set up, an individual user can change the language 
displayed on the Qube 3. For more information, see “Personal profile” on 
page 89. 

License agreement 

You are presented with the Cobalt Network License Agreement screen. 

By clicking on the arrow button on this screen, you acknowledge receipt of and 
agreement with the terms and conditions set forth on the Warranty/Registration 
Card enclosed with your Cobalt Qube 3 and with the License Agreement shown 
in Figure 9. 

Read through the License and click the right arrow at the bottom. 

✍ Note: The language chosen in this step applies only to the user 
admin. When a new user accesses the Qube 3, the server 
synchronizes with the language preference configured in settings of 
the user’s Web browser and displays the Welcome screen in that 
language. 

If the language selected in the browser preferences is not available 
on the Qube 3, the server defaults to the Administrator’s choice of 
language. 
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Figure 9.   License Agreement  
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Administrator Settings 

The Administrator Settings screen appears; see Figure 10. The Qube 3 
Administrator is responsible for the following: 

• Setting up and maintaining the users, groups and services on the Qube 3 

• Responding to email alerts from the Qube 3 in order to forestall potential 
problems 

Figure 10.   Administrator Settings  
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To set up the Qube 3 for the Administrator, you must enter a Password in this 
field. For guidelines on choosing a password, see “Password guidelines” on 
page 26.  

Be sure to remember the password to access the Qube 3 Administration features 
in the future. 

If you forget the password or want to reset the password, see “Resetting the 
Qube 3 Administrator password” on page 103. 

If you want to change the password for the Qube 3 Administrator, see 
“Modifying account information” on page 90. 

Click the right arrow at the bottom to move to the next screen. 

Password guidelines 

Use the following guidelines when choosing a password: 

1. Use between three and sixteen alphanumeric characters. 

The valid characters include:  a-z  A-Z 0-9  %  !  @  $  ^  &  *  -  _  =  \  |  .  ,  
/  ?  ;  :  + 

2. Use both upper- and lower-case letters.  

3. Do not use a proper name. 

4. Do not use a word found in a dictionary. 

5. Do not use a date. 

6. Do not use a command word. 

7. Do not use a string of consecutive keys on a keyboard (for example, 
“qwerty”). 

✍ Note: We recommend that you reserve the email account admin for 
system messages and alerts only, and that you do not publicize this 
admin account. To send comments or suggestions to the Qube 3 
Administrator, create instead an email alias such as sysadmin for 
that user. 

For information on how to add an email alias, see “Adding an email 
alias for a user” on page 112. 

✍ Note: A password is case-sensitive.
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Time Settings 

The Time Settings screen appears; see Figure 11. Using the pull-down menus, 
enter the current date, time and time zone on the Qube 3. 

Click the right arrow at the bottom to move to the next screen. 

Figure 11.   Time Settings  
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User Settings 

The User Settings screen appears as shown in Figure 12. On this screen, you can 
add users to the Qube 3 and allocate the user disk space limits. The Qube 3 
Administrator can select how the Qube 3 generates the user name and set the 
default disk usage limits by clicking Edit User Defaults. 

Figure 12.   User Settings  

The Qube 3 Administrator, with the user name admin, has full control of the 
Qube 3 and manages the services on the Qube 3. The administrator can be added 
to a group as a regular member, up to a maximum of 32 groups.  

Click the right arrow at the bottom to move to the next screen.

✍
Note: To add users through the browser interface after the Qube 3 is 
set up, see “Adding a user” on page 107. 
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Group Settings

The Group Settings screen appears as shown in Figure 13. On this screen, the 
Qube 3 Administrator can create different groups of users. Each group has its 
own mailing list, Web site and file storage. Click Edit Group Defaults to 
configure the maximum allowed disk space that groups can use.  

You can modify the Groups on this screen. Click the green pencil icon next to the 
group that you want to modify. For more information, see “Modifying a group” 
on page 116. 

Click the right arrow at the bottom to move to the next screen. 

✍ Note: To add groups through the browser interface after the Qube 3 
is set up, see “Adding a group” on page 115. 
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Figure 13.   Group Settings  
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Network Integration 

Figure 14 shows the Network Integration screen; on this screen, you can do the 
following: 

• Assign a host name (for example, qube3) to the Qube 3. 

• Enter your domain name. The domain name is either the official domain 
name that is registered with an ICANN-accredited registrar (for example, 
“cobalt.com”) or an intranet domain name specific to your network. 

Coordinate the host name and domain name with your Internet service 
provider (ISP) to ensure the integrity of your network. If your Qube 3 is 
integrated into a larger network, consult with your network administrator for 
this information. 

This allows you to access your Qube 3 by host name and domain name, 
rather than only by IP address. 

• From the pull-down menu, select the method by which the Qube 3 connects 
to the Internet: 

• Gateway on a Local Area Network (LAN) 

• Cable Modem or DSL 

• Analog Modem or ISDN 

If you do not know how you connect to the Internet or if you do not want to 
set up your connection yet, you can also select “None or Intranet”. If you 
select “None”, you can set up your Internet connection in the Server Desktop 
once the Qube 3 is operating. See “Internet” on page 165. 

Depending on the method by which the Qube 3 connects to the Internet, a 
particular screen appears in the Setup Wizard. For a full description of the 
three different screens, see “Internet” on page 165. 

• Enter the IP address of your Domain Name System (DNS) server. A DNS 
server maintains a list of computer names and their IP addresses. The Qube 3 
needs access to this list on the DNS server in order to convert between 
IP addresses and names. This conversion is essential for sending and 
receiving email external to the Qube 3. For more information on DNS, see 
Appendix E, “Domain Name System,” on page 227.  

Click the right arrow at the bottom to move to the next screen. 

✍
Note: If you choose a type of Internet connection in the previous 
step and you do not specify a DNS server, the Qube 3 becomes a 
DNS server. 
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Figure 14.   Network Integration  
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Product Registration 

The Product Registration screen appears; see Figure 15. If you are connected to 
the Internet, you can register the Qube 3 by completing the online registration.  

If you are not connected to the Internet, the Product Registration screen does 
not appear. Fill out the Warranty/Registration card included in the packaging 
materials and return it to Cobalt Networks, Inc. By doing so, you will register 
your Qube 3, and receive notifications of system upgrades, security upgrades and 
new product information. 

Cobalt Networks, Inc.
555 Ellis Street 
Mountain View, CA 
USA  94043 

To register online at a later time, see “Information” on page 174. 

✍ Note: If you are not yet connected to the Internet, you cannot 
register online.
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Figure 15.   Online Registration  
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Completing configuration with the Setup Wizard

If you completed the Product Registration screen, click the right arrow at the 
bottom. 

Once the Qube 3 has been configured, the Administration site on the Server 
Desktop appears; see Figure 16. 

The buttons on the left side of Server Desktop provide access to the information 
and functions on this site. Move the mouse pointer over the menu buttons and a 
description of the Server Desktop features appears in the help text frame at the 
bottom. 

Documentation 
You can access the user manual in PDF format from the Server 
Desktop. If you have installed third-party software on the Qube 3, the 
relevant documentation is available on this screen. 

To access the PDF file for the user manual, click on the help icon in the top right 
corner. A separate browser window opens displaying a list of PDF files in the 
languages available. Click the link for the PDF in your preferred language; you 
can open the PDF file in the browser window or save it to your personal 
computer. 

Figure 16.   Administration site on the Server Desktop  
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 Chapter 3

Qube 3 Services

This chapter offers a brief overview of the services available on the Cobalt 
Qube 3. These services are described in detail in Chapter 4 and Chapter 5.

These services include: 

• Email and mailing lists 

• Web publishing 

• File sharing through Windows file sharing, AppleShare, and file transfer 
protocol (FTP) 

• Dynamic Host Configuration Protocol (DHCP) server 

• Domain Name System (DNS) server 

• IP Masquerading (also known as Network Address Translation [NAT]) 

• Redundant array of independent disks Level 1 (RAID-1) (available on the 
Qube 3 Professional Edition only) 

• Internet access through a high-speed serial port 

• Basic Firewall 

• Web Caching (available on the Qube 3 Business Edition and Professional 
Edition only) 

• Archived mailing lists 

• Lightweight Directory Access Protocol (LDAP) import and export 

• Backup and restore data 

• Installing software 

• Simple Network Management Protocol (SNMP) 

• Secure sockets layer (SSL) 
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Managing your personal profile
Registered users on the Qube 3 can manage their own Personal Profile, including 
changing their password, using a standard Web browser such as Netscape 
Navigator (version 4.7 or later) or Microsoft Internet Explorer (version 5.0 or 
later). The features accessible from this screen are: 

• Account 

• Email 

• Disk Usage 

• Personal Information 

For more information, see “Personal profile” on page 89. 

Using email on the Qube 3 
To use all of the Qube 3’s email capabilities, you must configure the email 
settings correctly. You must also configure your email client to send email to and 
retrieve email from the Qube 3. 

For more information on setting up email on the Qube 3, see “Email server 
overview” on page 129. 

WebMail client 
The Qube 3 offers an integrated email client called WebMail. You can access the 
WebMail feature in the Programs site of the Server Desktop. See “Overview of 
WebMail” on page 66. 
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Setting up your email client 
Ensure that the following information is entered into your email client on your 
personal computer.  

1. Email address. The format is either 

<username>@domainname (see the note below) or

<username>@hostname.domainname 

(for example, myname@qube3.cobalt.com) where:

• <username> is the user name assigned to you (for example, myname)

• <hostname> is the name assigned to the Qube 3 (for example, qube3)

• <domainname> is either the official domain name that is registered with 
an ICANN-accredited registrar (for example, “cobalt.com”), or an 
intranet domain name specific to your network. Obtain this information 
from your ISP. If your Qube 3 is integrated into a larger network, consult 
with your network administrator for this information.  

2. SMTP server. The format is hostname.domainname (for example, 
qube3.cobalt.com).

3. POP3 server. The format is hostname.domainname (for example, 
qube3.cobalt.com). 

4. IMAP server. The format is hostname.domainname (for example, 
qube3.cobalt.com). 

✍-

Note: If you check your mail through an external client (for 
example, Microsoft Outlook, Netscape Messenger or Qualcomm’s 
Eudora), you can enable an option to save a copy on the email 
server for a number of days. 

✍-

Note: To use the shorter email format <username>@domainname, 
you must enter the domain name in the email parameters table, in 
the field “Receive email addressed to these hosts/domains.” 

✍-

Note: Occasionally, an email application asks for an “incoming” 
mail server. The incoming mail server is the POP3 server. 
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Email aliases 
Each registered user on the Qube 3 must have a unique user name (for example, 
mary or john.smith or khoward). This user name is used to send or retrieve email.

The Email Alias feature allows you to create an arbitrary email address without 
creating a user account on the Qube 3. An email message addressed to the alias is 
forwarded to an existing email address. 

If you add more than one alias for a user, enter one alias per line. You can only 
use lowercase alphanumeric characters, periods (.), hyphens (-) and underscores 
(_) in the alias. 

Let us say that the XYZ Company has a Qube 3 and that the company’s domain 
name is xyz.com. The email addresses for the users of the Qube 3 is 
<username>@xyz.com. Employee Andrew Bose has a user name of “abose”; his 
email address is “abose@xyz.com”. 

A user can have several email aliases that point to a his or her user name. For 
example, Andrew Bose can have can have the aliases “andrew@xyz.com” and 
“andrew.bose@abc.com”. If he were an avid soccer player, he might want to use 
the alias “striker@xyz.com”. All of these aliases point to his user name <abose> 
at xyz.com. Email messages addressed to any of these aliases are forwarded to 
“abose@xyz.com”.

However, having a large number of aliases for each user can cause problems. If a 
new user is added and the user name that is automatically generated by the 
Qube 3 is already in use, a warning appears in the help text at the bottom of the 
screen, stating that <username> has already been taken by another person. The 
Qube 3 does not accept the New User entry. 

Following the previous example, let us say that Andrew Boisvert is a new 
employee at the XYZ Company. If he wanted to have “andrew” as his user name, 
the Qube 3 help text displays: 

“Sorry, you have entered a value for User Name that has already been taken 
by another person on this system. Please enter another value for User Name.” 

The Qube 3 verifies the alias that you enter. If the alias is already in use as a user 
name, as another user’s alias or as the name of a mailing list, the Qube 3 does not 
allow the new alias. 

A Qube 3 Administrator can also set up aliases such as webmaster@abc.com, 
info@abc.com, sales@abc.com, comments@abc.com or support@abc.com that 
point to a specific user name. 
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Email relaying 
Simple Mail Transfer Protocol (SMTP) service is different from Post Office 
Protocol (POP), telnet and file transfer protocol (FTP) services in that SMTP 
does not try to authenticate a user when an SMTP connection is made. Every 
email server on the Internet has to be able to deliver email to you, so the email 
servers must be able to connect freely to send the email. 

The Qube 3 accepts email if the recipient has a user account or an alias email 
account, or if the sending host (your client computer) is trusted to relay outgoing 
email messages to another domain. These trusts are defined by host or domain 
names, as well as by IP addresses and networks. A network is a range of 
IP addresses; a network can be as small as one IP address, but that is not very 
practical.  

If you have users who access your server through the Internet, ask your ISP 
which networks are used by their remote access (dial-up) equipment. If the ISP 
says the network 209.43.21.5/24 and 209.48.66.5/16, add “209.43.21.0” and 
“209.48.0.0” to the “Relay email from these hosts/domains” field of the Email 
Parameters menu. If your ISP gives you a list of 30 networks used by 30 points-
of-presence (which are regional ISP offices) across the country and your clients 
can dial in from any of them, then you must trust all 30 networks or these users 
cannot send email through your Qube 3.  

!
Caution: Some users advise you to open relay to all com, edu, net 
and other top-level domain addresses. However, doing so allows 
hosts belonging to com, edu, net and others to relay email through 
your Cobalt server; this relayed mail is often known as spam mail. 

Spam mail can appear as though it originated from your server and 
as a result, others may blacklist your server as a known spam site. If 
your server is blacklisted, many mail servers will not relay your 
email and your customers will not receive a large amount of their 
email messages. 

✍-

Note: By default, the domain name for the Qube 3 is allowed to 
relay email. 

If you do not want to allow email to be sent through the Qube 3, 
enter the domain name of the Qube 3 in the “Block Email From 
Hosts/Domains” field. You will be able to download email but not 
be able to send outgoing email messages through Qube 3. 

For more information, see “Configuring the email settings” on 
page 131. 
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POP-before-SMTP feature 
The Qube 3 provides an option to allow POP authentication before SMTP. To 
enable this feature, see “Configuring the email settings” on page 131. 

Normally, you only permit email relaying from within your own network. But 
some users travel and connect from other places (for example, sales people or 
field engineers) and you want to let those users relay email through your server. 
The way to allow this and still protect your Qube 3 from being used to relay spam 
mail is to authenticate the user through POP before establishing an SMTP 
connection. 

When a user logs in for POP3 email, the Qube 3 notes the IP address from which 
the connection was made and permits relay from that IP address for a limited 
time. Travelling users need only check their email to “unlock” the mail server; no 
changes to the client mail software are necessary. 

The POP-before-SMTP implementation causes the IP addresses to expire after 
15 minutes. 

Mailing lists 
A mailing list allows you to send messages to a certain group of people without 
having to address them individually. You can create a mailing list comprising 
users registered on the Qube 3 as well as email addresses external to the Qube 3. 

When the Qube 3 Administrator creates a group, a mailing list is automatically 
created for that group. 

The email messages between members of a mailing list can be continuously 
archived, allowing a user to review a thread of email messages. If you are a 
member of a mailing list (either for a group or an independent mailing list), a new 
item, Mailing Lists, appears in the left menu bar of the WebMail program on the 
Programs site. You can view the archived email messages through the Mailing 
List link.  

For more information on viewing archived mailing lists, see “Mailing Lists” on 
page 77. 

For more information on managing mailing lists, see “Group List” on page 113. 

✍
Note: By default, the Archive option is OFF for mailing lists. 
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Developing Web pages 
The Qube 3 automatically provides a default home page for each individual user 
and each group. It also supports a broad range of Web publishing capabilities that 
allow both novice and expert users to build and publish custom Web pages.  

FrontPage 2000 Server Extensions 
The Qube 3 includes the FrontPage® 2000 Server Extensions, which allow you 
to use the FrontPage client application to publish and edit Web content easily. 
You can create and post Web pages using standard style templates and pre-
configured tools—including form processing and search tools. It is not necessary 
to know anything about FTP or other file transfer protocols.

The Qube 3 Administrator can enable Microsoft FrontPage Server Extensions for 
Web page development on the root Web site. 

When you enable FrontPage Server Extensions on the Qube 3, a FrontPage client 
webmaster account is created and you must provide a password for the 
webmaster account. See “Web settings” on page 141. 

The “webmaster” account simply means that when you log in to the root web 
(http://<your.host.domain>/) using FrontPage, your user name is webmaster and 
the password is whatever you entered in the Web Settings table.  

If FrontPage Server Extensions are enabled, the Web Settings table shows a 
check box indicating that the feature is enabled. If you disable FrontPage Server 
Extensions and save the changes, the Web Settings table refreshes to show the 
feature as disabled and a webmaster password field is now displayed in the table. 
If you re-enable FrontPage Server Extensions, you must provide a password 
again. 

✍-

Note: To access your home page, enter the URL
http://<hostname>/~<username>/, where <hostname> is the fully 
qualified domain name of your Qube 3 and <username> is your 
user name on the Qube 3. 

You must include the tilde mark (~) before your user name. 

✍
Note: The webmaster account does NOT have Web, email or FTP 
service. It is simply an account to use in the FrontPage client. 
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If you do not enter a password after you enable FrontPage Server Extensions and 
then try to save changes, the Server Desktop does not accept the changes. An 
error message appears at the bottom of the screen, informing you that you must 
enter a password for the webmaster account. 

Once the webmaster has authenticated through the FrontPage client, he or she 
can:

• modify Web content 

• create and manage FrontPage subwebs 

• add, modify or remove additional FrontPage user accounts 

• change the webmaster password 

Using an HTML editor 
You can create Web pages using any of the standard HTML editors and the 
HTML publishing capabilities of many popular desktop productivity 
applications. You can create and link the Web pages themselves on your desktop 
computer, and then move them to the appropriate subdirectory in the Qube 3 
through an FTP application; see “Publishing Web pages using FTP” on page 45. 

CGI scripts

The Qube 3 supports common gateway interface (CGI) scripts, such as those 
written in Perl or C, as well as Unix shell scripts. 

CGI scripts allow you to develop highly interactive, powerful Web-based 
applications by building server-side CGI scripts that generate Web pages in 
response to specific user inputs. These applications range from simple scheduling 
and conferencing applications to sophisticated electronic commerce solutions. 

You can develop CGI scripts on your desktop machine and then transfer them to 
the Qube 3 through an FTP-based application that allows the permissions to be 
set to “Executable”. 

CGI scripts must use .pl or .cgi filename extensions in order to be executed by the 
Web server. 
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Use FTP to upload .cgi and .pl files; use ASCII mode to upload CGI files. Once 
the file is on the Qube 3, use your FTP program to make the script executable. 
You can also use the telnet command:

chmod 775 <filename>.cgi 

The path to Perl is

/usr/bin/perl/ 

To set the access rights specifying who is allowed to run CGI scripts, see “Web 
settings” on page 141. 

PHP 

The Qube 3 is pre-configured with support for embedded PHP scripts. You can 
save PHP files in any directory on your site, provided that the file ends with 
a .php extension. 

Publishing Web pages using FTP
After creating your Web pages, you can publish them on the Qube 3 using FTP.

Ensure that you have the following information: 

• the host name or the IP address of your Qube 3 

• your user name and password 

• a filename of your choice to save as your main page (the default filename is 
index.html) 

Launch your FTP software and establish an FTP link to the Qube 3. Upload your 
HTML files. If you need help, consult the instructions for your FTP application. 

By default, the files you upload using FTP are stored in your personal directory. 
The path to your personal directory is: 

/home/users/<username>/ where <username> is your user name

Upload your Web page into the directory 

/home/users/<username>/web/ 
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Sharing files and transferring data 
You can access or connect to the Qube 3 through your desktop computer as you 
would any other shared network volume. The Qube 3 can be mounted from a 
Windows or Macintosh computer—it appears as a mounted volume on your 
desktop computer. 

The method of connecting to the Qube 3 varies, depending on your computer’s 
operating system. The Qube 3 offers several methods for transferring data. Use 
the following guidelines to decide which method is appropriate:

• Windows file sharing (Server Message Block [SMB]) for Windows 95, 
Windows 98 and Windows NT 

• Apple file sharing (AppleShare) for Macintosh 

• File Transfer Protocol (FTP) on all platforms. Advanced users use FTP to 
transfer files 

Windows File Sharing, FTP and Appleshare are enabled by default; guest share is 
not enabled by default. For more information, see “File Services” on page 137. 

Once you have mounted the Qube 3, you can copy and move individual files and 
entire subdirectories to and from the Qube 3 by dragging and dropping. 

Using Windows file sharing (SMB) 
Windows-based machines use a file-sharing protocol called Server Message 
Block (SMB) or Common Internet File System (CIFS). Once SMB is set up, the 
Qube 3 appears in your Network Neighborhood as a machine named 
<hostname>. The <hostname> is the name that the Qube 3 Administrator 
assigned to the Qube 3, either in the Setup Wizard or the File Services section of 
the Qube 3 Administration Site. 

Clicking the <hostname> icon in Network Neighborhood opens a window that 
provides an overview of the files and subdirectories that you can access. 

Before you begin: Windows 95 and Windows 98 users

The user name on the Qube 3 must be identical to the user name on your 
computer before you can access your subdirectory on the Qube 3. If necessary, 
restart your computer and log in as a new user, using the user name and password 
that are stored on the Qube 3. 

If your Windows password does not match the Qube 3 password, you are 
prompted for the Qube 3 password when you first connect to your Qube 3 
through Network Neighborhood. 
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Setting up Windows file sharing for Windows 95 
and 98

1. If the user name is the same on both your computer and the Qube 3, go to 
Step 6 

2. If the user name on your computer is different from the user name on the 
Qube 3, click the Start button in the bottom left corner of your screen.

3. Select Shut Down. The Shut Down Windows dialog appears.

4. Within the Shut Down Windows dialog, select “Close all programs and log 
on as a different user”. Click Yes.

Your computer closes any applications that are running, logs you out and 
prompts you with an Enter Network Password menu. 

5. Enter the same user name and password that are stored on the Qube 3. Your 
computer logs you in. If your Windows password does not match the Qube 3 
password, you are prompted for the Qube 3 password when you first connect 
to your Qube 3 through Network Neighborhood on your Windows desktop. 

6. Double-click on the Network Neighborhood icon. The Qube 3 (listed as the 
<hostname> assigned to the Qube 3) should be included in the listing.

7. If the Qube 3 is not listed, double-click on the Entire Network icon to cause 
your computer to scan the entire network for devices that can be shared. 
Select the name of the workgroup/domain of which the Qube 3 is a member. 
The default workgroup for the Qube 3 is WORKGROUP. 

You can also use the Find feature in Windows to locate the Qube 3. 

• Click Start in the bottom left corner of the Windows screen.

• Select Find and then Computer. The Find:Computer dialog appears.

• Enter the hostname of the Qube 3 in the field and click Find Now. The 
results appear in a window below the Find:Computer dialog.  

✍-

Note: It can take up to 15 minutes for a Windows PC to update its 
network information so that the Qube 3 is visible in the Network 
Neighborhood. The Find feature should produce quicker results. 
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8. Once the Qube 3 shows up in the Network Neighborhood list, double-click it 
to open it on your desktop computer. A password prompt appears. Enter the 
user name and password used on the Qube 3; the password is case-sensitive. 

9. Click OK. 

10.  If you are using a workgroup name other than WORKGROUP, the Qube 3 
may not appear in Network Neighborhood immediately. 

• To view your current workgroup name, click Start in the bottom left 
corner of the Windows screen. 

• Select Settings and then Control Panel. The Control Panel window 
appears. 

• Select Network. The Network dialog appears. 

• Select the Identification tab. The computer name, workgroup and 
computer description are displayed. Make note of the workgroup name 
and return to Step 7.  

Setting up Windows file sharing for Windows NT 

1. Double-click the Network Neighborhood icon. If you are using the 
WORKGROUP domain or workgroup names, the Qube 3 (listed as 
<hostname>) should be included in the list. 

If the Qube 3 is not listed, double-click on the Entire Network icon to have 
your computer scan the entire network for devices that can be shared. Select 
WORKGROUP. 

2. Once the Workgroup server list is visible, double-click the Qube 3 that you 
want to access. You can log into the Qube 3 as the Qube 3 Administrator or 
as any one of the registered users.

3. You may see a password prompt (depending on how your computer has been 
configured). If so, enter the user name and password used on the Qube 3; the 
password is case-sensitive.

✍-

Note: The Qube 3 Administrator can change the server workgroup 
name in File Services > Windows so that it matches your Windows 
95/98 workgroup name.

See “Windows file sharing (SMB)” on page 137.
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4. Click OK. 

5. You may want to log in to the Qube 3 as a different user. If you see a 
password prompt in Step 3, you can do so. 

However, if your Windows NT account uses the same user name and 
password as the Qube 3, account, the password prompt in Step 3 will not 
appear. In this case, you must first exit your Windows NT session. 

• From the Start menu, select “Shut down the computer”. The Shut Down 
Windows NT dialog appears. 

• Select the radio button “Close all programs and log on as a different 
user”. The computer closes all programs and logs out as the current user. 
A password prompt then appears for a new user. 

• Enter the enter the user name and password. 

• Click OK. 

Using AppleShare 
The Macintosh file-sharing protocol is called AppleShare. If AppleShare is 
enabled in the Setup Wizard or in the Administration section on the Server 
Desktop, the Qube 3 appears as an AppleShare volume in the Macintosh’s 
Chooser.

1. From the Apple menu in the top left corner, select Chooser. The Chooser 
dialog appears.

2. In the window on the left, select AppleShare.

3. In the list in the scrolling window on the right, double-click the Qube 3 you 
want to access (listed as <hostname>).

“Connect to the file server...” appears in the dialog box.

4. Select Registered User. Enter the user name and password used on the 
Qube 3; the password is case-sensitive.

5. Click OK. A dialog displays the volumes on the Qube 3; if a volume is not 
accessible, it is grayed-out. 

6. Double-click the volume(s) you want to access:

• Home — provides access to group directories

• [<username>] — provides access to user directories

7. Click OK. The selected volume appears on the desktop.
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Using AppleShare over IP 
The Qube 3 supports the use of AppleShare over IP, which means you can access 
your Qube 3 across an intranet or over the Internet. The Qube 3 shares its volume 
through AppleShare over IP by default. 

If you want to connect to a remote AppleShare volume over the Internet:

1. From the Apple menu in the top left corner, select Chooser. The Chooser 
dialog appears. 

2. In the window on the left, select AppleShare. 

3. In the left corner, click Server IP Address. The Server IP Address dialog 
appears. 

4. Enter the fully qualified host name or IP address of the Qube 3 that you want 
to access. 

5. Click Connect. 

Using FTP 
File Transfer Protocol (FTP) is typically available on platforms that support 
Transmission Control Protocol/Internet Protocol (TCP/IP), which are the 
underlying protocols used by the Qube 3. FTP is designed for transferring 
individual files. 

1. In your FTP application, enter the IP address or the host name of the Qube 3. 

2. Enter your user name and password. 

You are logged into the user home directory. Refer to the documentation for 
your FTP program for instructions on transferring files.  

✍-

Note: The user home directory is not the same as the Qube 3’s root 
directory. Many HTML publishing programs that use FTP require 
full path names to transfer files. 

For example, the home directory for user Bill Lumbergh is accessed 
through the URL 
ftp://<hostname.domainname>/home/users/blumbergh/. 
The “sales” group home directory is accessed through the URL 
ftp://<hostname.domainname>/home/groups/sales/. 
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Dynamic Host Configuration Protocol 
(DHCP) server
The Dynamic Host Configuration Protocol (DHCP) allows the Qube 3 to assign 
automatically the network configuration information (such as IP address, domain 
name, DNS service, subnet mask and gateway) to client computers that support 
DHCP, including Macintosh and Windows desktop computers.

The Qube 3 Administrator can enable the DHCP feature on the Qube 3 so that the 
Qube 3 is able to assign automatically the network information necessary for 
your desktop computer.

For more information on setting up DHCP on the Qube 3, see “Dynamic Host 
Configuration Protocol (DHCP) server” on page 146. 

What is DHCP and what are the benefits?
DHCP is a way for a computer on a network to obtain its TCP/IP settings when it 
boots up. With DHCP configured and enabled, a network administrator does not 
need to configure workstations manually, or modify networking settings when 
computers move or the network changes. This saves time and expense.

What is a configuration?

The Qube 3 DHCP configuration includes the default gateway, DNS servers, 
WINS server, subnet mask and IP address from an address pool. 

What are leases?

When the Qube 3 sends a configuration to a requesting DHCP client, one of the 
DHCP options returned to the client is the lease time. The lease time tells the 
DHCP client how long it can use the IP address. Before the lease time expires, 
the DHCP client sends a lease renewal request to the Qube 3. The Qube 3 then 
sends back to the client a renewed lease time, along with any other settings that 
have changed (for example, new IP address[es] for the DNS server).

A short lease time is useful in a network that has a limited number of 
IP addresses at its disposal.
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How does DHCP work?

DHCP requires a client and a server. The following steps briefly describe how a 
DHCP server provides a client with its proper TCP/IP configuration: 

1. When booted, a DHCP client broadcasts a request, known as a DHCP 
Discover, looking for a DHCP server to provide TCP/IP settings. DHCP 
clients are found in most TCP/IP software suites for PC, Macintosh and 
UNIX workstations. 

2. The Qube 3, as a DHCP server, receives the DHCP Discover request from a 
client and sends a reply, known as a DHCP Offer, to the DHCP client. 
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3. The DHCP client verifies the DHCP Offer it has received from the Qube 3 
and sends back an acknowledgment (ACK) message to the Qube 3.  

4. The Qube 3 responds to the client, reserves the IP address, acknowledges the 
client’s acceptance of the offer and delivers the configuration information. 

Domain Name System (DNS) 
The Domain Name System (DNS) is a vital and integral part of the Internet. 
Setting up DNS correctly on your Qube 3 is very important. For this reason, we 
have created an appendix solely for explaining DNS. See Appendix E, “Domain 
Name System,” on page 227.

The appendix covers the following items: 

• basic DNS issues 

• advanced DNS issues 

• a quick start guide detailing a sample setup of DNS for a Qube 3 

• a brief history of the DNS service 

If your network administrator is using the Qube 3 as a DNS server, you can enter 
the IP address of the Qube 3 into the “DNS server” field in the TCP/IP 
configuration on your desktop computer. 



Chapter 3: Qube 3 Services

54 Cobalt Qube 3 User Manual

IP Masquerading (NAT)  

The IP Masquerading feature simplifies and conserves IP addresses by presenting 
a single IP address for a private network to the public network. IP Masquerading 
enables private IP intranetworks that use non-registered IP addresses to connect 
to the Internet. IP Masquerading is both a security measure and a method of 
conserving IP addresses. 

On the Qube 3, IP Masquerading functions as a router connecting two networks 
together. IP Masquerading advertises only one IP address for the entire network 
to the outside world. This provides additional security, since the entire internal 
network is hidden from the outside world behind that single IP address. 

For outgoing packets, IP Masquerading translates a private IP address (an 
IP address that is not globally unique) on the internal network into the legal 
address of the secondary interface; packets are then forwarded onto the Internet.  

✍ Note: IP Masquerading is also known as Network Address 
Translation (NAT). 
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For incoming packets, IP Masquerading does the opposite. IP Masquerading 
receives a packet from the Internet and translates the legal address of the 
secondary interface into the private IP address on the internal network.  

RAID-1 support 
RAID-1 is available on the Qube 3 Professional Edition only. 

A redundant array of independent disks (RAID) is a way of storing the same data 
in different places (thus, redundantly) on multiple hard disks. A RAID appears to 
the operating system to be a single logical hard disk. 

There are a variety of different types and implementations of RAID, each with its 
own advantages and disadvantages. The Qube 3 Professional Edition implements 
RAID Level 1 (RAID-1), also known as disk mirroring, which consists of a 
primary hard disk and a secondary hard disk; the secondary hard disk is an exact 
copy or “mirror image” of the primary hard disk. 

Although RAID can protect against disk failure, it does not protect against 
operator and administrator (human) error, or loss due to system errors. 

The Qube 3 configuration uses Software RAID, meaning that it implements 
RAID in the software and requires no extra hardware. 

You do not need to enable RAID-1 on the Qube 3; it is enabled by default. You 
cannot disable RAID-1 on the Qube 3. 
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Hardware failure 
If one of the hard drives fails, the Qube 3 can function with one hard drive, but 
the server can no longer provide disk mirroring. To restore RAID service, you 
must shut down the Qube 3 and replace the failed hard drive. For more 
information on replacing a hard drive, see Appendix C, “Upgrading the Qube 3”.

For a failed drive, Active Monitor indicates that the Drive A or Drive B has failed. 
Drive A is the drive next to the side wall of the chassis; Drive B is on the inside. 
The drive letters are stamped on the slots of the drive bay for the hard drives. 

If RAID fails on the Qube 3, the system indicates the non-RAID status in two 
ways: 

• An email is sent to the Qube 3 Administrator. 

• In the Administration section, under Active Monitor > Status, the RAID 
circle changes to red. 

Once you replace a failed drive on a Qube 3 and reboot the server, the system 
detects the new hard drive. It then automatically begins to synchronize the new 
hard drive to the existing hard drive so that the server will be able to provide disk 
mirroring.  

Internet access through high-speed 
serial port 
The Qube 3 is equipped with a high-speed serial port to which you can connect 
an external modem or an Integrated Services Digital Network (ISDN) terminal 
adapter. If you have (or can obtain) a standard point-to-point protocol (PPP) 
dial-up account with an Internet Service Provider (ISP), a phone line and a 
modem, your Qube 3 can provide Internet access for your network—no router is 
required. 

For more information, see “Configuration for an analog modem or ISDN” on 
page 169. 

✍
Note: During the synchronization process, the Qube 3 cannot 
provide disk mirroring but it can still serve requests.
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Basic Firewall 
For more information on configuring the firewall, see “Basic Firewall” on 
page 149. 

For the definitions of the policies, see “Policy definitions” on page 153. 

A firewall provides network security through a set of rules that restrict the flow of 
information between your Qube 3 and your network. It is also used to control the 
information that your Qube 3 allows to pass between different networks (such as 
your company’s intranet and the public Internet. 

When information is transmitted between your Qube 3 server and a network (for 
example, during an FTP file transfer or when fetching a Web page), the 
information is divided into small blocks of data called packets. Each packet 
contains a header which is used to direct the packet to its destination. The header 
contains information such as the destination address and source address of the 
packet, and indicates the software program that should receive the packet. 

The Qube 3 ships with a type of firewall that allows you to accept or reject 
packets based on the information found in the header of a packet. This is known 
as an IP-packet-filtering firewall. 

The type of IP-packet-filtering firewall implemented on the Qube 3 is the 
standard ipchains firewall system which is compiled into the Linux kernel. You 
can configure the ipchains firewall through the Qube 3’s browser-based Server 
Desktop.   

!
Caution: Basic Firewall is an advanced feature of your Qube 3 
server. This feature is not recommended for novice users.

✍
Note: The Web Caching feature on your Qube 3 (available on the 
Qube 3 Business Edition and Professional Edition only) relies on 
the Basic Firewall feature to operate. If you enable the Web 
Caching feature, the Basic Firewall feature is enabled 
automatically. 

If you disable the Basic Firewall feature, the Web Caching feature 
is still enabled but will not function. To ensure that the Web 
Caching feature is functioning, re-enable the Basic Firewall feature.

For more information, see “Web Caching” on page 60. 
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Rules and chains 
A packet-filtering rule consists of a set of criteria, and an action to take if a packet 
matches the criteria (this action is called the rule’s policy). Criteria for a rule can 
consist of items such as the machine from which the packet originated, the 
destination of the packet and the network interface through which the packet is 
moving. Typically, a rule’s policy accepts or rejects the packet; if rejected, the 
packet is discarded from the system. 

Rules are organized into ordered lists called chains. When a chain of rules is 
applied, the firewall system tests the packet against each rule in sequence. If a 
packet meets the criteria of a rule, the action specified by the policy is taken; the 
packet is not evaluated against the subsequent rules. If a packet does not meet the 
criteria of a given rule, the packet is evaluated against the next rule in the chain. 

Chains can also specify a default action to apply to packets that do not meet the 
criteria of any of the rules within the chain. 

The Qube 3 allows you to configure three different rule chains, which are applied 
to packets at different stages of a packet’s lifecycle within the Qube 3. These 
three chains are known as:

• Input chain. The input chain is applied against all packets entering the 
Qube 3 through a network interface. 

• Forward chain. The forward chain is applied against all packets being 
forwarded through the Qube 3 to another computer.

• Output chain. The output chain is applied against all packets attempting to 
leave the Qube 3 through a network interface.  

✍
Note: The output chain is applied against both existing packets 
being forwarded through the Qube 3 and new packets created by 
local services on the Qube 3. 



Basic Firewall

Cobalt Qube 3 User Manual 59

The lifecycle of a packet within the Qube 3 
When a packet enters the Qube 3 server through a network interface, the firewall 
system applies the input chain against the packet before it is allowed to proceed 
any further into the system. 

If the input chain rejects or denies the packet, the Qube 3 discards the packet.

If the input chain accepts the packet, the Qube 3 then makes a routing decision 
about the packet: either to pass the packet to a local process (such as the Web 
server on the Qube 3) or to schedule the packet to be forwarded to another 
computer. 

If the packet is scheduled to be forwarded, the firewall system applies the forward 
chain against the packet. If the forward chain rejects or denies the packet, the 
Qube 3 discards the packet. If the forward chain accepts the packet, the firewall 
system applies the output chain against the packet. 

If a packet attempts to leave the Qube 3 through a network interface, the firewall 
system applies the output chain against the packet. If the output chain rejects or 
denies the packet, the Qube 3 discards the packet without transmitting it. If the 
output chain accepts the packet, the firewall system allows the Qube 3 to transmit 
the packet. 

The output chain tests both existing packets that have just passed the forward 
chain as well as new packets created by local services on your Qube 3 (for 
example, the Web server responding to a request for a Web page). 

To sum up the ipchains process: 

• any packet entering the Qube 3, destined for a local service on the Qube 3, 
must pass the input chain of rules 

• any packet originating within your Qube 3, destined for another computer, 
must pass the output chain of rules 

• any packet entering your Qube 3 and being immediately forwarded to 
another computer must pass all three chains of rules: input, forward and 
output 
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Web Caching 
Web Caching is available on the Qube 3 Business Edition and Professional 
Edition only. 

The Qube 3 offers a caching feature. When the caching feature is enabled, the 
Qube 3 acts as a caching proxy server for Web clients.  

Web cache servers are network servers that store frequently used content, such as 
Web pages and graphics, closer to the requesting clients so that subsequent 
accesses are served from the local server. It works as follows: when the browser 
requests a Web page from the network, the Web cache server intercepts the 
request. If the cache server has an up-to-date copy, it returns the copy to the client 
immediately. If the cache does not have a copy, it fetches one from the source of 
the content, saves a copy for future requests and returns the result to the client. 

The key benefits of caching are: 

• Faster response times from the Web. Once an object is cached, subsequent 
requests by a client for that object do not have to access the public Internet. 
Cached objects are held much closer to the client making the request and are 
retrieved much more quickly. 

• Cost savings. In some locations (for example, in Europe, Asia and 
Australia), a client is charged a fee for each megabyte (MB) of data 
transferred. By having the object cached locally and not having to transfer it 
over the Internet again, a client avoids extra charges. 

• Reduced network bandwidth requirements. Having an object cached 
locally means that content does not have to travel over congested wide area 
networks (WANs), thus conserving bandwidth. 

For more information on Caching, see “Web Caching” on page 144. 

✍ Note: The Web Caching feature on your Qube 3 relies on the Basic 
Firewall feature to operate. If you enable the Web Caching feature, 
the Basic Firewall feature is enabled automatically. 

If you disable the Basic Firewall feature, the Web Caching feature 
is still enabled but will not function. To ensure that the Web 
Caching feature is functioning, re-enable the Basic Firewall feature. 

For more information, see “Basic Firewall” on page 57. 
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Support for Lightweight Directory 
Access Protocol (LDAP) 
Lightweight Directory Access Protocol (LDAP) is a client-server protocol for 
accessing a directory service. 

The Qube 3 supports looking up user and group information through an LDAP 
client. For example, using a standard email client such as Netscape, Eudora or 
Outlook, you can use the address book feature of the email client to look up email 
addresses of users on the Qube 3. 

For more information on LDAP, see “LDAP Directory” on page 117. 

Back up and restore data 
The backup feature on the Qube 3 allows the Qube 3 Administrator to perform 
full or incremental system backups, on a manual or scheduled basis. 

The data can be backed up to a Windows (SMB) fileshare, a Network File System 
(NFS) share or to a File Transfer Protocol (FTP) server. 

For more information on backing up your data, see “Backup” on page 175. 

If the Qube 3 fails, you can fully restore the system from a backup set or you can 
restore the system to a special network fileshare in order to restore selected files 
only. 

For more information on restoring backed-up data, see “Restore” on page 178. 

Secure sockets layer (SSL) 
The Qube 3 Administrator can administer the Qube 3 
through secure sockets layer (SSL). SSL is provided in 128-
bit encryption code and offers a secure Web connection to 
the end user. The implementation of SSL on the Qube 3 is 
based on mod_ssl and BSAFE cryptographic software from 
RSA Security. 

A secure connection means two things: encryption and authentication. 
Encryption ensures that no one can snoop the connection between the browser 
and the Qube 3; authentication ensures the client, through a certificate, that the 
server is who they say they are. The security is assured on two levels. 
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At the network level, the first time the browser connects to a server, the browser 
stores the server’s certificate. This is the encryption part of the secure connection. 
Each time the browser “thinks” that it is communicating with this same server, it 
verifies that this same certificate is used to assure the secure connection. 

At a higher level, a server’s certificate is “signed” by a trusted external authority 
that the browser knows about, such as VeriSign. This is the authentication part of 
the secure connection. The server information (country, state, city, organization) 
is encoded into the certificate and certificate request. The external authority signs 
your request and guarantees that your server information is legitimate. 

For example, if a Web site sends a signed certificate saying that it comes from 
Cobalt Networks in Mountain View, California, United States, the end user can 
trust (due to the signed certificate from the external authority) that this Web site is 
indeed run by this company located in this city. 

A self-signed certificate is a certificate that has not been signed by an external 
authority. A self-signed certificate simply ensures that an encrypted Web 
connection is in place; it does NOT provide authentication to a user that the 
server is who they say they are. 

On the Qube 3, a self-signed certificate is generated by the Qube 3 during 
configuration.

For more information on authentication, encryption and secure sockets layer, 
refer to Appendix G, “Glossary”. 

Install software 
You can add new software to the Qube 3 through the browser interface. You can 
install new software obtained either from the Cobalt Networks Web site or from a 
CD supplied by Cobalt Networks. You can also add third-party software. 

For more information, see “BlueLinQ” on page 190. 

Simple Network Management 
Protocol (SNMP) 
Simple Network Management Protocol (SNMP) is a network management 
protocol used almost exclusively in TCP/IP networks. SNMP provides a means to 
monitor and control network devices, and to manage configurations, statistics 
collection, performance and security on a network.
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 Chapter 4

 

Users Site

 

This chapter describes the functions that Qube 3 users can perform with the Web 
browser interface which include the following: 

• WebMail 

• Address Book 

• Mailing Lists 

• Personal Profile  

 

✍

 

Note:

 

 You cannot use accented characters (for example, ä, é, ñ) in 
the following items: 

• user names 

• group names 

• email addresses and email aliases 

• host names and domain names 

• the names of email folders in the WebMail program 

You can use accented characters.in descriptive fields, for example, 
in the Full Name field for a user or in the Remarks field describing a 
group. 
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Overview of users site 

 

When a user other than the Administrator logs into the Qube 3, the Server 
Desktop consists of the 

 

Programs

 

 and 

 

Personal Profile

 

 screens which are 
selected with tabs at the top of the screen. 

The 

 

Programs

 

 screen is where Qube 3 users will spend most of their time when 
using the Qube 3; see Figure 17. Users access the WebMail feature and manage 
the address book on the 

 

Programs

 

 screen. 

The 

 

Personal Profile

 

 screen allows users to configure their personal settings on 
the Qube 3; see Figure 18.  

 

Help icon 

 

You can access the user manual in PDF format from the Server 
Desktop. If the Qube 3 Adminstrator has installed third-party software 
on the Qube 3, the relevant documentation is available on this screen. 

To access the PDF file for the user manual, click on the help icon in the top right 
corner. A separate browser window opens displaying a list of PDF files in the 
languages available. Click the link for the PDF in your preferred language; you 
can open the PDF file in the browser window or save it to your personal 
computer. 

 

Logout icon 

 

There is a Logout icon in the top right corner of the Server Desktop. 
Click this icon to log out of the system. 

 

✍

 

Note:

 

 To reduce the number of steps in each procedure, you may 
see the menu commands are grouped together and shown in 

 

bold

 

 
type face. Right angle brackets separate the individual items. 

For example, select 

 

Programs > Address Book > Users 

 

means to 
click the 

 

Programs

 

 tab in the top menu bar, click the 

 

Address 
Book 

 

menu category in the left menu bar and finally click the 

 

Users 

 

sub-menu item.
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Figure 17.   

 

Programs screen  

 

Figure 18.   

 

Personal Profile screen  
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Overview of WebMail  

 

The Cobalt Qube 3 provides users with an integrated email client called 
WebMail. With WebMail’s intuitive, easy-to-use interface, users can 

• send email messages to other registered users, groups and mailing lists on 
the Qube 3 or to external recipients 

• reply to messages received and forward messages 

• create folders and move messages between them 

• create an automatic vacation response 

• enter an email address to which WebMail messages are forwarded 

• if you belong to a certain group or mailing list on the Qube 3, review the 
archive of email messages among the members of a mailing list. 

Users can also add external recipients to an address book on the Qube 3 and send 
email from the Address Book feature. The Address Book feature is closely tied to 
the integrated WebMail client. For more information, see “Address book” on 
page 80. 

 

✍

 

Note: 

 

WebMail uses the IMAP email server. If the Qube 3 
Administrator disables the IMAP server; users cannot access 
WebMail. 

The IMAP server is enabled by default. 

 

✍

 

Note: 

 

The Qube 3 Administrator must enable the Archive option for 
the mailing list. For more information, see “Mailing Lists” on 
page 123. 
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To access WebMail: 

1. From the Server Desktop, select 

 

Programs

 

. The Programs screen appears, 
with a menu list on the left. 

2. Click 

 

WebMail

 

. A separate browser window opens for the WebMail 
program with one option at the top. 

3. Under the tab 

 

Messages

 

, you can:

• compose a message 

• view your folders 

• add or delete folders 

4. If you belong to a group or mailing list for which the Archive option has 
been enabled, a Mailing List menu item also appears in the menu list. You 
can review the archive of email messages among the members of a mailing 
list. 

 

WebMail messages 

 

In the Messages section, you can compose a message, view your folders, manage 
your folders and (if available) view the archived mailing lists. 

 

Compose 

 

To compose a message: 

1. Click 

 

Compose

 

 on the left. The Compose table appears. Fill in the fields in 
the table. 

a.

 

To. 

 

This field is mandatory. You must enter an email address of a 
recipient. Separate multiple addresses with commas. For users on the 
Qube 3, you only need to enter their user name. 

b.

 

CC. 

 

This field is optional. Enter the email addresses of the recipients to 
whom you want to send a copy of the message. Separate multiple 
addresses with commas. 
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c.

 

BCC. 

 

This field is optional. Enter the email addresses of the recipients 
to whom you want to send a “blind” copy of the message. Separate 
multiple addresses with commas. 

The recipients entered in the To: and CC: fields do not see the recipients 
listed in the BCC: field; a recipient in the BCC: field does not see any of 
the other recipients in the BCC: field.  

d.

 

Attachments. 

 

This field is optional. You can choose to attach a file to 
your email message. For more information, see “To add an attachment 
to a message:” on page 69. 

e.

 

Subject. 

 

This field is optional. Enter the subject of your message. 

f.

 

Message. 

 

Enter the body of your message in the scrolling window. 

2. Click 

 

Send

 

 at the bottom. The Message Sent table appears with a list of the 
recipients of the message, Figure 19 shows a sample. 

 

Figure 19.   

 

Message Sent table  

 

✍

 

Note: 

 

You can also select recipients from your Address Book. The 
Address Book includes all of the users on the Qube 3 as well as 
your personal entries. For more information, see “Address book” on 
page 80. 

• Click the address card icon to the right of these three fields; a 
separate browser window opens with the list of people entered 
in your address book. 

• Click the check box next to the names of those people to whom 
you want to send the message. 

• Click 

 

Select

 

 at the top. The selected names appear in the field 
into which you imported them. 
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Adding an attachment to a message 

 

When you compose a new message, reply to a message or forward a message, 
you can attach a file to your message.  

To add an attachment to a message: 

1. Click the green “plus document” icon next to the Attachments field in the 
Compose Message table. A separate browser window opens and displays the 
Add table. 

2. Enter the path and filename of the file that you want to attach. 

3. You can also browse for the file on your computer. Click 

 

Browse

 

. A dialog 
opens in which you locate the file. See Figure 20. 

4. Locate the file and click 

 

Open

 

. The dialog closes. The path and filename of 
the file you selected appear in the Add File field. 

5. Click 

 

Submit

 

. The file is added to the Attachments field in the message. 

6. If you want to remove a file that you have added, click the file name once in 
the Attachments field to highlight it and then click the red “minus document” 
icon. 

7. Continue with your message. 

 

Figure 20.   

 

Email Attachment screen  

 

✍

 

Note: 

 

If you are using Internet Explorer on the Mac, you can only 
add one attachment to an email message. There is a single field with 
a browse button for locating the file. 
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Folder List 

 

You can review the messages in your folders.  

There are two standard folders in WebMail. A user cannot delete these folders. 

•

 

Inbox

 

 contains the incoming messages to your Qube 3 email account. 

•

 

Sent-mail

 

 contains the outgoing messages from your Qube 3 email account. 

If you have created any other folders, they show up in this list as well.

 

Viewing a folder 

 

To view a folder: 

1. Click 

 

Folder List

 

 on the left. A sub-menu of the two standard folders and 
any others that you have created appears underneath.

2. Click on the name of the folder that you want to view. The folder table for 
that folder appears in the browser window. For more information on the 
folder table, see “Folder table” on page 71.

 

✍

 

Note: 

 

To add or delete folders, see “Manage Folders” on page 75. 
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Folder table 

 

In a folder table, the title bar displays the name of the folder. Figure 21 shows a 
sample of a folder table. 

 

Figure 21.   

 

Folder table  

 

In the second row, there is a 

 

Remove

 

 button for deleting messages and a 
“Move to...” pull-down menu for moving the messages between folders. The 
number of messages in the table is also shown. 

Above the table is a legend explaining the status icons: 

• A solid blue circle indicates that the message has not been read yet. 

• A hollow blue circle indicates that the message has been read. 

• A left-pointing blue arrow indicates the message has been replied to or 
forwarded (either by the Send, Reply, Reply All or Forward command). 

The table has five columns (see Figure 21): 

•

 

Check box column.

 

 This column allows you to manipulate your email 
messages. Click the check box to select one or more messages. You can 
delete selected messages with the 

 

Remove

 

 button or move them to another 
folder with the “Move to...” pull-down menu. 

Another check box above this column allows you to select all of the 
messages in the table. Click the check box a second time to de-select all of 
the messages. 

•

 

Status column.

 

 This column indicates the status of a message. A blue circle 
indicates that the message has not been read yet. A hollow blue circle 
indicates that the message has been read. A left-pointing blue arrow indicates 
the message has been replied to or forwarded (either by the Send, Reply, 
Reply All or Forward command). 
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•

 

Subject.

 

 This column displays the subject of the message as a hypertext link. 
To view the message, click on this link. The browser window refreshes and 
the full message appears, with all the fields from the Compose section 
displayed (To, CC, Date, Subject, Message). If the message has an attached 
file, the file name appears as a hypertext link. 

•

 

Recipient or Sender.

 

 Depending on which folder you are in, this column 
indicates who received the message or who sent the message. 

•

 

Date.

 

 This column displays the date that the message was sent. 

 

Sorting the messages 

 

Users can sort the messages in a folder according to Subject, Recipient or Sender, 
or Date. The messages can be sorted in ascending or descending order. 

To sort the messages, click on the triangle next to the column heading to sort the 
messages by that column. To reverse the order of the sort, click on the triangle a 
second time. 

 

Messages in a folder 

 

In each of the tables, you can

• sort the messages according to different criteria; see “Sorting the messages” 
on page 72 

• move a message between folders; see “Moving a message” on page 73 

• delete a message; see “Deleting a message” on page 74 

As well, you can perform a number of operations on a message. The subject line 
of each message is a hypertext link. Click on the link to open the message. 

Depending on which folder you are in, you can reply to the message, reply to all 
recipients of the original message, forward the message or delete the message. 
The following list explains each of these options. 

•

 

Reply. 

 

You can reply to the original sender (the address in the From field). 

•

 

Reply All. 

 

You can reply to the original sender and all other recipients of the 
original message. BCC recipients on the original message do not receive a 
Reply All message. 

•

 

Forward.

 

 You can forward the message to another email address. 

•

 

Remove.

 

 You can delete the message. 

•

 

Back.

 

 The browser returns to the Inbox table. 



 

WebMail messages

Cobalt Qube 3 User Manual 73

 

Moving a message 

 

To move a message: 

1. In the folder table, click the check box next to the message or messages that 
you want to move. 

2. From the “Move to...” pull-down menu in the title bar, select the folder to 
which you want to move the message. The message moves as soon as you 
select the folder. 

3. The folder table appears, minus the moved message. 

 

Replying to a message 

 

To reply to a message: 

1. In a folder, click on the subject (a hypertext link) of the message. The 
browser window refreshes and the full message appears, with all the fields 
displayed (To, CC, Date, Subject, Message). 

2. Click 

 

Reply 

 

or

 

 Reply All

 

. The Reply or Reply All table appears and you can 
fill in the fields. For an explanation of these fields, see “To compose a 
message:” on page 67. 

 

Reply

 

 sends the reply to the sender only; 

 

Reply All

 

 sends the reply to 
everyone in the To: and CC: fields. You can add other recipients as well. 

3. The Message field appears with the original header and text, separated from 
your reply by a divider at the top of the text window. You can edit this text if 
you want and add your own text. 

4. Click 

 

Send

 

 at the bottom. The Message Sent table appears and lists the 
recipient or recipients of the reply. 
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Forwarding a message 

 

To forward to a message: 

1. In a folder, click on the subject (a hypertext link) of the message. The 
browser window refreshes and the full message appears, with all the fields 
displayed (To, CC, Date, Subject, Message). 

2. Click 

 

Forward

 

. The Forward table appears and you can fill in the fields. For 
an explanation of these fields, see “To compose a message:” on page 67. 

3. The Message field appears with the original header and text, separated from 
your new message by a divider at the top of the text window. You can edit 
this text if you want and add your own text. 

4. Click 

 

Send

 

 at the bottom. The Message Sent table appears and lists the 
recipient or recipients of the forwarded message. 

 

Deleting a message 

 

There are two ways to delete a message: from the folder table or while viewing 
the message. 

To delete a message from the folder table: 

1. In the folder, click the check box next to the message or messages that you 
want to delete. 

2. Click 

 

Remove 

 

in the title bar. A confirmation dialog verifies the deletion. 

3. Click 

 

OK

 

.

4. The browser window refreshes. The folder from which you deleted the 
message or messages appears, minus the deleted message.

To delete a message while viewing the message: 

1. In the folder, click on the subject (a hypertext link) of the message. The 
browser window refreshes and the full message appears, with all the fields 
displayed (To, CC, Date, Subject, Message). 

2. Click 

 

Remove

 

. A confirmation dialog verifies the deletion. 

3. Click 

 

OK

 

. 

4. The browser window refreshes. The folder from which you deleted the 
message(s) appears, minus the deleted message(s).
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Manage Folders 

 

In the Manage Folder section, you can add or delete personal folders within your 
WebMail account. 

There are two standard folders in WebMail. A user cannot delete these folders. 

a.

 

Inbox

 

 contains the incoming messages to your Qube 3 email account. 

b.

 

Sent-mail

 

 contains the outgoing messages from your Qube 3 email 
account. 

You can add any number of folders. Folders added by a user can be deleted. 

Figure 22 shows a sample Folder List table. 

Figure 22.   Folder List table  
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Adding a folder 

To add a folder: 

1. Click Manage Folders on the left. The Folder List table appears with the 
two standard folders and any others you have created. The title bar indicates 
the number of folders in the table. 

2. Click Add in the top row. The Add Folder table appears. 

3. Enter the name of the folder in the Name field. 

4. Click Save. The Folder List table refreshes with the new folder at the bottom 
of the list. 

Folders added by a user have a green pencil and a red trashcan icons next to 
it so that you can modify or delete the folder. 

Modifying a folder 

To modify a folder: 

1. Click Manage Folders on the left. The Folder List table appears with the 
two standard folders and any others you have created. 

2. Click the green pencil icon next to the folder that you want to modify. The 
Modify Folder - <folder name> table appears. 

3. Enter the new folder name in the field. 

4. Click Save. The Folder List table refreshes with the renamed folder. 

Deleting a folder 

To delete a folder: 

1. Click Manage Folders on the left. The Folder List table appears with the 
two standard folders and any others you have created. 

2. Click the red trashcan icon next to the folder that you want to delete. A 
confirmation dialog verifies the deletion. 

3. Click OK. The Folder List table refreshes, minus the deleted folder. 
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Mailing Lists 
When the Qube 3 Administrator creates a mailing list, he or she can enable the 
Archive option. The archive provides members of the mailing list access to all of 
the email messages addressed to the mailing list as well as the responses. 

By default, the Archive option is OFF. You can enable the Archive option when 
you create a new mailing list or you can modify an existing mailing list to enable 
the Archive option. This applies to mailing lists created separately or to mailing 
lists generated automatically as part of a Group. 

When the Qube 3 Administrator enables the Archive option for a mailing list, the 
system generates an email to each member of the list, notifying them that the 
archive option has been enabled for that list. 

For more information on enabling this option, see “Modifying a mailing list” on 
page 127; the Archive option is found under the Advanced tab of the mailing list 
table. 

Viewing an archive 

To view the archive of a mailing list: 

1. Click Mailing Lists on the left. The lists for which there is an archive are 
shown under this menu item. The Mailing List Archive - <mailing list> table 
appears for the first mailing list in the sub-menu. Figure 23 shows a sample. 

2. In the sub-menu, select the archive that you want to view. The archive table 
for that mailing list appears. 

3. The archive table has three columns: 

• Subject. The subject line of the message shows up as a hypertext link. 

• Sender. The name or email address of the sender. 

• Date. The date the message was received. 

4. To view the text of a message, click on the subject line of that message. The 
individual message appears in a table showing the sender, date, subject and 
message. Figure 24 shows a sample of an archived message. 

✍
Note: If a user does not belong to any mailing lists that have the 
Archive option enabled, the Mailing Lists menu item does not 
appear on the WebMail screen for that user. 
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Figure 23.   Sample of a Mailing List Archive  

Figure 24.   Sample of an archived message  
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Replying to a message in the archive 

To reply to a message in the archive: 

1. Click Mailing Lists on the left. The lists for which there is an archive are 
shown under this menu item. The Mailing List Archive - <mailing list> table 
appears for the first mailing list in the sub-menu. Figure 23 shows a sample. 

2. In the sub-menu, select the archive that you want to view. The archive table 
for that mailing list appears.

3. Click on the subject line of the message (shown as a hypertext link). The 
individual message appears in a table showing the sender, date, subject and 
message. 

4. Click Reply. The Compose table appears. For more information on this 
table, see “Replying to a message” on page 73. 

5. When you have completed the message, click Send. The Message Sent table 
appears.

6. Click on the name of mailing list in the sub-menu to return to the Mailing 
List archives.
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Address book 
The Address Book feature is closely integrated with WebMail. Using the Address 
Book, users can 

• view the registered users and groups on the Qube 3 

• view personal contacts that you have added 

• send email messages to other registered users or groups on the Qube 3 or to 
personal contacts 

• view the Web pages of individual users or of groups. 

For more information on the WebMail program, see “Overview of WebMail” on 
page 66. 

To access the Address Book: 

1. From the Server Desktop, select Programs. The Programs screen appears, 
with a menu list on the left. 

2. Click Address Book. Three options appear in a sub-menu.

• Users. This screen displays all the registered users on the Qube 3. 

• Groups. This screen displays all the registered groups on the Qube 3.

• Personal. This section contains your personal contacts that you have 
added to your address book. 

Sorting the entries 
In the Users Address Book, you can sort the entries according to the full name or 
user name of the registered user. 

In the Personal Address Book, you can sort the entries according to the full name, 
email address or phone number of the person. 

The entries can be sorted in ascending or descending order. 

To sort the messages, click on the triangle next to the column heading to sort the 
entries by that column. To reverse the order of the sort, click on the triangle a 
second time. 
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Users 
The Users section of the Address Book lists the registered users on the Qube 3. 
As the Qube 3 Administrator adds new users, the new users appear in the Address 
Book. 

For each user, you can view the user’s contact information, send an email to the 
user or view the user’s personal Web page. 

Viewing the users on the Qube 3 

To view the registered users on the Qube 3:

1. Click Users in the sub-menu. The Users Address Book appears; see 
Figure 25. The table comprises four columns: 

• Full Name displays the full name of the registered user. 

• User Name displays the user name of the registered user. 

• Remarks provides additional information about the user. 

• Actions displays icons for sending email to a user, viewing the user’s 
Web page and viewing the user’s contact information. 

The number of registered users on the Qube 3 is displayed above the Actions 
column. 

Viewing the contact information for a user

To view a user’s contact information: 

1. Click Users in the sub-menu. The Users Address Book appears. 

2. Click the green magnifying glass next the user whose contact information 
you want to see. The View Contact Information table appears. 

3. Click Back to return to the Users Address Book. 
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Figure 25.   Users Address Book  

Sending an email to a user 

To send an email to the user:

1. Click Users in the sub-menu. The Users Address Book appears. 

2. Click the yellow email icon next the user to whom you want to send an 
email. The Compose table appears. 

For more information on this table, see “Replying to a message” on page 73. 

3. When you have completed the message, click Send. The Message Sent table 
appears. 

4. Click Users in the sub-menu to return to the Users Address Book. 
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Viewing a user’s Web page 

To view the user’s personal Web page:

1. Click Users in the sub-menu. The Users Address Book appears. 

2. Click the globe icon next the user to whose personal Web page you want to 
view. A separate browser window opens to a default Web page for the user; 
see Figure 26. 

The user can replace this Web page. 

3. Close the browser window to return to the Users Address Book. 

Figure 26.   Default User Web Page  
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Groups 
The Groups section of the Address Book lists the registered groups on the 
Qube 3. As the Qube 3 Administrator adds new groups, the new groups appear in 
the Address Book. 

For each group, you can send an email to the group or view the group’s Web 
page. 

Viewing the groups on the Qube 3 

To view the groups on the Qube 3:

1. Click Groups in the sub-menu. The Groups Listing table appears; see 
Figure 27. The table comprises four columns: 

• Name displays the name of the group. 

• Members displays the user names members of the group. 

• Remarks provides additional information about the group. 

• Actions displays an icon for sending email a group or viewing the 
group’s Web page. 

The number of groups on the Qube 3 is displayed above the Actions column. 

Figure 27.   Groups Listing table  
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Sending an email to a group 

To send an email to a group:

1. Click Groups in the sub-menu. The Groups Listing table appears. 

2. Click the yellow email icon next the group to whom you want to send an 
email. The Compose table appears. 

For more information on this table, see “Replying to a message” on page 73. 

3. When you have completed the message, click Send. The Message Sent table 
appears. 

4. Click Groups in the sub-menu to return to the Groups Listing table. 

Viewing a group’s Web page 

To view the group’s page:

1. Click Groups in the sub-menu. The Groups Listing table appears. 

2. Click the globe icon next the group to whose Web page you want to view. A 
separate browser window opens to a default Web page for the group; see 
Figure 28. 

The group can replace this Web page. 

3. Close the browser window to return to the Groups Listing table. 

Figure 28.   Default Group Web Page  
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Personal 
The Personal section of the Address Book contains contact information of a 
person that a user has added. You can enter a person’s name, email address, 
telephone and facsimile numbers, a URL for a Web page, mailing address and 
remarks. You must complete the field for the person’s name; all other fields are 
optional.  

Viewing the entries in the Personal Address Book 

To view the entries in the Personal Address Book: 

1. Click Personal in the sub-menu. The Personal Address Book appears; see 
Figure 29. The table comprises four columns: 

• Full Name displays the name of the personal contact. 

• Email Address displays an email address for that person. 

• Phone Number displays the telephone number for that person. 

• Actions displays an icon for sending email to the person, modifying the 
entry or deleting the entry from the Personal Address Book. 

The number of entries in the Personal Address Book is displayed above the 
Actions column. 

Figure 29.   Personal Address Book  

✍ Note: You do not have to enter an email address for a person; you 
can simply enter the contact information. However, if the entry does 
not include an email address, you will not be able to send email to 
that person from your Personal Address Book. 
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Adding a personal contact 

To add a personal contact to the Personal Address Book:

1. Click Personal in the sub-menu. The Personal Address Book appears. 

2. Click Add at the top of the table. The Add Contact table appears; see 
Figure 30. 

3. Complete the following fields. 

• Full Name. This field is mandatory. Enter the full name of the person.

• Email Address. This field is optional. Enter an email address in the 
format <xxxxx@yyy.zzz>. 

• Phone Number. This field is optional. Enter a telephone number. 

• Fax Number. This field is optional. Enter a number for a facsimile 
machine. 

• Web Page Address. This field is optional. Enter a URL for a Web page. 

• Address. This field is optional. Enter a mailing address email. 

• Remarks. This field is optional. 

4. Click Save. 

Figure 30.   Add Contact table  
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Modifying a personal contact 

To modify a personal contact in the Personal Address Book: 

1. Click Personal in the sub-menu. The Personal Address Book appears. 

2. Click the green pencil icon next to the entry that you want to modify. The 
Modify Contact table appears. 

3. Modify any of the following fields. 

• Full Name. This field is mandatory. Enter the full name of the person.

• Email Address. This field is optional. Enter an email address in the 
format <xxxxx@yyy.zzz>. 

• Phone Number. This field is optional. Enter a telephone number. 

• Fax Number. This field is optional. Enter a number for a facsimile 
machine. 

• Web Page Address. This field is optional. Enter a URL for a Web page. 

• Address. This field is optional. Enter a mailing address email. 

• Remarks. This field is optional. 

4. Click Save. 

Sending an email to a personal contact

To send an email to a personal contact from the Personal Address Book:

1. Click Personal in the sub-menu. The Personal Address Book appears. 

2. Click the yellow email icon next the person to whom you want to send an 
email. The Compose table appears. 

For more information on this table, see “Replying to a message” on page 73. 

3. When you have completed the message, click Send. The Message Sent table 
appears. 

4. Click Personal in the sub-menu to return to the Personal Address Book. 
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Deleting a personal contact 

To delete a personal contact from the Personal Address Book:

1. Click Personal in the sub-menu. The Personal Address Book appears. 

2. Click the red trashcan icon next to the entry that you want to delete. A 
confirmation dialog verifies the deletion. 

3. Click OK. The Personal Address Book table refreshes, minus the deleted 
entry. 

Personal profile 
The Personal Profile section allows you to view your user account information.

On the Server Desktop, click Personal Profile at the top. The menu items for 
your account appear on the left. 

• Account 

• Email 

• Disk Usage 

• Personal Information 

Account 
In the Account section, you can change the name on your account, select a 
language and change your password 
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Modifying account information 

To modify your account information: 

1. Click Personal Profile at the top. 

2. Click Account on the left. The Account Settings - <username> table 
appears; see Figure 31. 

3. Modify any of the following fields. 

a. Full Name. This field is mandatory. Modify the name for your account. 

b. Language Preference. You can select a language from the pull-down 
menu. 

You can also have the Qube 3 use the language option selected in your 
browser software (as long as the text strings for that language are 
available on the Qube 3). If the language selected in your browser is not 
available, the Qube 3 defaults to English. 

c. New Password. (optional) You can change your password. Enter the 
password twice for confirmation. 

For more information on choosing a password, see “Password 
guidelines” on page 26.

4. Click Save. 

Figure 31.   Account Settings table  



Personal profile

Cobalt Qube 3 User Manual 91

Email
There are two options available in the Email section: Email Forwarding and 
Vacation Message.

Forwarding 

The Forwarding feature allows you to forward incoming messages to another 
email address. 

Enabling email forwarding

To enable email forwarding: 

1. Click Personal Profile at the top. 

2. Click Email on the left. The Email Settings - <username> table appears; see 
Figure 32. 

3. In the Email Forwarding section of the table, click the check box Enable. 

4. In the scrolling text window labeled Email Addresses, enter an email address 
in the format <xxxxx@yyy.zzz>. 

For more than one email address, separate the addresses with a comma or 
enter each address on a separate line. 

5. You can save a copy of the email messages that you forward. 

Click to enable the check box Save Copy. 

6. Click Save. 

Disabling email forwarding 

To disable email forwarding: 

1. Click Personal Profile at the top. 

2. Click Email on the left. The Email Settings - <username> table appears; see 
Figure 32. 

3. In the Email Forwarding section of the table, click to disable the check box 
Enable. 

4. Click Save. 
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Vacation message 

The Vacation Message feature allows you to enter a vacation-reply message that 
is automatically sent to each person who sends you email. This feature is useful 
when you know that you will not be reading or responding to incoming email 
messages for a period of time. 

A vacation-reply email is sent only once a week to each sender. 

Enabling the vacation message 

To enable the vacation message: 

1. Click Personal Profile at the top. 

2. Click Email on the left. The Email Settings - <username> table appears; see 
Figure 32. 

3. In the Vacation Message section of the table, click to enable the check box 
Enable. 

4. In the scrolling text window labeled Auto-Reply, type the text of the message 
you want to send to users while you are away. 

5. Click Save. 

Disabling the vacation message 

To disable the vacation message: 

1. Click Personal Profile at the top. 

2. Click Email on the left. The Email Settings - <username> table appears; see 
Figure 32. 

3. In the Vacation Message section of the table, click to disable the check box 
Enable. 

4. Click Save. 

Figure 32.   Email Settings table  
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Disk Usage 
In the Disk Usage section, you can view the amount of disk space in use, the 
amount of disk available and the percentage of the disk in use. 

Viewing the disk usage statistics 

To view the Disk Usage statistics: 

1. Click Personal Profile at the top. 

2. Click Disk Usage on the left. The Disk Usage table appears with the usage 
statistics; see Figure 33. 

The table displays the amount of disk space used (MB), the amount of disk 
space free (MB) and the percentage of disk space used. 

Figure 33.   Disk Usage table  
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Personal Information 
In the Personal Information section, you can enter and manage your personal 
contact information.

1. Click Personal Profile at the top. 

2. Click Personal Information on the left. The Personal Information table 
appears.

3. Fill in the following fields (all of the fields are optional):

• Web page address 

• Telephone number 

• Fax number 

• Address 

• Remarks 

4. Click Save.

Figure 34.   Personal Information table  
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 Chapter 5

 

Administration Site

 

This chapter describes the administrative functions that only the Cobalt Qube 3 
Administrator is allowed to perform. The Qube 3 Administrator, with the user 
name 

 

admin

 

, has full control of the Qube 3. The Qube 3 Administrator: 

• enters the network settings 

• enables or disables the various services 

• adds and deletes users, groups and mailing lists 

• performs maintenance functions 

• receives system alerts and warnings by email   

 

✍

 

Note:

 

 In most of the short procedures in this chapter, the first step is 
to click the 

 

Administration

 

 tab in the top menu bar and the second 
step is to click on a selection from the left menu bar. 

To reduce the number of steps in each procedure, the menu 
commands are grouped together and shown in 

 

bold

 

 type face. Right 
angle brackets separate the individual items. 

For example, select 

 

Administration > Users and Groups > User 
List

 

 means to click the 

 

Administration

 

 tab in the top menu bar, 
click the 

 

Users and Groups

 

 menu category in the left menu bar and 
finally click the 

 

User List

 

 sub-menu item.
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Administration site 

 

The Administration site on the Server Desktop is available only when you log in 
under the user name 

 

admin

 

. Besides the options on the standard Server Desktop, 
there are two other options: the Administration menu and the BlueLinQ. See 
Figure 35. 

 

Accessing the Administration site 

 

To access the Qube 3 Administration Site:

1. Enter the following URL into your browser:

 

http://<hostname>.<domainname>/login/ 

 

2. At the login screen that appears, enter the user name: 

 

admin 

 

Only this user name allows access to the Administration site. Any other user 
name brings up the normal Qube 3 interface. 

3. Enter the admin password. 

4. If you want to establish a secure connection when you log in to the Qube 3, 
click the Secure Connect check box. This establishes a Secure Sockets Layer 
(SSL) connection between your browser and the Qube 3. Cobalt 
recommends that you enable the secure connection so that any data sent to or 
received from the Qube 3 is encrypted. 

If your browser does not support SSL or has problems accessing the Qube 3, 
try connecting without enabling the secure connection. Some browsers do 
not handle SSL properly and the only option is not to use SSL. 

 

✍

 

Note:

 

 You cannot use accented characters (for example, ä, é, ñ) in 
the following items: 

• user names 

• group names 

• email addresses and email aliases 

• host names and domain names 

• the names of email folders in the WebMail program 

You can use accented characters.in descriptive fields, for example, 
in the Full Name field for a user or in the Remarks field describing a 
group. 
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5. Click 

 

Login

 

. If you enabled the Secure Connect option, your browser may 
prompt you to accept a self-signed certificate. This certificate is generated 
automatically for you and is required for SSL encryption. If you do not 
accept the certificate, you cannot use the Secure Connect option. 

6. The 

 

Administration

 

 screen of the Server Desktop appears; see Figure 35. 

 

Figure 35.   

 

Administration screen  

 

✍

 

Note:

 

 The Qube 3 generates a self-signed certificate during 
configuration. A self-signed certificate encrypts the data but it does 
not authenticate the identity of the server at the other end of the 
connection. 

For more information, see the entries for 

 

Authentication

 

, 

 

Encryption

 

 and 

 

Secure Sockets Layer

 

 in Appendix G, “Glossary”.



 

Chapter 5: Administration Site

98 Cobalt Qube 3 User Manual

 

Administration screen 

 

The following bullet items represent the fully expanded Administration menu on 
the left side of 

 

Administration

 

 screen. These are the functions and services that 
the Administrator can manage from the Administration screen. They are 
explained in this chapter.

• Users and Groups (see page 104) 

• User List 

• Group List 

• LDAP Directory 

• Import 

• Email Services (see page 123) 

• Mailing Lists 

• Email Servers 

• Remote Retrieval 

• File Services (see page 137) 

• Windows 

• FTP 

• Apple 

• Guest Share 

• Web Services (see page 141) 

• Web 

• Web Caching 

• Network Services (see page 145) 

• DNS 

• DHCP 

• Basic Firewall 

• SNMP 

• Telnet 
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• System (see page 162) 

• TCP/IP 

• Internet 

• Power 

• Time 

• Information 

• Maintenance (see page 175) 

• Backup 

• Restore 

• Usage Information (see page 184) 

• Web 

• Disk 

• Network 

• Active Monitor (see page 186) 

• Status 

• Settings 
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BlueLinQ screen 

 

This screen provides tools for updating and installing the Qube 3 software. See 
“BlueLinQ” on page 190 for details on using these tools.

 

Figure 36.   

 

BlueLinQ screen  

 

Programs screen

 

The Programs screen (see Figure 37) is where the Administrator accesses and 
manages Web Mail and the Address Book. These are described in Chapter 4.

 

Figure 37.   

 

Programs screen  
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Personal Profile screen

 

The Personal Profile screen (see Figure 38) is where the Administrator manages 
the Administrator Account, Email, Password, and disk usage settings. These are 
described in “Personal profile” on page 89.

 

Figure 38.   

 

Personal Profile screen  
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Other features 

 

There are four icons in the top right corner of the Server Desktop: 

• Help 

• Software Notification 

• Active Monitor 

• Logout 

 

Help icon 

 

You can access the user manual in PDF format from the Server 
Desktop. If you have installed third-party software on the Qube 3, the 
relevant documentation is available on this screen. 

To access the PDF file for the user manual, click on the help icon in the top right 
corner. A separate browser window opens displaying a list of PDF files in the 
languages available. Click the link for the PDF in your preferred language; you 
can open the PDF file in the browser window or save it to your personal 
computer. 

 

Software Notification 

 

The Software Notification icon allows you to check for new or updated 
software packages and to install them if any are found. The icon 
changes color when new or updated software packages are available. 

For more information on installing software, see “BlueLinQ” on page 190. 

 

Active Monitor

 

The Active Monitor icon allows you to view status information. The 
icon turns red if any of the components monitored by Active Monitor 
have severe problems. 

For more information on the Active Monitor feature, see “Active Monitor” on 
page 186. 

 

Logout 

 

Click the Logout icon to log out of the system. 
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Resetting the Qube 3 Administrator password

 

When the Qube 3 Administrator password is cleared, the root account is not 
accessible until a new administrator password is assigned.  

If you forget the password for the Qube 3 Administrator, you can reset the 
password:

1. Push and hold a paper clip in the recessed Reset Password button (on the 
back of the Qube 3; see Figure 1). Hold the button in for approximately 2 
seconds. 

The LCD screen displays 

 

RESETTING ADMIN 
PASSWORD 

 

2. Enter the following URL in your Web browser to access the Administration 
Site:

 

http://<hostname>.<domainname>/login/ 

 

3. If a prompt appears asking for a username or password, enter 

 

admin

 

 as the 
username and “admin” as the password. Click 

 

OK

 

. The 

 

Administration 
Site

 

 screen opens as shown in Figure 35.  

4. To modify the Administrator password, follow the steps in “Account” on 
page 89. 

!

 

Caution:

 

 After you clear the password, enter a new one as soon as 
possible to protect the security of the Qube 3.At this point, anyone 
on the network can assign the Qube 3 Administrator password until 
you assign a new one.

 

✍

 

Note:

 

 The system automatically sets the 

 

admin

 

 password to 
“admin” when you use the Password Reset button. 
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Users and Groups 

 

The Users and Groups section is where you administer user and group settings 
for all Qube 3 users including the Qube 3 Administrator. 

To access the Users and Groups section, select 

 

Administration

 

 in the top menu 
bar and 

 

Users and Groups

 

 in the left menu bar. The Users and Groups sub-menu 
items are as follows:

• User List 

• Group List 

• LDAP Directory 

• Import 

These are described below. 

 

User List 

 

To access the User List section on the Administration Site:

Select 

 

Administration > Users and Groups > User List

 

 to open The User List 
table; see Figure 39.

The User List table displays the full name of each user (for example, Jessica 
Smith) and the name used to log in to the Qube 3 (for example, jsmith).This is 
called the “user name” or “userID”.

The Qube 3 Administrator can use the User List to perform the following:

• Configure the default user settings 

• Add or remove a user

• Modify a user’s account and email settings
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Figure 39.   

 

User List table  
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Configuring the default user settings

 

To configure the default user settings:

1. Select 

 

Administration > Users and Groups > User List

 

 to open The User 
List table (see Figure 39).

2. Click 

 

Edit User Defaults

 

.

The User Defaults table appears as shown in the following figure. 

 

Figure 40.   

 

Edit User Defaults table  

 

3. Configure the following default settings: 

•

 

Maximum Allowed Disk Space (MB).

 

 This value is the default amount 
of disk space available to a newly created user for file storage and Web 
pages. The default value is 100 MB. The value entered must be a whole 
number greater than zero (you cannot enter zero).

If you leave this field blank, the user has unlimited disk space. 

•

 

User Name Generation. 

 

You can specify one of the following formats 
for the Qube 3 to automatically format user names. 

• Initial of first name & last name 

• First name & initial of last name 

• Only first name 

• Only last name 

4. Click 

 

Save

 

. 
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Adding a user

 

To add a user:

1. Select 

 

Administration > Users and Groups > User List

 

 to open The User 
List table (see Figure 39). 

2. Click 

 

Add. 

 

The Add New User table appears as shown in the following figure.

 

Figure 41.   

 

Add New User table  
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3. Fill in the fields:

•

 

Full name.

 

 Enter the first and last names of the user, separated by a space 
(for example, Alan Williams). 

•

 

User name. 

 

The user name is generated automatically from the user’s 
full name, according to the user name format specified in the default 
settings. 

If the automatically generated user name is already taken by another 
user, you cannot save the information that you entered in the Add New 
User table and you have to enter a different user name manually. 

•

 

Password. 

 

Enter the password twice to ensure that you have entered it as 
intended. For guidelines on choosing a password, see “Password 
guidelines” on page 26. 

•

 

Maximum allowed disk space (MB). 

 

This value is the amount of disk 
space available to a user for file storage and Web pages. The value 
entered must be a whole number greater than zero (you cannot enter 
zero).

If you leave this field blank, the user has unlimited disk space. 

•

 

Group Membership.

 

 (optional) 

 

Use the green left and right arrows to 
move selected group names between the Groups Affiliated and the 
Groups Not Affiliated lists.

•

 

Email aliases. 

 

(optional) 

 

Enter additional names for which the user can 
receive email. To add more than one alias, enter each alias on a separate 
line or separate the aliases with spaces. 

If you enter a first name (Alan) and last name (Williams) in the Full 
Name field, the system automatically generates an alias of 
“alan.williams”.

For more information on email aliases, see “Email aliases” on page 40. 

•

 

Remarks. 

 

(optional) 

 

You can enter additional information about the user 
in this field.

4. Click 

 

Save

 

. 



 

Users and Groups

Cobalt Qube 3 User Manual 109

 

Modifying a user account 

 

To modify the information for a user’s account:

1. Select 

 

Administration > Users and Groups > User List

 

. The User List 
table appears. 

2. Click the green pencil icon next to the user whose account you want to 
modify. The Modify User table appears (see Figure 42).

3. Modify one or all of the following fields. You cannot modify the user name.

•

 

Full name. 

 

Enter the first and last names of the user, separated by a space 
(for example, Grace Ecklund Gustavson). 

•

 

New password. 

 

Enter the new password twice to ensure that you have 
entered it as intended. For guidelines on choosing a password, see 
“Password guidelines” on page 26. 

•

 

Maximum allowed disk space (MB). 

 

This value is the amount of disk 
space available to a user for file storage and Web pages. The value 
entered must be a whole number greater than zero (you cannot enter 
zero).

If you leave this field blank, the user has unlimited disk space. 

•

 

Group Membership.

 

 You can edit the groups to which the user belongs. 
Select one or more group names and click on the arrows to move the 
name(s) between the Groups Affiliated and Groups Not Affiliated lists.

•

 

Remarks. 

 

You can enter additional information about the user in this 
field.

4. Click 

 

Save

 

. 
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Figure 42.   

 

Modify User Account Settings table  
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Modifying a user’s email settings

 

To modify a user’s email settings: 

1. Select 

 

Administration > Users and Groups > User List

 

. The User List 
table appears. 

2. In the User List table, locate the user whose email settings you want to 
modify. 

3. Click the green pencil icon next to that user’s name. The Modify User 
Settings - <username> table appears (see Figure 43). 

4. Click the Email tab in the upper right corner of the table. The email settings 
appear. 

 

Figure 43.   

 

Modify User Email Settings table  



 

Chapter 5: Administration Site

112 Cobalt Qube 3 User Manual

 

5. Modify the following fields in the Modify User Settings table. 

• Email Aliases. (optional) There may already be an alias entered from 
when you first added the user.

Enter additional names for which the user can receive email. To add 
more than one alias, enter each alias on a separate line or separate the 
aliases with spaces. 

For more information on email aliases, see “Email aliases” on page 40. 

• Email Forwarding. Enter the email address to which you want to 
forward automatically your email messages. 

• Vacation Message. If you want to automatically send a custom email 
message to everyone who sends you email, check the Enabled check box 
and enter the response message in the Automatic Reply box. This feature 
is useful if you want to send an automatic response message to the 
sender, or when you know that you will not be reading or responding to 
incoming email messages for a period of time.  

6. Click Save. 

Adding an email alias for a user 

To add an email alias for a user: 

1. Select Administration > Users and Groups > User List. The User List 
table appears. 

2. In the User List table, locate the user for whom you want to add an email 
alias. 

3. Click the green pencil icon next to that user’s name. The Email Settings table 
appears. 

4. Click the Email tab in the upper right corner of the table. The email settings 
appear; see Figure 43. 

5. In the Email Aliases field, enter additional name(s) for which the user can 
receive email. To add more than one alias, enter each alias on a separate line 
or separate the aliases with spaces. 

For more information on email aliases, see “Email aliases” on page 40. 

6. Click Save. 

✍ Note: A vacation-reply email is sent only once per week to each 
sender.
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Deleting a user 

To delete a user:  

1. Select Administration > Users and Groups > User List. The User List 
table appears. 

2. Click the red trash can icon next to the user that you want to delete. A 
confirmation dialog box verifies the deletion. 

3. Click OK in the confirmation dialog box. 

The User List table updates with the deleted user removed from the table.

Group List 
In the Group List section, the Qube 3 Administrator can: 

• configure the default group settings 

• add a group 

• modify the members of a group 

• specify the maximum allowed disk space for the group 

• remove a group 

To access the Group List, select Administration > Users and Groups > Group 
List to open the Group List table. The table displays the group name and the 
members of each group. See Figure 44. 

!
Caution: You cannot undo this action.

If you remove a user, you delete the user account and all of the 
associated files.
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Figure 44.   Group List table  

Configuring the default group settings 

To configure the default settings for a group: 

1. Select Administration > Users and Groups > Group List. The Group List 
table appears.

2. Click the Edit Group Defaults button. The Edit Group Defaults table 
appears; see Figure 45. 

Figure 45.   Edit Group Defaults table  

3. Enter a whole number greater than zero (in MB) for the maximum amount of 
disk space available to a group for file storage and Web pages. You cannot 
enter zero in this field.

If you leave this field blank, the group has unlimited disk space. 

4. Click Save.
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Adding a group 

To add a group: 

1. Select Administration > Users and Groups > Group List. The Group List 
table appears. 

2. Click Add. The Add New Group table appears; see Figure 46. 

Figure 46.   Add New Group table  

3. Fill in the fields: 

• Group name. Enter the name of the group. The name can be a maximum 
of 12 characters long; you can only use lowercase English letters, 
numbers, and the hyphen (-) and underscore (_) characters. 

• Maximum allowed disk space (MB). This value is the amount of disk 
space available to a group for file storage and Web pages. The value 
entered must be a whole number greater than zero (you cannot enter 
zero). 

If you leave this field blank, the user has unlimited disk space. 

• User Membership. The lower part of the Add New Group table lists all 
the Qube 3 users. Select one or more names and click on the arrows to 
move the name(s) between the Users Affiliated and Users Not Affiliated 
lists. 

• Remarks. You can enter additional information about the group in this 
field. 

4. Click Save. 
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Modifying a group

To modify the members of a group or the maximum allowed disk space for the 
group:

1. Select Administration > Users and Groups > Group List. The Group List 
table appears. 

2. Click the green pencil icon next to the group that you want to modify. The 
Modify Group Settings table appears; see Figure 47. 

Figure 47.   Modify Group Settings table  

3. Modify one or both of the following fields.

• Maximum allowed disk space (MB). This value is the amount of disk 
space available to a user for file storage and Web pages. The value 
entered must be a whole number greater than zero (you cannot enter 
zero).

If you leave this field blank, the group has unlimited disk space. 

• User Membership. Add members to or remove members from the 
group. Use the arrows to move user names between the Users Affiliated 
and Users Not Affiliated lists. 

• Remarks. You can enter additional information about the group in this 
field. 

4. Click Save. 
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Deleting a group 

To delete a group:  

1. Select Administration > Users and Groups > Group List. The Group List 
table appears. 

2. Click the red trash can icon next to the group that you want to delete. A 
confirmation dialog verifies the deletion. 

3. Click OK in the confirmation dialog box. The Group List table updates to 
show the new groups; the deleted group is deleted from the table. 

LDAP Directory 
To provide a user directory listing by using the Lightweight Directory Access 
Protocol (LDAP) server: 

1. Select Administration > Users and Groups > LDAP Directory. The 
LDAP Directory table appears; see Figure 48. 

Figure 48.   LDAP Directory table  

!
Caution: You cannot undo this action. 

If you remove a group, you delete the group, all of the files in the 
group directory, the group directory itself, the associated mailing 
list for that group, and the Windows file sharing and AppleShare 
settings. 
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2. Configure the settings in the LDAP Import table. 

• Enable. Click the check box to enable the Qube 3 as an LDAP server. 

• Base Distinctive Name. The base distinctive name (Dn) of your user 
directory. For example, o=My Organization, c=US. 

• Email Domain Name. (optional) This option allows you to alter the 
domain name of the email messages exported in your directory. If the 
name of this machine is mail.company.com, but receives mail for 
@company.com, you can set the email domain name to company.com. 

3. Click Save. 

Configuring your LDAP client 

When your standard LDAP client is correctly configured, you can access user and 
group information on the Qube 3. You must set up your client to authenticate with 
the Qube 3 as a valid user. 

In Administration > Users and Groups > LDAP Directory, select a Base 
Distinctive Name (DN) under which to export. For example, you could enter 
“o=Cobalt, c=US”. 

The following procedures describe two sample setups. It should be a similar 
procedure to configure other LDAP clients. 

Netscape Messenger on Macintosh 

To configure your Netscape LDAP client: 

1. Open the Netscape Messenger window. 

2. Select Communicator > Address Book. The Address Book window opens. 

3. With the Address Book window active, select File > New Directory. The 
LDAP Server Properties window opens. 

4. Fill in the following fields: 

• Description. Enter a name for the directory. 

• LDAP Server. Enter the fully qualified domain name of the Qube 3. 

• Search Root. Enter the value(s) that you entered in the Base Distinctive 
Name field in the Administration > Users and Groups > LDAP 
Directory on the Qube 3. 
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5. Click to enable the check box “Log in with name and password”. You need 
to authenticate yourself as a user on the Qube 3 with: 

• <username>@<hostname.domainname> 

• your password 

You can click to enable the check box “Save password” if you want. 

6. You can leave the other settings as they are. 

7. Click OK. 

Microsoft Outlook Express on Windows 

To configure your Microsoft Outlook LDAP client: 

1. Open Microsoft Outlook. 

2. Select Tools > Accounts. The Internet Accounts window opens. 

3. Select Directory Service. A list of directory services appears. 

4. On the right, click Add > Directory Service. An Internet Connection Wizard 
appears in a popup window. 

5. In the field Internet directory (LDAP) server, enter the fully qualified 
domain name of the Qube 3. 

Click to enable the check box “My LDAP server requires me to log on”. 

6. Click Next. 

7. Click the radio button Log on using 

• LDAP account name. Enter cn=username, o=Cobalt, c=US 

• Password. Enter your password for your Qube 3 account.  

✍ Note: o=Cobalt, c=US must match the value entered in the 
Base Distinctive Name field in Administration > Users and 
Groups > LDAP Directory on the Qube 3. 
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8. Click Next. 

9. For Check Email Addresses, you can select Yes or No. Click Next. 

10. For Friendly Name, enter an easy-to-remember name for the directory 
service. For example, enter Eric Braswell’s Directory. 

11. Click Next. 

12. Click Finish. You return to the Internet Accounts window. 

13. Double-click on the account you just created. The Properties - General 
window for that account opens. This window displays the information you 
entered through the Wizard.

14. Click Advanced at the top. 

15. In the field Search base, enter the value(s) that you entered in the Base 
Distinctive Name field in the Administration > Users and Groups > 
LDAP Directory on the Qube 3.

16. Click OK. 

LDAP Import 
Use this function to Import users from an LDAP directory as follows: 

1. Select Administration > Users and Groups > Import. The File Import 
table appears; see Figure 49. 

Figure 49.   File Import table  
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2. In the pull-down menu, select Lightweight Directory Access Protocol 
(LDAP) Import to open the following table. 

Figure 50.   LDAP Import table  

3. Configure the settings in the LDAP Import table. 

• Server Network Address. The IP or hostname of the server from which 
you wish to import. 

• Base Distinctive Name (Dn). The base of the LDAP entries to import. 

• Binding Distinctive Name (Dn). This is the binding distinctive name 
(Dn) of the admin user on the LDAP server. This value along with its 
respective password are needed to authenticate and acquire the 
appropriate information for importing users. 

• Password. This is the password for the binding distinctive name (Dn). 

• User Filter. (optional) Enter the filter used for determining which object 
classes to import as users. If the field is left blank, the system uses the 
value (|(objectClass=cobaltAccount)(objectClass=posixAccount)). 

• Group Filter. (optional) Enter the filter used for determining which 
object classes to import as groups. If the field is left blank, the system 
uses the value (|(objectClass=cobaltGroup)(objectClass=posixGroup)). 

4. Click Save. 
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File Import 
The Import feature allows you to upload a tab-delimited file containing user 
information to the Qube 3, saving you the time and effort of adding a large list of 
users individually through the Add New User function. 

The tab-delimited file must have the following information for each user; this 
information replicates a number of the fields on the Add New User table:

• user name 

• full name 

• a plain-text password 

• email alias(es) (optional)  

The information in the tab-delimited file must be in the following format: 

username[tab]fullname[tab]password[tab]email alias[newline] 

To import users and groups onto the server: 

1. Select Administration > Users and Groups > Import. The File Import 
table opens. See Figure 51. 

Figure 51.   File Import table  

2. Enter the directory path and file name in the Source File field, or click 
Browse to locate the tab-delimited file on your computer. 

3. Click Import Now. Depending on the number of users to import, this 
operation may take several minutes. 

Once the import operation is complete, you can modify the individual users. 
See “Modifying a user account” on page 109. 

✍
Note: If a user has more than one email alias, separate the aliases 
with a comma or a space. 
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Email Services 
This section describes how the Qube 3 administrator configures the Qube 3 email 
settings. For additional information about setting up your email client to access 
email on the Qube 3, see “Using email on the Qube 3” on page 38. In addition, 
Chapter 4, “Users Site,” on page 63 describes how to use Web Mail. 

Mailing Lists 
In the Mailing Lists section, you can create and manage mailing lists. A mailing 
list can receive email from an address that is external to the Qube 3. 

The Qube 3 Administrator can: 

• add a mailing list 

• modify a mailing list 

• remove a mailing list 

Adding a mailing list 

To add a mailing list: 

1. Select Administration > Email Services > Mailing Lists. The Mailing 
Lists table appears; see Figure 52. 

Figure 52.   Mailing Lists table  
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2. Click Add. The Add Mailing List table appears in the Basic section; see 
Figure 53. 

Figure 53.   Add Mailing List - Basic table  

3. Enter a name for the mailing list in the List Name field. 

You can only use lowercase English letters, numbers, and the hyphen (-) and 
underscore (_) characters. There is no limit on the number of characters in 
the name. 

4. Add local subscribers to the mailing list. 

To add an existing Qube 3 user, select a name in the not subscribed list and 
click the left arrow to move the subscriber to the subscribed list. 

5. Add remote (external) subscribers to the mailing list. 

To add an external subscriber to the mailing list, enter the complete email 
address in the External Subscribers field (for example, tstonis@xyz.com). 

6. You can enter additional information about the mailing list in the Remarks 
field. 

7. Click Advanced in the top right corner. The Advanced section appears; see 
Figure 54.
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Figure 54.   Add Mailing List - Advanced table  

8. Fill in the fields. 

• Owner/Moderator. Enter a properly formatted email address or the user 
name of the Qube 3 user performing all the administrative duties for the 
mailing list. For example, user@cobalt.com is a valid entry. 

The default value is admin.

• Password. This password is used when performing certain list 
administration tasks through email, such as approving subscriptions or 
moderating messages. If you do not plan to use these features, leave this 
field blank. 

• Posting Policy. Use the pull-down menu to select a policy for sending 
messages to the mailing list. 

• Only Subscribers Can Post Messages. Only members of the 
mailing can post messages to the mailing list. 

• All Users Can Post Messages. This means that anyone with access 
to email can post messages if they know name of the mailing list. 

• Moderator Confirms All Messages. The moderator indicated in 
the first field must approve the messages sent to the mailing list 
before they are posted. 
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• Subscription Policy. Use the pull-down menu to select a policy for 
subscribing to the mailing list. 

• Open: any user may subscribe. Anyone with an email address can 
subscribe herself or himself to the mailing list; that person is 
automatically subscribed. This is not restricted to registered Qube 3 
users. 

• Confirm: Email confirmation is required for subscription. The 
system sends a confirmation message to the requestor who must then 
reply to that message, confirming the subscription request. The 
email is automatically generated by the system. 

• Closed: List owner approval is required for subscription. 
Anyone with an email address can subscribe herself or himself but 
the list owner/moderator must approve all subscription requests. 

• Reply Policy. Specify whether a reply to a message is sent to all 
members of the mailing list or just to the original sender of the email 

• Maximum Message Length. From the pull-down menu, select the 
maximum size allowed for messages sent to this mailing list. Messages 
exceeding this size will be rejected. The default is 50 KB.

If the message is too large, the list owner receives the posting. It is up to 
the list owner to decide whether to send the message along to the rest of 
the mailing list. 

• Archiving. Check the enable box to archive the messages for this 
mailing list. Local users can access these archives in their WebMail 
account. 

• Keep Period (Days) Enter a number specifying the number of days that 
messages are kept in the archive. Enter a zero to keep archived messages 
indefinitely. 

The default value is 30 days. 

9. Click Save. 
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Modifying a mailing list 

To modify a mailing list: 

1. Select Administration > Email Services > Mailing Lists. The Mailing 
Lists table appears. 

2. Click the green pencil icon next to the group whose mailing list you want to 
modify. 

3. The Modify Mailing List table appears. There are basic and advanced tables. 
Except for the screen titles, these tables are contain the same fields as the 
Add New Mailing List tables. See Figure 55 and Figure 56. 

For details on how to enter data in these tables, refer to “Adding a mailing 
list” on page 123. 

4. Click Save. 

Figure 55.   Modify Mailing List - Basic table  



Chapter 5: Administration Site

128 Cobalt Qube 3 User Manual

Figure 56.   Modify Mailing List - Advanced table  

Deleting a mailing list 

To delete a mailing list: 

1. Select Administration > Email Services > Mailing Lists. The Mailing 
Lists table appears. 

2. Click the red trash can icon next to the mailing list that you want to delete. 
Aconfirmation dialog box verifies the deletion.  

3. Click OK in the confirmation dialog box. 

The screen refreshes and the Mailing Lists table appears with the deleted 
mailing list removed from the table. 

✍-

Note: A mailing list with a dimmed trash can is a mailing list 
created as part of a group on the Qube 3. To remove this mailing 
list, you must remove the corresponding group. See “Deleting a 
group” on page 117. 
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Email server overview 
The Qube 3 supports email for entire domains such as www.mydomain.com. By 
default, each registered user has an email account created on the Qube 3.

The Qube 3 supports multiple client and server email protocols but does not 
implement virtual email users. This means that for the entire Qube 3, each user 
must have a unique username. 

The Qube 3 can act as a Simple Mail Transfer Protocol (SMTP) server for 
sending and receiving Internet email. 

Users can retrieve their email using the Post Office Protocol 3 (POP3) and the 
Internet Message Access Protocol 4 (IMAP4). Users can send mail using the 
Simple Mail Transfer Protocol (SMTP).  

✍
Note: WebMail uses the IMAP email server. If the Qube 3 
Administrator disables the IMAP server; users cannot access 
WebMail. 

The IMAP server is enabled by default. 

�
Important: If your Internet service provider (ISP) also provides 
your Domain Name System (DNS) service, the ISP must create a 
Mail Server (MX) record specifying your Qube 3 as the mail server 
for your registered domain in order for the Qube 3 to receive email. 

If your Qube 3 is integrated into a larger network, consult with your 
network administrator for this information. 

The IP address of the DNS server must be entered in the network 
settings for the Qube 3 or the SMTP protocol will not work. 

For more information, see “Network Integration” on page 31. 

If you are providing your own DNS service through the Qube 3, 
you need to create an MX record for the Qube 3. For more 
information on DNS, see Appendix E, “Domain Name System,” on 
page 227.
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Enabling the email server 
By default, all three options are enabled. To enable or disable an email server: 

1. Select Administration > Email Services > Email Servers. The Email 
Settings table opens in Basic mode; see Figure 57. 

2. Use the check boxes to enable or disable the following email servers. 

• SMTP. The Simple Mail Transfer Protocol server 

• IMAP. The Internet Message Access Protocol server 

• POP. The Post Office Protocol server 

3. Click Save. 

Figure 57.   Email Servers Settings - Basic table  
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Configuring the email settings 
To configure the Email settings: 

1. Select Administration > Email Services > Email Servers. The Email 
Settings table opens in the Basic mode. 

2. Click Advanced to enter the Advanced mode; see Figure 58. 

Figure 58.   Email Servers Settings - Advanced table  
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3. Fill in the fields in the Advanced Email Settings table. 

• Delivery Schedule. This setting specifies how frequently email is 
delivered by the email server on the Qube 3. The Qube 3 queues the 
messages, sending them at the specified frequency. 

If you connect to the Internet through a dedicated phone line or by 
ethernet (through the secondary network interface), then you can choose 
to have your email delivered and retrieved more often. If you connect to 
the Internet through a modem that shares a phone line with other 
functions, or if your Internet access is charged by the minute, then you 
should specify less-frequent mail delivery and pickup.

• Maximum Email Message Size. This sets the maximum size of email 
messages this server will send or receive. The default value is to leave this 
field empty to allow this server to send and receive email messages of any 
size. You may optionally enter an integer greater than zero. 

• Force Senders Domain. An optional domain name can be specified to 
override the From: address of mail sent by users of this server. This 
feature is also called Domain Masquerade.

• Smart Relay Server. You can enter an optional host name in this field. 
With this feature, you can configure the Qube 3 to send Internet email to 
a specific email server. Enter the host name of the email server through 
which you want to relay your email. 

This feature is useful if the Qube 3 does not have direct Internet access 
(for example, the Qube 3 is subject to a restrictive firewall), but can 
communicate with an email server that has direct Internet access. 

• POP Authenticated Relaying. Check this box to enable SMTP relay 
trusts by POP authentication. If checked, any user who successfully uses 
POP to check mail is trusted for 15 minutes to send email using the 
SMTP service. This feature is useful for users who frequently travel. 
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• Relay Email from Hosts/Domains/IP Addresses. Enter the IP 
addresses, host names, or domain names that are allowed to relay email 
through this Cobalt Qube 3 server. For more information, see “Email 
relaying” on page 41. 

A user cannot send outgoing email through this server unless the 
IP address, host name or domain name of the machine from which they 
they are connecting is entered in this field. Networks may be specified in 
addition to IP addresses. For example, to allow relaying for a network 
192.168.1.1 with subnet mask 255.255.0.0, specify the address 
192.168.0.0.   

The entries you add to this field serve as part of a pattern match against 
the email that the client is sending. As a result, some handy shortcuts are 
possible. If you have a number of hosts in the same network block, you 
can, as a shortcut, simply enter the number of the network block. 

For example, specifying a network such as 192.168.1.0 in the “Relay 
email from these hosts/domains” field trusts all IP addresses from 
192.168.1.0 through 192.168.1.254. 

!
Caution: Some users advise you to open relay to all com, edu, net 
and other top-level domain addresses. However, doing so allows 
hosts belonging to com, edu, net and others to relay email through 
your Cobalt server; this relayed mail is known as spam mail.

Spam mail can appear as though it originated from your server and 
as a result, others may blacklist your server as a known spam site. If 
your server is blacklisted, many mail servers will not relay your 
email and your customers will not receive any email messages.

✍-

Note: By default, the domain name for the Qube 3 is allowed to 
relay email. 

If you do not want to allow email to be sent through the Qube 3, 
enter the domain name of the Qube 3 in the “Block Email From 
Hosts/Domains” field. You will be able to download email but not 
be able to send outgoing email messages through Qube 3. 

For more information, see “Configuring the email settings” on 
page 131. 
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If you want to allow connections from a host that ends, for example, in 
mydomain.com, add the string mydomain.com in the text area.  

• Receive Email Addressed to Hosts/Domains. In this field, enter the 
IP addresses or domain names for which you receive email. Email 
addressed to the <hostname.domainname> of the Qube 3 is 
automatically accepted. 

For example, if you want to receive email addressed to you at 
“username@domain.com”, then you must enter “domain.com” in this 
field. Otherwise, a sender will have to include the host name in your 
email address (for example, username@hostname.domain.com).

• Block Email from Hosts/Domains. In this field, enter email addresses 
or domains from which you want to block any email. Anyone trying to 
send you messages from one of these addresses or domains will receive 
an error message in return. 

• Block Email from Users. In this field, enter email addresses of users 
which you want to block any email. Anyone trying to send you messages 
from one of these addresses will receive an error message in return. 

4. Click Save in the Email Servers Settings table. 

✍ Note: If you entering a domain name or part of a domain name in 
the text box, you must have reverse DNS working on your clients. 
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Remote Retrieval (Multidrop) 
ISPs often arrange for all messages to an organization to be retrieved from a 
single mailbox. This mailbox is usually referred to as a “multidrop mailbox” 
because it contains email messages addressed to more than one person. Your ISP 
must configure your multidrop mailbox at the ISP to accept all email for your 
domain. The domain of the Qube 3 must match the domain of the email that is to 
be collected. 

The Qube 3 retrieves the email and then distributes it to the users on the Qube 3. 
Email messages that are addressed to recipients who are not listed as users on the 
Qube 3 are forwarded to the Qube 3 Administrator. 

To setup Remote Retrieval: 

1. Select Administration > Email Services > Remote Retrieval. The Remote 
Retrieval table appears; see Figure 59. 

Figure 59.   Remote Retrieval table  
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2. Configure the fields in the Remote Retrieval table. 

• Enable Remote Retrieval. Click the check box to enable remote 
retrieval. 

• Remote Email Server. Enter the network address or fully qualified 
domain name of the remote email server from which to retrieve your 
entire domain's email messages. Enter a properly formatted network 
address or fully qualified domain name for the Remote Email Server. For 
example, 192.168.1.100 and mail.cobalt.com are valid entries. 

• User Name. Enter the user name of the account on the remote email 
server from which to retrieve your entire domain's email messages. 

• Password. Enter the password of the account on the remote email server 
from which to retrieve your entire domain's email messages. 

• Message Retrieval Protocol. Select a method of retrieving incoming 
email messages from the remote email server. The ETRN method should 
only be used if your remote email server is ESMTP-compliant. The 
default setting, POP3, should work for most users. (for an explanation of 
the various email protocols, see Appendix G, “Glossary”.) 

• Retrieval Frequency. Specifies how often email is retrieved.  

3. Click Save.

✍ Note: If you set the same frequency for email delivery and retrieval, 
then both take place at the same time, saving you access time and 
charges. (See “Configuring the email settings” on page 131 for 
setting the email delivery schedule.)
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File Services 
See “Sharing files and transferring data” on page 46 for further information on 
Qube 3 file sharing. This section describes how to setup the Qube 3 file sharing 
settings.  

Windows file sharing (SMB) 
Windows-based machines use a file-sharing protocol called Server Message 
Block (SMB) or Windows file sharing. Once Windows file sharing is set up, the 
Qube 3 appears in your Network Neighborhood as a machine named <hostname> 
(the name that the Qube 3 Administrator assigned to the Qube 3 in the Setup 
Wizard or the Control Panel screen). For additional information on setting up 
Windows file sharing, see “Using Windows file sharing (SMB)” on page 46. 

To set the Windows file sharing settings: 

1. Select Administration > File Services > Windows. The Windows File 
Sharing Settings table appears; see Figure 60 for the Basic settings and 
Figure 61 for the Advanced settings. 

Figure 60.   Windows File Sharing Settings - Basic table  

Figure 61.   Windows File Sharing Settings - Advanced table  

✍ Note: Windows File Sharing (SMB), FTP and Appleshare are 
enabled by default; guest share is not enabled by default.
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2. Configure the following settings: 

• Enable Server. Check this box to enable Windows File Sharing.

• Maximum Simultaneous Users. The default value is 25 users but you 
can change this value. 

• Workgroup. Enter a workgroup or NT domain to which you want the 
Qube 3 to belong. This entry determines how the Qube 3 appears in the 
Network Neighborhood on a Windows client machine. 

• Windows 95/98 Network Login Authentication. Enable this option if 
you want the Qube 3 to act as a Windows logon server, authenticating 
users when they begin a session on a Windows 95 or Windows 98 
machine. This means that when Windows users log into the network, 
they are authenticated using their Qube 3 account. 

• Windows Internet Naming Service (WINS) Server. If your Windows 
network spans more than one TCP/IP subnet, you must use a WINS 
server for NetBIOS name resolution. To use your Qube 3 as a WINS 
server, click the radio button “Be a WINS Server.” If you do have a 
WINS server on your network, be sure to specify the IP address of the 
WINS server in the “Other machine” field. If you do not have a WINS 
server on your network, choose “Other machine” field and leave the field 
blank.

3. Click Save. 
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FTP 
As the Qube 3 Administrator, you can enable the File Transfer Protocol (FTP) 
server and specify the number of simultaneous users.  

To set the FTP settings for your Qube 3: 

1. Select Administration > File Services > FTP. The File Transfer Protocol 
(FTP) Settings table appears; Figure 62. 

Figure 62.   File Transfer Protocol (FTP) Settings table  

2. Click the Enable Server check box. 

3. Specify the maximum number of simultaneous users. 

4. Click Save. 

✍ Note: To enable anonymous FTP access, see “Guest Share” on 
page 140. 
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Apple file sharing (AppleShare)
AppleShare is the Macintosh file-sharing protocol. This option allows you to 
share files between the Qube 3 and Macintosh computers on your network. In the 
Qube 3, AppleShare works over IP networks, which makes Macintosh-to-Qube 3 
file sharing faster (even on your internal network). 

To enable Apple file sharing: 

1. Select Administration > File Services > Apple. The Apple File Sharing 
Settings table appears; see Figure 63. 

Figure 63.   Apple File Sharing Settings table  

2. Click the Enable Server check box.

3. Specify the maximum number of simultaneous users.

4. Click Save.

Guest Share 
When you enable the Guest Share feature, you provide guest access to Windows 
File Sharing and Appleshare. You also enable anonymous FTP access which 
allows a user without a password to download files through FTP. 

You can also enable guest users to upload files to the guest share and set a limit 
on amount of disk space allowed for uploaded files. 

To enable Guest Access: 

1. Select Administration > File Services > Guest Share. The Guest Share 
Settings table appears; see Figure 64. 

2. Click the check the Enable Guest Access.

3. You can allow a guest user to upload files to the guest share. 

Click the Enable check box and enter a value (in MB) for the maximum disk 
space allowed for incoming files. 

4. Click Save. 
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Figure 64.   Guest Share Settings table  

Web Services 

Web settings
To set the Web settings:

1. Select Administration > Web Services > Web. The Web Settings table 
appears; see Figure 65. 

2. To enable the FrontPage Extensions, click the Enable check box and enter a 
webmaster password.

Figure 65.   Web Settings table  
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3. Specify the CGI access settings. 

• Do not allow access to any user. Only the Qube 3 Administrator is 
allowed to run CGI scripts. 

• Allow access to all users. All users are allowed to run CGI scripts.

• Allow access to specified users only. You can specify the users who are 
allowed to run CGI scripts. 

If you select this option, click on the user names to transfer between the 
Users Allowed Access and Users Not Allowed Access windows. For 
more information on using CGI scripts, see “CGI scripts” on page 44 
and “Directory structure” on page 224.  

4. Click Save. 

Restricted Web access 
As the Qube 3 Administrator, you can control Web sites accessed through the 
Qube 3 server. You can restrict user access to specific Web sites only, block users 
from accessing specific Web sites or apply no restrictions at all.  

You can specify the sites by a host name and domain name or by IP address. 

To configure the settings for the Restricted Access feature: 

1. Select Administration > Web Services > Restricted Access. The Restricted 
Web Access table appears; see Figure 66. 

2. Choose a Restriction Policy from the pull-down menu: 

• Permitted Access. If you choose the Permitted Access policy, users can 
access only the Web sites specified in the following fields. They cannot 
access any other sites. 

• Blocked Access. If you choose the Blocked Access policy, users are 
blocked from accessing the Web sites specified in the following fields. 

• Unrestricted. If you choose the Blacklist policy, users can access all 
Web sites on the Internet. 

!
Caution: Poorly written CGI scripts can cause performance 
problems on the server. 

✍ Note: This feature affects access to Web sites only. FTP and other 
protocols are not affected by this feature. 
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3. (optional) Enter the host name(s) or domain name(s) to which you want to 
apply the policy chosen in the pull-down menu. Blanket domain names may 
be used by including a leading period character before a domain name. 

For example, if you enter “www.sun.com”, the restriction policy applies to 
this host only. However, if you enter “.sun.com”, the policy applies to 
“www.sun.com”, “cobalt.sun.com” and all other Web sites sharing the 
“sun.com” domain. 

4. (optional) Enter the list of IP addresses to which you want to apply the 
policy chosen in the pull-down menu. 

5. Click Save. The new configuration settings are saved and the Restricted Web 
Access table refreshes. 

Figure 66.   Restricted Web Access table  
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Web Caching 
Web Caching is available on the Qube 3 Professional Edition and Business 
Edition only. 

The Qube 3 offers a caching feature. When the caching feature is enabled, all 
Web traffic (http://) routed through the Qube 3 is cached; the Qube 3 acts as a 
caching proxy server for Web clients. This is known as “transparent caching”.

Alternatively, if network traffic is not routed through the Qube 3, clients can take 
advantage of the Web Caching feature by configuring their Web browser to use 
the IP address of the Qube 3 as its HTTP proxy and by setting the proxy port 
number to 3128.  

To enable the Web caching feature: 

1. Select Administration > Web Services > Web Caching. 

The Web Caching Settings table appears. 

2. Click the Enable Caching check box. 

3. Click Save. 

✍
Note: The Web Caching feature on your Qube 3 relies on the Basic 
Firewall feature to operate. If you enable the Web Caching feature, 
the Basic Firewall feature is enabled automatically. 

If you disable the Basic Firewall feature, the Web Caching feature 
is still enabled but will not function. To ensure that the Web 
Caching feature is functioning, re-enable the Basic Firewall feature. 

For more information, see “Basic Firewall” on page 57. 
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Network Services 

 

In the Network section, you can enter the network configuration settings for the 
Qube 3. The network settings make the 

 

Qube 3

 

 visible to other computers.  

There are three ways to set up the Qube 3 network access:

• Both intranet and Internet communication is provided through the primary 
network interface.

• Intranet access is provided through the primary network interface; Internet 
access is provided through the secondary network interface. The Qube 3 acts 
as a gateway. 

• Intranet access is provided through the primary network interface; Internet 
access is provided by an analog modem or an ISDN terminal adapter 
connected to the high-speed serial port. Modem settings are covered in 
“Configuration for an analog modem or ISDN” on page 169 

 

DNS server 

 

The Domain Name System (DNS) is a vital and integral part of the Internet. 
Setting up DNS correctly on your Qube 3 is very important. For this reason, we 
have created an appendix solely for explaining DNS. See Appendix E, “Domain 
Name System,” on page 227.

The appendix covers the following items:

• basic DNS issues 

• advanced DNS issues 

• a quick start guide detailing a sample setup of DNS for a Qube 3 

• a brief history of the DNS service 

 

�

 

Important:

 

 Coordinate any changes to the network configuration 
information with your Internet service provider (ISP) to ensure the 
integrity of your network. If your Qube 3 is integrated into a larger 
network, consult with your network administrator for this 
information. 

Incorrect network settings can result in a loss of connectivity.
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Dynamic Host Configuration Protocol (DHCP) 
server  

 

The Dynamic Host Configuration Protocol (DHCP) feature allows the Qube 3 to 
assign automatically the network configuration information to network devices 
that support DHCP, including Macintosh and Windows desktop computers. This 
information includes the domain name, DNS server(s), IP address, subnet mask 
and gateway. 

To configure the DHCP settings:

1. Select 

 

Administration >

 

 

 

Network Services > DHCP 

 

to open the following 
table.

 

Figure 67.   

 

DHCP Settings table  

!

 

Caution:

 

 If a DHCP server is already present on your network, do 
not configure the Qube 3 to act as a DHCP server. 
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2. Specify the settings in the DHCP Settings table: 

•

 

Enable Server.

 

 This check box enables or disables the feature of DHCP 
server. If you enable this feature, the Qube 3 automatically provides the 
network configuration information to a client machine when you power 
up the client machine. 

•

 

Client Domain Name. 

 

Enter the domain name that the Qube 3 will 
automatically serve to these clients. This domain name is usually the 
same as the domain name of your Qube 3. Enter only lowercase 
alphanumeric characters, dashes or periods. For example, cobalt.com is 
a valid entry. 

•

 

Client DNS Address. 

 

Enter the IP address or addresses of your local 
DNS server or servers that the Qube 3 will automatically serve to these 
clients. A DNS server translates text-based host names and domain 
names into numeric IP addresses and vice-versa. Enter a series of four 
numbers between 0 and 255 separated by periods. For example, 
192.168.10.10 is a valid entry. 

For more information on DNS, see Appendix E, “Domain Name 
System”. 

•

 

Client Subnet Mask. 

 

Enter the subnet mask that the Qube 3 will 
automatically serve to these clients. Enter a series of four numbers 
between 0 and 255 separated by periods. For example, 255.255.255.0 is 
a valid entry. 

•

 

Client Default Gateway. 

 

Enter the IP address of your local network 
gateway that the Qube 3 will automatically serve to these clients. A 
network gateway allows you to connect to the world outside of your local 
network. Enter a series of four numbers between 0 and 255 separated by 
periods. For example, 192.168.10.10 is a valid entry.

•

 

Maximum Lease Time. 

 

The networking information assigned by a 
DHCP server expires after a fixed period of time. Enter the maximum 
period of time in seconds before a lease expires. Enter an integer greater 
than zero. The default value is 86400 seconds (24 hours).

3. Click 

 

Modify Address Assignments

 

. The Address Assignment List tables 
appear; see Figure 68. 

 

Figure 68.   

 

Address Assignments List tables  
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4. Click 

 

Add 

 

for the Dynamic Address Assignments List to open the table 
shown Figure 69. 

 

Figure 69.   

 

Add New Dynamic Address Assignment table  

 

5. Specify the following settings: 

•

 

IP Address Range (From). 

 

Enter the first or lowest IP address in the 
range of IP addresses to be dynamically assigned by this server. Enter a 
series of four numbers between 0 and 255 separated by periods. For 
example, 192.168.1.100 is a valid entry.

•

 

IP Address Range (To). 

 

Enter the last or highest IP address in the range 
of IP addresses to be dynamically assigned by this server. Enter a series 
of four numbers between 0 and 255 separated by periods. For example, 
192.168.1.110 is a valid entry.

6. Click 

 

Save

 

. 

7. Click 

 

Add

 

 for the Static Address Assignments List to open the table shown 
in Figure 70. 

 

Figure 70.   

 

Add New Static Address Assignment table  

 

8. Specify the following settings: 

•

 

IP Address. 

 

Enter the IP address to be statically assigned by this server 
to a specific computer; the computer is identified by its Media Access 
Control (MAC) address entered in the second field. 

•

 

MAC Address. 

 

Enter the MAC address of the computer that receives a 
static IP address from this DHCP server. A MAC address is the hardware 
address of the network interface card. This hardware address is a unique 
identifier and cannot be changed after manufacture. 

Enter a series of 12 hexadecimal digits separated by a colon between 
every 2 digits. For example, 00:10:E0:01:33:AB is a valid entry. 

9. Click 

 

Save

 

. 
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Basic Firewall 

 

 

A firewall provides network security through a set of rules that restrict the flow of 
information between your Qube 3 and your network. It is also used to control the 
information that your Qube 3 allows to pass between different networks (such as 
your company’s intranet and the public Internet.

For more information on how the Basic Firewall feature on the Qube 3 functions, 
see “Basic Firewall” on page 57. 

On this screen, the Qube 3 Administrator can: 

• enable and disable your firewall 

• create and edit rules for each of the three rule chains 

• re-order your rules within each rule chain 

• change the default policy for each rule chain  

!

 

Caution:

 

 Basic Firewall is an advanced feature of your Qube 3 
server. This feature is not recommended for novice users.

 

✍

 

Note: 

 

The Web Caching feature on your Qube 3 (available on the 
Qube 3 Professional Edition and Business Edition only) relies on 
the Basic Firewall feature to operate. If you enable the Web 
Caching feature, the Basic Firewall feature is enabled 
automatically. 

If you disable the Basic Firewall feature, the Web Caching feature 
is still enabled but will not function. To ensure that the Web 
Caching feature is functioning, re-enable the Basic Firewall feature. 

For more information, see “Web Caching” on page 60. 
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Firewall Safeguard 

 

When enabling your firewall for the first time or applying changes to the 
configuration of the firewall currently functioning, the Qube 3 verifies that the 
Web browser that the Qube 3 Administrator is currently using is still able to 
communicate with the Qube 3 after the firewall settings have been applied. 

The purpose of this verification is to prevent the Qube 3 Administrator from 
accidentally misconfiguring the firewall and locking herself or himself out of the 
Qube 3 completely, rendering the Qube 3 inaccessible. 

If, sixty seconds after the new firewall settings have been applied, the Qube 3 has 
not received any communication from the Qube 3 Administrator’s Web browser, 
the Qube 3 automatically disables the firewall feature. 

 

Applying changes 

 

If you make changes to the Basic Firewall settings when the firewall is already 
enabled, the changes are not immediately reflected in the state of the firewall that 
is currently functioning. 

You must click 

 

Apply Changes Now

 

 to make your changes take effect. The 
changes do not take effect in real time because that could cause the firewall to 
enter a temporary, insecure state while you are in the process of editing the 
firewall configuration.

If Basic Firewall is not enabled, the 

 

Apply Changes Now

 

 button is greyed out. 

 

Enabling the firewall feature 

 

To enable the firewall feature:

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears; see Figure 71. 

2. Click to enable the check box Enable Firewall. 

3. Click 

 

Save

 

. A popup window notifies you that you are about to enable packet 
filtering on your firewall.

4. Click 

 

OK

 

. 

 

Figure 71.   

 

Firewall Settings table  
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Configuring the firewall settings 

 

To configure the Basic Firewall settings: 

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears. 

2. The Firewall Settings table consists of three more sections that you access 
with the 

 

Select Section

 

 pull-down menu. These are shown in Figure 72, 
Figure 73 and Figure 74. 

The rule tables list the IP filtering rules for the firewall currently functioning. 
You can perform the following actions in the Rules tables: 

• Click 

 

Add

 

 to add a new rule. See “Adding a firewall rule” on page 155. 

• Click the green pencil icon to edit a rule. See “Modifying a firewall rule” 
on page 156. 

• Click the red trash can icon to delete a rule. See “Deleting a firewall rule” 
on page 159. 

• Click 

 

Apply Changes Now

 

 to apply rule changes to the firewall 
currently functioning. The 

 

Apply Changes Now

 

 button is greyed out 
until you modify rules that define your firewall. Your changes do not 
take effect until you click this button. 

3. After making changes in one of the Firewall Settings tables, click 

 

Save

 

. 
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Figure 72.   

 

Firewall Input Rules  

 

Figure 73.   

 

Firewall Forwarding Rules  

 

Figure 74.   

 

Firewall Output Rules  
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Policy definitions 

 

In the Add and Modify Firewall Rule tables, the Qube 3 Administrator selects an 
action in the Policy pull-down menu. The policy determines the action taken if a 
packet matches the rule’s criteria. 

The following policies are supported: 

•

 

ACCEPT

 

 accepts the packet into the system. The packet “passes” the rule 
chain and no further rules within this chain are applied. 

•

 

DENY

 

 discards the packet. The packet is dropped from the system; the 
originator of the packet in not notified that the packet was discarded. 

•

 

REJECT

 

 rejects the packet. Like DENY, the packet is dropped from the 
system. However, unlike DENY, the sender of the packet is notified that the 
packet was discarded. 

•

 

MASQ

 

 masquerades the packet. Masquerading rewrites the packet as it 
passes through the Qube 3 to make it appear that the packet originated at the 
firewall. This is the same effect as enabling Network Address 
Translation (NAT).  

•

 

REDIRECT

 

 redirects the packet to a local port number. Regardless of the to 
which port number or IP address the packet is actually addressed, the packet 
is instead routed to a port number on the Qube 3 itself. This port is specified 
in the “Redirect to Port Number” field. This feature is primarily used for 
features such as transparent proxy servers.  

 

✍

 

Note: 

 

The MASQ policy is applicable only when configuring 
forwarding rules.

 

✍

 

Note: 

 

The REDIRECT policy is applicable only when configuring 
input rules.
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Viewing a chain of rules 

 

To view a chain of rules: 

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears; see Figure 75. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain or Output Rule Chain. 

The rules table for that chain appears, displaying the list of rules currently 
configured for that rule chain. 

 

Figure 75.   

 

Sample of a list of Firewall rules  

 

Changing the default policy for a chain 

 

To change the default policy for a chain of rules: 

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain or Output Rule Chain. 

The rules table for that chain appears, displaying the list of rules currently 
configured for that rule chain. 

3. In the Default Policy pull-down menu, select the default policy you want to 
apply to this rule chain. For definitions of the policies, see “Policy 
definitions” on page 153. 

4. Click 

 

Save

 

. 
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Adding a firewall rule 

 

To add a firewall rule:

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain or Output Rule Chain. The rules table for that chain appears.

3. Click 

 

Add

 

. The Add New Firewall Rule table appears; see Figure 76. 

 

Figure 76.   

 

Add New Firewall Rule table  

 

4. Configure the following settings: 

•

 

Source IP Address (Low). 

 

Enter the first or lowest source IP address in the 
range of IP addresses to be matched by this rule. 

•

 

Source IP Address (High). 

 

Enter the last or highest source IP address in the 
range of IP addresses to be matched by this rule.  

 

✍

 

Note: 

 

To match any source IP address, leave both the Low and High 
Source IP Address fields empty. 
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•

 

Source Port Number(s). 

 

Enter the first and last source port number in the 
range of source IP addresses to be matched by this rule. To match any source 
port number, leave the Source Port Number fields empty. 

•

 

Destination IP Address (Low). 

 

Enter the first or lowest destination IP 
address in the range of IP addresses to be matched by this rule. 

•

 

Destination IP Address (High). 

 

Enter the last or highest destination IP 
address in the range of IP addresses to be matched by this rule.  

•

 

Destination Port Number(s). 

 

Enter the first and last destination port 
number in the range of destination IP addresses to be matched by this rule. 
To match any destination port number, leave the Destination Port Number 
fields empty. 

•

 

Network Protocol. 

 

Enter the network protocol of the packets to be matched 
by this rule. The options are: Any Network Protocol, TCP, UDP, ICMP, IPIP 
and Encap.

•

 

Network Interface. 

 

Enter the network interface of the packets to be 
matched by this rule. The options are: Any Network Interface, Primary 
Network Interface, Secondary Network Interface or PPP Dialup Interface. 

•

 

Policy

 

. Select the policy for this rule chain. The policy determines the action 
applied to a packet that meets the criteria of this firewall rule. For definitions 
of the policies, see “Policy definitions” on page 153. 

•

 

Redirect to Local Port Number. 

 

If the REDIRECT policy has been 
selected, enter a local port number to which packets that meet the criteria of 
this firewall rule are redirected. 

If the REDIRECT policy has not been selected, this field is ignored. 

5. Click 

 

Save

 

. 

 

Modifying a firewall rule 

 

To modify a firewall rule: 

1. Select 

 

Administration > Network Services > Basic Firewall

 

. The Firewall 
Settings table appears. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain, or Output Rule Chain. The rules table for that chain appears.

 

✍

 

Note: 

 

To match any destination IP address, leave both the Low and 
High Destination IP Address fields empty. 
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3. Click the green pencil icon next to the rule you want to modify. The Edit 
Firewall Rule table appears; see Figure 77. 

 

Figure 77.   

 

Edit Firewall Rule table  

4. Modify one or all of the following fields. For a description of each field, see 
the procedure in “Adding a firewall rule” on page 155. 

• Source IP Address (Low) 

• Source IP Address (High) 

• Source Port Number(s) 

• Destination IP Address (Low) 

• Destination IP Address (High) 

• Destination Port Number(s) 

• Network Protocol 

• Network Interface 

• Policy 

• Redirect to Local Port Number 

5. Click Save. 

✍ Note: Rules in the Input Chain table that display a greyed-out 
pencil and trash can are related to the Web Caching feature. You 
cannot modify or delete these rules. 
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Changing the order of rules in a chain 

To re-order the firewall rules in a chain:

1. Select Administration > Network Services > Basic Firewall. The Firewall 
Settings table appears. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain, or Output Rule Chain. The rules table for that chain appears.

The first column in the table displays the order in which the system applies 
the firewall rules. Number 1 is the top-priority rule. For a sample chain of 
rules, see Figure 75. 

3. To change the position of a rule in the hierarchy, simply enter the number of 
of the position that you want the rule to occupy in the small window in the 
first column. 

For example, let us say that a table holds five rules. If you want to move the 
rule at position 4 to position 2, enter “2” in the window for the rule at 
position 4.  

4. Click Save. The rules within this chain are sorted according to the values you 
entered into the Order column and the table refreshes with the re-numbered 
rules. 

Using the same example, the rule at position 4 now occupies position 2; the 
rule at position 2 shifts down to position 3 and the rule at position 3 shifts 
down to position 4. The rule at position 5 does not shift. 

5. If you have finished changing the order of the rules and your firewall is 
currently enabled, click Apply Changes Now so that your changes take 
effect in the firewall currently functioning. 

✍ Note: You can change the position of more than one rule at a time.
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Deleting a firewall rule 

To delete a firewall rule: 

1. Select Administration > Network Services > Basic Firewall. The Firewall 
Settings table appears. 

2. From the Select Section pull-down menu, select Input Rule Chain, Forward 
Rule Chain, or Output Rule Chain. The rules table for that chain appears.

3. Click the red trash can icon next to the rule you want to delete. A 
confirmation dialog verifies the deletion. 

4. Click OK. 
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SNMP 
You can specify the Simple Network Management Protocol (SNMP) 
communities that can have read-only and read-and-write access to this SNMP 
agent. 

The default read-only access community is “public.” 

The default read-and-write access community is “private.”  

To specify the SNMP communities: 

1. Select Administration > Network Services > SNMP. The SNMP Settings 
table appears; see Figure 78. 

2. Configure the following settings: 

• Enable Server. Turns the Simple Network Management Protocol 
(SNMP) server on or off. 

• Read Only SNMP Community. Enter the Read Only SNMP 
Community to which this Qube 3 server belongs. The Read Only SNMP 
Community you enter can only contain alphanumeric characters along 
with '-' and '_'. 

• Read and Write SNMP Community. Enter the Read and Write SNMP 
Community to which this Qube 3 server belongs. The Read and Write 
SNMP Community you enter can only contain alphanumeric characters 
along with '-' and '_'. 

3. Click Save. 

Figure 78.   SNMP Settings table  

✍ Note: We recommend that you change the default string for the 
Read and Write SNMP Community to a unique value. 
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Telnet   

To specify the access settings for telnet: 

1. Select Administration > Network Services > Telnet.The Telnet Settings 
table appears; see Figure 79. 

Figure 79.   Telnet Settings table  

!
Caution: You can adversely affect the performance of your Qube 3 
if you modify system configuration files. Check your warranty card 
for details. 

!
Caution: Only advanced users who need to run shell scripts or use 
shell commands should access the Qube 3 through the telnet 
function. An advanced user is someone who is proficient in using 
the Unix operating system. 

Direct root logins are not allowed on the Qube 3. To obtain a root 
shell, telnet to the server and log in as the user admin. From the 
command prompt, type “su -” and press enter. Enter the 
administrator’s password at the password prompt. 

Only the Qube 3 Administrator can su - to root. 
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2. Select one of the following telnet access options to specify who has telnet 
access to the Qube 3.  

• Off - Do Not Allow Logins. No telnet access is available. This is the 
most secure option for the Qube 3. 

• On - Allow Only Administrator Logins. Only the Qube 3 
Administrator can telnet into the Qube 3. 

• On - Allow All User Logins. The Qube 3 Administrator and all 
registered users can telnet into the Qube 3. This is the least secure option 
but provides the most flexibility. 

3. Click Save. 

System 
This section describes how to use the following system administration screens: 

• TCP/IP. Configure the TCP/IP settings. 

• Internet. Configure settings specific to the type of internet connection 
for gateway on a LAN, cable modem or DSL, or analog modems and 
ISDN terminal adapters. 

• Power. Reboot the Qube 3. 

• Time. Set the Qube 3 time settings. 

• Information. Display information about the Qube 3. 

TCP/IP 
To configure the Transmission Control Protocol/Internet Protocol (TCP/IP) 
settings for the Qube 3: 

1. Select Administration > System > TCP/IP. The TCP/IP Settings table 
appears; see Figure 80. 

✍-

Note: The second and third options pose security risks; however, 
they allow the user to configure options supported by the Linux 
operating system that cannot be configured through the Web-based 
Server Desktop interface.
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Figure 80.   TCP/IP Settings table  

2. Configure the following fields as appropriate for your situation. 

• Host Name. Enter the host name of this Qube 3. The host name and the 
domain name combined together should uniquely identify this server. 
Enter only lowercase alphanumeric characters, dashes or periods. For 
example, www is a valid entry. 

• Domain Name. Enter the domain name of this Qube 3. The host name 
and the domain name combined together should uniquely identify this 
server. Enter only lowercase alphanumeric characters, dashes or periods. 
For example, cobalt.com is a valid entry. 

• DNS Servers. Enter the IP address or addresses of your local domain 
name server or servers. A domain name server translates textual host 
names and domain names into numerical IP addresses, and vice-versa. 
Enter a series of four numbers between 0 and 255 separated by periods. 
For example, 192.168.1.1 is a valid entry. Leaving this field empty will 
prevent this machine from finding other machines by hostname or 
domain name and will cause networking difficulties.  

✍
Note: Be sure to enter the IP address of your DNS server(s) here. 
Otherwise, the Simple Mail Transfer Protocol (SMTP) will not 
work. SMTP is used for transferring electronic mail messages. 

For more information, see Appendix E, “Domain Name System,” 
on page 227. 
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• IP Address (Primary Interface). Enter the IP address of the primary 
interface. If you are using only one network interface connection to the 
server appliance, use the primary interface and leave the secondary 
interface empty. Enter a series of four numbers between 0 and 255 
separated by periods. For example, 192.168.1.1 is a valid entry. 

• IP Network Mask (Primary Interface). Enter the network mask of the 
primary interface. If you are using only one network interface connection 
to the server appliance, use the primary interface and leave the secondary 
interface empty. Enter a series of four numbers between 0 and 255 
separated by periods. For example, 255.255.255.0 is a valid entry. 

• MAC Address (Primary Interface). The Media Access Control (MAC) 
address is the hardware address of the network interface card. This 
hardware address is a unique identifier and cannot be changed after 
manufacture. 

• IP Address (Secondary Interface). Enter the IP address of the secondary 
interface. If you are using only one network interface connection to the 
server appliance, use the primary interface and leave the secondary 
interface empty. Enter a series of four numbers between 0 and 255 
separated by periods. For example, 209.43.21.5 is a valid entry. 

• IP Network Mask (Secondary Interface). Enter the network mask of the 
secondary interface. If you are using only one network interface 
connection to the server appliance, use the primary interface and leave 
the secondary interface empty. Enter a series of four numbers between 0 
and 255 separated by periods. For example, 255.255.255.0 is a valid 
entry. 

• MAC Address (Secondary Interface). The MAC address is the hardware 
address of the network interface card. This hardware address is a unique 
identifier and cannot be changed after manufacture. 

3. Click Modify Static Routes. The Static Route List table appears; see 
Figure 81. 

Figure 81.   Static Route List table  
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4. Click Add. The Add Static Route table appears; see Figure 82. 

Figure 82.   Add Static Route table  

5. Configure the Add Static Routes table fields: 

• Target Subnet. Enter the IP address of the subnet to be re-routed. Enter 
a series of four numbers between 0 and 255 separated by periods. For 
example, 192.168.1.0 is a valid entry. 

• Target Network Mask. Enter the network mask of the subnet to be re-
routed. Enter a series of four numbers between 0 and 255 separated by 
periods. For example, 255.255.255.0 is a valid entry. 

• Gateway. Enter the IP address of the network gateway through which 
the target subnet's packets will be re-routed. Enter a series of four 
numbers between 0 and 255 separated by periods. For example, 
192.168.1.1 is a valid entry. 

• Network Interface. Select the network interface through which the 
target subnet’s packets will be re-routed. If no device is specified, a 
device will be selected based on the IP address of the network gateway. 
Your choices are: 

• Primary Ethernet Interface 

• Secondary Ethernet Interface 

• Point-to-Point Protocol Interface 

6. Click Save. 

Internet 
The following sections describe how to configure a connection to the Internet 
through the Qube 3. The Qube offers three connection methods: 

• Gateway on local area network (LAN) 

• Cable modem or Digital Subscriber Line (DSL) 

• Analog modem or Integrated Services Digital Network (ISDN) terminal 
adapter 
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Configuration for a gateway on a LAN 

Complete this section only if you intend to connect the Qube 3 to the Internet 
through an existing gateway located on a local area network (LAN). This 
gateway may be connected to the outside world through a T1/E1 line or other 
type of leased line.

You need a network connection and the IP address for the gateway.  

To configure the Qube 3 Internet settings for an existing gateway on a LAN:

1. Select Administration > System > Internet to open the Internet Settings 
table. 

2. If it does not open in the desired mode, click on the Change Internet 
Connection pull-down menu and select Gateway on Local Area 
Network (LAN). The Gateway on a LAN table appears; see Figure 83. 

Figure 83.   Internet Settings for Gateway on a LAN table  

✍ Note: Depending on your network configuration, the gateway can 
be on the primary or the secondary network interface. If the 
gateway is on the secondary network interface, ensure that you 
connect the secondary network interface on the back of the Qube 3 
to the network on which the gateway is located.

See Figure 6 on page 12. 
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3. Configure the following settings: 

• Server Gateway. Enter the IP address of your local network gateway. A 
network gateway allows you to connect to the world outside of your 
LAN. Enter a series of four numbers between 0 and 255 separated by 
periods. For example, 192.168.1.254 is a valid entry. Leaving this field 
empty prevents this machine from communicating with other networks. 

• IP Forwarding and Masquerading. Select the method of forwarding 
packets through the server appliance. Choosing packet forwarding with 
masquerading enables network address translation (NAT) functionality. 
This allows your organization to share Internet access by translating all 
network traffic between your single publicly accessible IP address and 
your many privately accessible IP addresses through this server. 
Choosing only packet forwarding with no masquerading only allows 
traffic between one network interface and the other without providing 
NAT. Choosing no packet forwarding does not allow any traffic between 
one network interface and the other.  

• IP Address. Enter the IP address of the secondary interface. If you are 
using only one network interface connection to the server appliance, use 
the primary interface and leave the secondary interface empty. Enter a 
series of four numbers between 0 and 255 separated by periods. For 
example, 209.43.21.5 is a valid entry. 

• IP Network Mask. Enter the network mask of the secondary interface. 
If you are using only one network interface connection to the server, use 
the primary interface and leave the secondary interface empty. Enter a 
series of four numbers between 0 and 255 separated by periods. For 
example, 255.255.255.0 is a valid entry. 

• MAC Address. The Media Access Control (MAC) address is the 
hardware address of the network interface card. This hardware address is 
a unique identifier and cannot be changed.  

4. Click Save. 

✍ Note: This option does not appear in the Setup Wizard.

✍
Note: If you configured the Qube 3 manually and want to use the 
Qube 3 as the Internet connection for your network, you must 
configure the clients on your network with the IP address of the 
Qube 3 as their default gateway. 
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Configuration for cable modem or DSL 

Complete this section only if you intend to connect the Qube 3 to the Internet 
with a cable modem or digital subscriber line (DSL) modem. You need a cable 
modem or DSL modem, and an account with an ISP. 

Ensure that you connect the modem to the secondary network interface on the 
back of the Qube 3; see Figure 6 on page 12. 

To configure the Qube 3 Internet settings for a cable modem or for DSL service: 

1. Select Administration > System > Internet to open the Internet Settings 
table. 

2. If it does not open in the desired mode, click on the Change Internet 
Connection pull-down menu and select Cable Modem or DSL. The Cable 
Modem or DSL table appears; see Figure 84. 

Figure 84.   Internet Settings for Cable Modem or DSL table  
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3. This table presents three options: 

• Obtain Automatically Using DHCP. There are two fields: Client Host 
Name and Client Identifier. Depending on your ISP, they provide you 
with the information to enter in these fields or the fields do not need to 
be filled in. 

• Obtain Automatically Using PPPoE. If your ISP uses PPPoE and 
provides you with a user name and password, enter them here. Enter your 
password twice for confirmation. 

• Specify Manually. Choose this option if your ISP has provided a static 
IP address.

Enter the IP address, subnet mask and gateway. Obtain this information 
from your ISP or network administrator.  

4. Click Save. 

Configuration for an analog modem or ISDN 

The Qube 3 is equipped with a high-speed serial port for connecting an external 
analog modem or an Integrated Services Digital Network (ISDN) terminal 
adapter. If you have (or can obtain) a standard point-to-point protocol (PPP) 
dial-up account with an Internet service provider (ISP) and a phone line, your 
Qube 3 can provide Internet access for your network — no router is required. 
Using the external modem or terminal adapter and the serial port, the Qube 3 can 
also act as a router.

Ensure that you connect the modem to the serial port on the back of the Qube 3; 
see Figure 6 on page 12. 

✍ Note: If you configured the Qube 3 manually and want to use the 
Qube 3 as the Internet connection for your network, you must 
configure the clients on your network with the IP address of the 
Qube 3 as their default gateway. 
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To configure the Qube 3 Internet settings for an analog modem or for ISDN:

1. Select Administration > System > Internet to open the Internet Settings 
table.

2. If it does not open in the desired mode, click on the Change Internet 
Connection pull-down menu and select Analog Modem or ISDN. The 
Analog Modem or ISDN table appears; see Figure 85. 

Figure 85.   Internet Settings for Analog Modem or ISDN table  

3. Configure the following settings:

• Connection Status. Connection status indicates whether the modem is 
currently connected to your ISP. 

• Connection Mode. From the pull-down menu, select the Connection 
Mode: Always On, Always Off or On Demand only. On Demand means 
the Qube 3 establishes a connection to the Internet only when prompted 
to by the system (for example, when checking email) 
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• Connection Period. You can select certain hours of the day during 
which the modem cannot connect to the Internet. By default, the modem 
is allowed to dial out at any time of the day. 

In the scrolling window Connect Times, click on a particular hour or 
hours, and then click the green arrow to move that time period into the 
scrolling window Do Not Connect. 

The hours are displayed according to a 24-hour clock. For example, the 
period “00:00 - 00:59” represents 12:00 a.m. to 12:59 a.m.; the period 
“16:00 - 16.59” represents 4:00 p.m. to 4:59 p.m. See Figure 85. 

• Phone Number. Enter the dial-up telephone number of your ISP. 

• Dial-Up Account User Name. Enter the user name of the dial-up 
account used to log in to your ISP. 

• Dial-Up Account Password. Enter the password of the dial-up account 
used to log in to your ISP. 

• Modem Initialization String. If your modem requires a specific 
initialization string, enter the string. Otherwise, leave the default value of 
ATZ. Refer to the user manual for your modem if you are having 
difficulty establishing a connection using the default string. 

• Local IP Address. Enter the local IP address at this end of the modem 
connection only if your ISP has assigned a static IP address. 

• Modem Speed (Baud). Select the speed of the serial line connection to 
the modem. The default value is 115 200.

• Enable Pulse Dialing. A telephone uses either pulse dialing or tone 
dialing. If your telephone uses pulse dialing, click the check box to 
enable the Pulse Dialing feature. Enabling this feature causes the system 
to use pulse dialing when connecting. By default, pulse dialing is OFF. 

• IP Masquerading. IP masquerading enables network address translation 
functionality that allows your organization to share Internet access by 
translating all network traffic between your one publicly accessible IP 
address and your many privately accessible IP addresses through this 
Qube 3 server.  

4. Click Save. 

✍
Note: If you configured the Qube 3 manually and want to use the 
Qube 3 as the Internet connection for your network, you must 
configure the clients on your network with the IP address of the 
Qube 3 as their default gateway. 
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Power (Reboot) 
Rebooting the Qube 3 sometimes cures problems with certain services. The 
Active Monitor software recommends when a reboot is necessary.

For security reasons, you cannot power down the Qube 3 through the Desktop 
Server; you have to power down the server through the LCD console. This screen 
lists the steps for powering down. 

For more information, see “Power down” on page 203.  

To reboot the Qube 3 through the Server Desktop: 

1. Select Administration > System > Power. The Reboot screen appears with 
the following button.  

2. Click the Reboot Now button. A confirmation dialog appears.

3. Click OK. A dialog appears stating that the server is rebooting and that the 
reboot can take as long as a few minutes. 

4. Once the Qube 3 reboots, the browser should refresh to the Login screen. If 
it does not, point your browser to the IP address of the Qube 3.

You can also reboot the Qube 3 through the LCD console; refer to “Reboot” on 
page 202. 

!
Caution: Turning off the power switch before the Qube 3 tells you 
to do so can result in lost or corrupted data. 
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Time 
To specify the time, date, and time zone settings for the Qube 3: 

1. Select Administration > System > Time. The Time Settings table opens; 
see Figure 86. 

2. Use the pull-down menus to set the time, date, and time zone. 

3. You may optionally enter the host name or IP address of a Network Time 
Protocol (NTP) server if you want the Qube 3 to automatically synchronize 
its internal clock every night. 

You can find a list of publicly available NTP servers at:
http://www.eecis.udel.edu/~mills/ntp/servers.html. 

4. Click Save. 

Figure 86.   Time Settings table  
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Information 
To view information about your Qube 3, select Administration > System > 
Information The System Information table appears; see Figure 87. You can see 
the following information: 

• the product name 

• the serial number of the product 

• the serial number of the hardware 

• the MAC address for the primary network interface 

• the MAC address for the secondary network interface 

• the size of the hard disk drive in the server 

• the amount of memory in the server 

• trademark information from Cobalt Networks 

In addition to viewing information about your Qube 3, you can click the 
following buttons. 

• Click Register Now to register your Qube 3 online. 

• Click Cobalt Networks, Inc. Web Site to go to the Cobalt Web site. 

• Click Credits and Acknowledgements to view credits about some of the 
software installed on the Qube 3. 

Figure 87.   System Information table  
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Maintenance 
The Maintenance menu provides access to utilities for backing up and restoring 
the Qube 3 system. 

Backup 
You can perform both scheduled backups and manual backups on the Qube 3. 

Creating a backup 

To create a backup of the data on the Qube 3: 

1. Select Administration > Maintenance > Backup. The Scheduled Backup 
List table appears. 

2. Click Add. The Add Scheduled Backup table appears; see Figure 88. 

3. Complete the fields in the table. 

• Backup Name. This is a unique name assigned to a backup job which 
can be used to identify backup sets at a later time. The backup name must 
be a unique name. 

• Files to Backup. This pull-down menu allows you to specify whether 
this job is a full backup or an incremental backup. 

You can choose to back up All Files (a full backup) or All files modified 
in the last 31 days, 14 days, 7 days, 2 days or 1 day (incremental 
backups). 

• Method of Backup. This field allows you to specify the backup method 
to use (SMB, NFS or FTP) and the necessary information for that 
method. For more details on each of these methods, see “Backup file 
locations” on page 177. 

When a backup runs, it creates a new directory in the location specified 
in these fields. The directory name is the time at which the backup was 
started and has the form: Year Month Day Hour Minute Second. For 
example, the directory name “20000921174533” indicates that the 
backup was run at 17:45:33 on September 21, 2000. 

• Backup Interval. This field allows you to specify how often a backup 
job runs once it is scheduled. You can schedule a backup to run 
immediately, once a day, once a week or once a month. 

• Once a day means each day soon after midnight. 

• Once a week means every Sunday morning after midnight (Saturday 
night going into Sunday morning). 

• Once a month means after midnight on the first of every month. 
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• Click Cancel to discard any changes you have made.

• Click Save to schedule the backup as specified. The Scheduled Backup 
List table refreshes with the new job displayed; see Figure 89. 

If you selected Backup Immediately, the backup job begins and 
proceeds in the background. Administering the Qube 3 while a backup 
is running is not recommended.  

Figure 88.   Add Scheduled Backup table  

Figure 89.   Scheduled Backup table  

✍ Note: Do not interrupt or cancel the backup job. If the backup job 
fails, delete the partial backup file from your computer. If you try to 
restore a partial backup file, you can corrupt the data on your 
Qube 3. 
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Viewing details of a scheduled backup 

To view the details for a scheduled backup job: 

1. Select Administration > Maintenance > Backup. The Scheduled Backup 
List table appears. 

2. Click the green magnifying glass icon next to the backup that you want to 
view. The Scheduled Backup Details table appears, showing the details 
about the backup job. 

3. Click Back to return to the Scheduled Backup List table. 

4. Click Remove to permanently delete this backup job. A confirmation dialog 
verifies the deletion. 

Click OK. 

Deleting a scheduled backup 

To delete a scheduled backup job: 

1. Select Administration > Maintenance > Backup. The Scheduled Backup 
List table appears. 

2. Click the red trash can icon next to the backup that you want to delete. A 
confirmation dialog verifies the deletion. 

3. Click OK. 

Backup file locations 
FTP server 

For a backup by FTP Server: 

• specify a location (fileserver and directory), user name and password 

• a location is in the form server.name.com/dir1/dir2  

✍ Note: For FTP backups, portions of the data set must be stored on 
the Qube 3’s hard disk while being transferred. There must be at 
least 1 GB of disk space free on the Qube 3 to perform an 
FTP backup. 
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NFS server 

For a backup by NFS Server: 

• specify a location only 

• a location is in the form server:/dir1/dir2 

• a password is not required 

SMB server 

For a backup by SMB Server (Windows File Sharing): 

• specify a location (fileserver and directory), user name and password 

• a location is in the form \\server\share\dir1\dir2 

All scheduled backups 

For All Scheduled backups, ensure that the target location is available and has 
enough disk space to hold the backup archive. Failure to do this may result in 
zero-length or truncated archives. 

Restore 
There are two ways to restore a data set to the Qube 3: use the backup history or 
restore the data set manually. 

When a backup runs, it creates a new directory in the location specified in the 
Method of Backup section of the Add Scheduled Backup table; see “Creating a 
backup” on page 175. The directory name is the time at which the backup was 
started and has the form: Year Month Day Hour Minute Second. For example, the 
directory name “20000921174533” indicates that the backup was run at 17:45:33 
on September 21, 2000. 

Restoring with the backup history 

If your system failed and you have cleansed your system with the Cobalt 
OS Restore CD, your backup history is not available. To retrieve your history file, 
you must transfer the most recent history file of one of your data sets to the 
Qube 3. This is a separate file within a data set and it always includes the backup 
data set with which it was associated. The directory names created by the 
backups can be used to determine the most recent backup. 

To retrieve a history file, create the directory /home/users/admin/.cbackup/ 
and load the history file in the new directory. This file must be named history. You 
can use any method to transfer the file there. 
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If you have not cleansed your system with the Cobalt OS Restore CD or you have 
restored your history file, the history of all executed backups is available in the 
Backup File List table in the Maintenance > Restore screen. 

To restore the data set with the backup history:

1. Select Administration > Maintenance > Restore. The Backup File List 
table appears; see Figure 90.  

Figure 90.   Backup File List table  

2. Click the file restore icon (a tape with a green arrow) for the history file that 
you want to restore to the Qube 3. The Restore a Backup table appears with 
information about the history file; see Figure 91. 

Figure 91.   Restore a Backup table  

✍ Note: For an unsuccessful backup or for a backup that is still 
running, the restore icon for that file is greyed out in the Action 
column. 
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3. From the Location to Restore Files pull-down menu, choose a location for 
the restored files: restore to “restore” fileshare or replace existing files. 

Replacing existing files overwrites files on your hard drive if there is a file 
with the same name and location as the file being restored. This option 
should only be used for disaster recovery, as it irreversibly alters the state of 
the system.  

The restore fileshare is the directory 

/home/groups/restore/<BACKUPTIME>

where <BACKUPTIME> is the directory name used for the backup (for 
example, 20000903040200). You cannot select or change this location, and 
there must be enough space in the /home/ partition for the files.

This allows you to manually copy only those files you wish to restore. 

4. Click Cancel to discard any changes you have made or click Restore to 
restore the files. The restore job begins and proceeds in the background. 
Administering the Qube 3 while a restore is underway is not recommended. 

✍ Note: If you select the “Replace existing files” option to restore a 
full backup, the Qube 3 automatically reboots when the restore is 
complete. 

!
Caution: Interrupting a restore can corrupt your data. If the restore 
process is interrupted, the Qube 3 Administrator can try to restore 
again. 
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Viewing details of a history item 

To view the details for a history item: 

1. Select Administration > Maintenance > Restore. The Backup File List 
table appears. 

2. Click the green magnifying glass icon next to the history file that you want to 
view. The History Item Details table appears, showing the details about the 
history file. 

3. Click Back to return to the Backup File List table. 

4. Click Restore to restore the files. The Restore a Backup table appears with 
information about the history file. To continue, go to Step 3 in the procedure 
under “Restoring with the backup history” on page 178. 

5. Click Remove to permanently delete this history file. A confirmation dialog 
verifies the deletion. 

Click OK. 

Deleting a history item 

To delete a history item:  

1. Select Administration > Maintenance > Restore. The Backup File List 
table appears. 

2. Click the red trash can icon next to the history file that you want to delete. A 
confirmation dialog verifies the deletion. 

3. Click OK. 

✍ Note: This operation deletes just the history item; it does not delete 
the backup itself
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Restoring a backup file manually 

To restore a data set manually, you must make the desired data set available to the 
Qube 3 either by mounting the network share or by transferring the files to the 
Qube 3. 

1. Mount the network share or transfer the data set to the Qube 3. 

2. Select Administration > Maintenance > Restore. The Backup File List 
table appears. 

3. Click Restore Manually above the table. The Manual Restore From 
Directory table appears; see Figure 92. 

Figure 92.   Manual Restore From Directory table  

4. In the Directory field, enter the name of the directory on the Qube 3 to which 
the data has been transferred or mounted, and within which the data set is 
found (for example, /home/restoredata/20000903040200 ). 

5. From the Location to Restore Files pull-down menu, choose a location for 
the restored files: restore to “restore” fileshare or replace existing files. 

Replacing existing files overwrites files on your hard drive if there is a file 
with the same name and location as the file being restored. This option 
should only be used for disaster recovery, as it irreversibly alters the state of 
the system.  

The restore fileshare is the directory 

/home/groups/restore/<BACKUPTIME>

where <BACKUPTIME> is the directory name used for the backup (for 
example, 20000903040200). You cannot select or change this location, and 
there must be enough space in the /home/ partition for the files.

This allows you to manually copy only those files you wish to restore. 

✍
Note: If you select the “Replace existing files” option to restore a 
full backup, the Qube 3 automatically reboots when the restore is 
complete. 
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6. Click Cancel to discard any changes you have made or click Restore to 
restore the files. The restore job begins and proceeds in the background. 
Administering the Qube 3 while a restore is underway is not recommended.  

Disaster recovery 

To restore your Qube 3 to a known state after a disaster: 

1. Restore the Qube 3 to a factory-fresh state with the Cobalt OS Restore Disc 
that was shipped with the Qube 3. 

2. Locate the most recent history file from your backups (use the directory 
name to identify the most recent backup). 

3. Transfer this history file to the directory /home/users/admin/.cbackup/ 

4. Select Administration > Maintenance > Restore. The Backup File List 
table appears. 

5. Restore your backup using from the history item. See “Restoring with the 
backup history” on page 178.  

!
Caution: Interrupting a restore can corrupt your data. If the restore 
process is interrupted, the Qube 3 Administrator can try to restore 
again. 

� Important: When restoring your backups, start with the oldest 
dataset you want to restore. Restore each dataset from oldest to 
most recent until you reach either the most recent backup or the 
backup you wish to restore. 
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Usage information 

Web usage 
To view statistics about your Qube 3 Web server: 

1. Select Administration > Usage Information > Web. The Web Server 
Statistics table appears; see Figure 93. 

2. Use the pull-down menu to select one of the following views: 

• Summary 

• Most active requestors 

• Most requested pages 

• Most frequent referring pages 

• Hourly requests 

• Daily requests 

3. You can click the Reset Statistics button to reset all of the web usage 
statistics and begin gathering statistics again. 

Figure 93.   Web Server Statistics table  
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Disk usage 
To view information about the current state of your Qube 3 disk: 

1. Select Administration > Usage Information > Disk. The Disk Usage table 
appears; see Figure 94. 

2. Use the pull-down menu to select one of the following views: 

• Summary 

• Users 

• Groups 

3. You can click the Check Usage Now button to update disk usage 
information immediately. This may take as long as several minutes, and 
proceeds in the background. 

Figure 94.   Disk Usage table  

Network usage 
To view statistics about your Qube 3 network interfaces, select Administration > 
Usage Information > Network. The Network Usage table appears; see 
Figure 95. 

Figure 95.   Network Usage table  
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Active Monitor 
The Qube 3 uses Active Monitor software, a Cobalt Networks utility that runs on 
a Qube 3 and updates key system and service status every 15 minutes. This 
section describes how to use the Active Monitor. 

Active Monitor icon 
The Active Monitor icon in the top right corner of the Server Desktop 
allows you to view status information. The icon turns red if any of the 
components monitored by Active Monitor have severe problems. 

Active Monitor Status 

To view the Active Monitor Status of a system component or a service: 

1. Select Administration > Active Monitor > Status. The Active Monitor 
Status table appears; see Figure 96. 

2. You can click the Check Status Now button to begin updating system and 
service status information immediately. This may take as long as several 
minutes and proceeds in the background. 
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Figure 96.   Active Monitor Status table  
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3. To view detailed status information for a particular system component or 
service, click the colored circle to the left of the item’s name in the table or 
click the magnifying glass in the Action column that corresponds to the 
name of the item. See Figure 97. 

The status of each of the above items is indicated by a green, yellow, red or 
grey circle beside each item. The colors have the following significance: 

• Grey. No information is available or monitoring is not enabled 

• Green. Normal functioning 

• Yellow. A problem exists that should be investigated by the Qube 3 
Administrator (for example, low disk space) 

• Red. A severe problem exists that needs immediate attention by the 
Qube 3 Administrator 

Figure 97.   Sample details table  
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Active Monitor Settings 
To configure the Active Monitor settings: 

1. Select Administration > Active Monitor > Settings. The Active Monitor 
Settings table appears; see Figure 98. 

2. Configure the settings in the Active Monitor Settings table. 

• Enable Monitoring. This check box enables or disables Active Monitor. 
Enabling this feature allows the system components to be regularly 
checked for proper operation. 

• Alert Notification Emails. Specify the email address(es) to which the 
Active Monitor sends email alert messages. The default is the user 
admin. 

If you add more than one email address, enter each one on a separate 
line or separate the addresses with spaces. 

• Monitored Components. Select the specific system components to be 
regularly checked by Active Monitor. The left column shows the system 
components which are currently being monitored. The right column 
shows the system components which could possibly be monitored. To 
add a system component to be monitored, move the system component 
from the right column to the left column.

Figure 98.   Active Monitor Settings table  
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BlueLinQ 
When you log into the Qube 3 as admin, the BlueLinQ tab appears in the top 
menu bar of the Qube 3 interface. When you select BlueLinQ, the left menu bar 
presents commands that allow you to update the Qube 3 software, add new 
software and view the installed software. This section describes how to use these 
commands. 

Software Notification icon 
The Software Notification icon in the top right corner of the Server 
Desktop allows you to check for new or updated software packages and 
to install them if any are found. The icon changes color when new or 
updated software packages are available. 

New Software 
1. Select BlueLinQ > New Software. The Available New Software table 

appears; see Figure 99. 

2. Click Check Availability Now to check availability of new software.

3. Click Install Manually if you already know the location of new software 
that you want to install on the Qube 3.

Figure 99.   Available New Software List table  
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Updates 
1. Select BlueLinQ > Updates. The Available Software Updates List table 

appears; see Figure 100. 

Figure 100.   Available Software Updates List table  

2. Click Check Availability Now to update the list of available software or 
click Install Manually if you already know the location of new software that 
you want to install on the Qube 3.

3. Click the green magnifying glass icon to see more detailed information 
about the software package. The Install Software table appears; see 
Figure 101. 

Figure 101.   Install Software table  
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4. Click Install Manually. The Install Manually table appears; see Figure 102.

Figure 102.   Install Manually table  

5. Enter a URL in the URL field or enter a path and filename to load the 
software package from you computer. You can also click Browse to locate 
the software package. 

6. Click Prepare. The system verifies that the file you are loading is in the 
correct .pkg format. The system then begins to load the software. 

Installed Software 
The following packages are installed on the Qube 3 at the factory; you cannot 
un-install these packages. 

• Cobalt OS 

• Cobalt Web Cache (Qube 3 Business Edition and Professional Edition only) 

• Cobalt DiskMirror (Qube 3 Professional Edition only) 

To view the software installed on the Qube 3:

1. Select BlueLinQ > Installed Software. The Installed Software List table 
appears; see Figure 103. 

2. Click the icon in the Uninstall column if you wish to uninstall a particular 
software. A confirmation dial appears to proceed with the uninstall 
procedure. 

3. Click OK.

Figure 103.   Installed Software List table  
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Settings 
To view or modify the settings for the BlueLinQ feature:

1. Select BlueLinQ > Settings. The BlueLinQ Settings table appears; see 
Figure 104 for the Basic settings and Figure 105 for the Advanced settings. 
The active tab shows up as a light grey. 

Figure 104.   BlueLinQ Settings - Basic table  

Figure 105.   BlueLinQ Settings - Advanced table  
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2. Configure the fields in the BlueLinQ Settings tables. 

• Query Schedule. Specify how frequently the BlueLinQ server is 
checked for new or updated software packages. 

• Software Notification Light. Specify the type of new software that 
activates the Software Notification Light, and if applicable, the type of 
new software that appears in notification email messages. 

• Notification Emails. The email addresses for sending notification of 
new software or errors in software update queries. The notification email 
is sent in accordance with the Software Notification Light settings. 

• BlueLinQ Server(s). Enter the HTTP address(es) of the location(s) to 
query for software updates. You can enter more than one address in this 
scrolling window; enter each HTTP address on a separate line. 

The default location of the Cobalt Networks Update Server is 
http://updates.cobalt.com/packages/.  

• HTTP proxy:port. (optional) Enter the proxy server and port for HTTP 
queries if a proxy server is needed to reach outside your firewall. 

Example: proxy.mycompany.com:8080. 

• FTP proxy:port. (optional) Enter the proxy server and port for FTP 
queries if a proxy server is needed to reach outside your firewall. 

Example: proxy.mycompany.com:8080. 

• Packages must be authenticated. If enabled, BlueLinQ installs only 
packages that have passed an authentication check. 

3. Click Save. 

✍ Note: To receive updates from Cobalt Networks, you must retain 
the URL http://updates.cobalt.com/packages/ in this field. 
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 Appendix A

 

Using the LCD Console

 

During startup, the LCD screen on the back of the Cobalt Qube 3 displays status 
information about the boot process itself.

When setting up the Qube 3, you use the LCD console to enter network 
configuration information for the Qube 3.

Once the Qube 3 is running, the LCD console serves several purposes. Through 
the LCD console, you can:

• change network configuration information, which is useful if you change the 
location of the Qube 3 

• reboot, which restarts the entire Qube 3 

• power down in a way that allows the Qube 3 to close all open files, and 
minimizes startup time the next time the Qube 3 is powered on 

• reset the network, which resets all IP addresses, netmasks and other network 
settings to that of a new, unconfigured system 

• reset the filters and the static routes, which disables the IP firewall filters and 
deletes the static route settings. 

• exit from the LCD commands without making any changes  

You access each of these functions by holding down the  (select) button on 

the LCD console for approximately two seconds. This action causes the LCD 

screen to enter its function mode. Press the  button until the function you 

want appears on the LCD screen. To cancel the LCD function mode, select the 

 

EXIT

 

 function when it appears on the screen. Press the  (enter) button and 

select 

 

YES

 

. 

!

 

Caution:

 

 It is important to follow the proper power-down 
procedure before turning off the Qube 3. Refer to “Power down” on 
page 203.
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Set up network

 

To reset the IP address or change the network configuration of the primary 
network interface: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button. 

3. Enter the IP address of the primary network interface using the arrow 
buttons. The left and right arrow buttons move the cursor position to the left 
or right. The up and down arrow buttons increase or decrease the digit at the 
cursor position. 

4. Press the  button. 

5. Enter the Netmask of the primary network interface using the arrow buttons.

6. Press the  button. 

7. Enter the Gateway using the arrow buttons. 

8. Press the  button. 

9. Use the arrow buttons to toggle the cursor between [S]ave or [C]ancel. 

10.  Press the  button. 

If you select Save, the Qube 3 saves the new information. The LCD screen 
returns to the normal display with the fully qualified domain name on the top line 
and the IP address on the bottom line. 

If you select Cancel, the LCD screen just returns to the normal display. 

You can also change the network configuration of the 

 

Qube 3

 

 through the Web 
browser: 

1. On the Server Desktop, select 

 

Administration > System > TCP/IP

 

. The 
TCP/IP Settings table appears. 

2. Edit the network settings in the tables. 

3. Click 

 

Save

 

. 
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Advanced network 

 

There are six further options under the Advanced Network option:

• review settings

• set up primary

• DHCP primary

• set up secondary

• DHCP secondary

• Exit

 

Review settings

 

To review the network settings on the Qube 3:

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

ADVANCED NETWORK 

 

appears in the LCD 
screen: 

 

SELECT: 
ADVANCED NETWORK 

 

3. Press the  button. The LCD screen displays: 

 

SELECT: 
REVIEW SETTINGS 

 

4. Press the  button. The LCD scrolls through the settings for the default 

gateway, the primary IP address, the primary subnet mask, the secondary 

IP address and the secondary subnet mask; each setting is displayed for 

about five seconds. If an interface is disabled, the bottom line of the 

LCD screen displays 

 

Not Configured

 

. 

5. The LCD screen then returns to the normal display with the fully qualified 
domain name on the top line and the IP address on the bottom line. 
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Set up primary 

 

To set up the primary network interface on the Qube 3:

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

ADVANCED NETWORK 

 

appears in the LCD 
screen: 

 

SELECT: 
ADVANCED NETWORK 

 

3. Press the  button. The LCD screen displays: 

 

SELECT: 
REVIEW SETTINGS 

 

4. Press the  button until 

 

SETUP PRIMARY

 

 appears in the LCD screen:

 

SELECT: 
SETUP PRIMARY 

 

5. Press the  button. 

6. Enter the IP address of the primary network interface using the arrow 
buttons. The left and right arrow buttons move the cursor position to the left 
or right. The up and down arrow buttons increase or decrease the digit at the 
cursor position. 

7. Press the  button. 

8. Enter the Netmask of the primary network interface using the arrow buttons.

9. Press the  button. 

10. Enter the Gateway using the arrow buttons. 

11. Press the  button. 

12. Use the arrow buttons to toggle the cursor between [S]ave or [C]ancel. 

13.  Press the  button. 

If you select Save, the Qube 3 saves the new information. The LCD screen 
returns to the normal display with the fully qualified domain name on the top line 
and the IP address on the bottom line. 

If you select Cancel, the LCD screen just returns to the normal display. 
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DHCP primary

 

To configure the primary network interface on the Qube 3 using a DHCP server:

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

ADVANCED NETWORK 

 

appears in the LCD 
screen: 

 

SELECT: 
ADVANCED NETWORK 

 

3. Press the  button. The LCD screen displays: 

 

SELECT: 
REVIEW SETTINGS 

 

4. Press the  button until 

 

DHCP PRIMARY 

 

appears in the LCD screen:

 

SELECT: 
DHCP PRIMARY 

 

5. Press the  button. The Qube 3 looks for a DHCP server on the network. 

If it finds a DHCP server, the Qube 3 resets its primary network interface 

with information received from the DHCP server. The Qube 3 also resets its 

default gateway, host name and domain name, if it receives this information. 

If the Qube 3 obtains IP addresses for DNS servers, those IP addresses are 

appended to the list of DNS servers. 

The LCD screen displays the fully qualified domain name on the top line and 
the IP address on the bottom line. 
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Set up secondary 

 

To configure the secondary network interface on the Qube 3:

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

ADVANCED NETWORK 

 

appears in the LCD 
screen: 

 

SELECT: 
ADVANCED NETWORK 

 

3. Press the  button. The LCD screen displays: 

 

SELECT: 
REVIEW SETTINGS 

 

4. Press the  button until 

 

SETUP SECONDARY

 

 appears in the LCD 

screen:

 

SELECT: 
SETUP SECONDARY 

 

5. Press the  button. 

6. Enter the IP address of the secondary network interface using the arrow 
buttons. The left and right arrow buttons move the cursor position to the left 
or right. The up and down arrow buttons increase or decrease the digit at the 
cursor position. 

7. Press the  button. 

8. Enter the Netmask of the secondary network interface using the arrow 
buttons.

9. Press the  button. 

10. Enter the Gateway using the arrow buttons. 

11. Press the  button. 

12. Use the arrow buttons to toggle the cursor between [S]ave or [C]ancel. 

13.  Press the  button. 

If you select Save, the Qube 3 saves the new information. The LCD screen 
returns to the normal display with the fully qualified domain name on the top line 
and the IP address on the bottom line. 

If you select Cancel, the LCD screen just returns to the normal display. 
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DHCP secondary 

 

To configure the secondary network interface on the Qube 3 using a DHCP 
server:

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

ADVANCED NETWORK 

 

appears in the LCD 
screen: 

 

SELECT: 
ADVANCED NETWORK 

 

3. Press the  button. The LCD screen displays: 

 

SELECT: 
REVIEW SETTINGS 

 

4. Press the  button until 

 

DHCP SECONDARY 

 

appears in the LCD 

screen:

 

SELECT: 
DHCP SECONDARY 

 

5. Press the  button. The Qube 3 looks for a DHCP server on the network. 

If it finds a DHCP server, the Qube 3 resets its secondary network interface 

with information received from the DHCP server. The Qube 3 also resets its 

default gateway if it receives this information. If the Qube 3 obtains 

IP addresses for DNS servers, those IP addresses are appended to the list of 

DNS servers. 

The LCD screen displays the fully qualified domain name on the top line and 
the IP address on the bottom line. 

 

Exit 

 

To exit the Advanced Network option, choose EXIT. The LCD screen returns to 
the normal display with the fully qualified domain name on the top line and the 
IP address on the bottom line.
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Reboot 

 

To reboot the Qube 3 through the LCD console: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

REBOOT 

 

appears in the LCD screen: 

 

SELECT: 
REBOOT 

 

3. Press the  button. 

4. Use the arrow buttons to toggle the cursor between [Y] and [N]. Select [Y] to 
reboot the system. 

5. Press the  button. 

You can also reboot the Qube 3 through the Web browser: 

1. On the Server Desktop, select 

 

Administration > System > Power

 

. 

A screen appears with a 

 

Reboot Now 

 

button. 

2. Click 

 

Reboot Now

 

. 

A warning dialog appears, asking whether you want to reboot the server 
appliance. 

3. Click 

 

OK

 

. 

The screen states that the server appliance is now rebooting and that it should 
be available again in a few minutes. 
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Power down  

 

To power down the Qube 3: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

POWER DOWN

 

 appears in the LCD screen: 

 

SELECT: 
POWER DOWN 

 

3. Press the  button. 

4. Use the arrow buttons to toggle the cursor between [Y] and [N]. Select [Y] to 
power down the system. The LCD screen displays: 

 

PLEASE SWITCH 
POWER OFF NOW 

 

5. Press the 

 

On/Off

 

 button on the back panel to turn off the Qube 3.  

!

 

Caution:

 

 To prevent the potential loss of data, it is important to 
follow the proper power-down procedure before turning off the 
Qube 3. 

 

✍

 

Note: 

 

If you have the Qube 3 Professional Edition (with RAID), 
wait a few seconds before pressing the 

 

On/Off

 

 button. 
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Reset network 

 

This function is useful if you are moving the Qube 3 to a new network. 

The Reset Network function resets the IP address and netmask for the primary 
and secondary network interfaces to that of a new, unconfigured Qube 3. It also 
resets the gateway, host name, domain name and DNS information to that of a 
new, unconfigured Qube 3. 

Resetting the network also disables the IP firewall filtering rules, if you had 
enabled that option. 

To reset the network state of the Qube 3: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

RESET NETWORK

 

 appears in the LCD 
screen: 

 

SELECT: 
RESET NETWORK 

 

3. Press the  button. 

4. Use the arrow buttons to toggle the cursor between [Y] and [N]. Select [Y] to 
reset the network configuration. 

5. Press the  button. 

6. After resetting, the Qube 3 powers down and the LCD screen displays: 

 

 PLEASE SWITCH 
 POWER OFF NOW 

 

7. Press the 

 

On/Off

 

 button the back panel to turn off the Qube 3.  

 

✍

 

Note: 

 

If you have the Qube 3 Professional Edition (with RAID), 
wait a few seconds before pressing the 

 

On/Off

 

 button. 
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To re-enable the filtering rules through the Server Desktop: 

1. On the Server Desktop, select 

 

Administration > Network Services > Basic 
Firewall

 

. 

The Firewall Settings table appears. 

2. Click the check box Enable Firewall. 

3. Click 

 

Save

 

. 

 

Reset filters and static routes 

 

The Reset Filters function turns off the IP firewall filtering rules and provides the 
option to reset static routes, meaning that the static routes are deleted.

To reset the filtering rules: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

 

SELECT: 
SETUP NETWORK 

 

2. Press the  button until 

 

RESET FILTERS

 

 appears in the LCD screen: 

 

SELECT: 
RESET FILTERS 

 

3. Press the  button. 

4. Use the arrow buttons to toggle the cursor between [Y] and [N]. Select [Y] to 
disable the IP filters. 

5. Press the  button. 

6. If you select Yes, the LCD screen displays: 

 

RESETTING 
FILTERS 

7. Regardless of a Yes or No selection in Step 6, the LCD screen now displays: 

RESET ROUTES? 
[Y]ES / [N]O

8. Use the arrow buttons to toggle the cursor between [Y] and [N]. Select [Y] to 
reset the static routes. 

9. If you select Yes, The LCD screen displays: 

RESETTING 
ROUTES 
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The LCD screen returns to the normal display with the fully qualified domain 
name on the top line and the IP address on the bottom line. 

To re-enable the filtering rules through the Server Desktop: 

1. On the Server Desktop, select Administration > Network Services > Basic 
Firewall. 

The Firewall Settings table appears. 

2. Click the check box to Enable Firewall. 

3. Click Save. 

To re-enter the static routes through the Server Desktop, see “TCP/IP” on 
page 162. 

Language 
You can change the language through the LCD console. The selected language 
applies to the Server Desktop UI, the messages and commands on the LCD 
screen and the alert messages that Active Monitor sends to the Qube 3 
Administrator. 

To change the language selection: 

1. On the LCD console, hold down the  button for approximately two 
seconds. The LCD screen displays: 

SELECT: 
SETUP NETWORK 

2. Press the  button until LANGUAGE appears in the LCD screen: 

SELECT: 
LANGUAGE 

3. Press the  button. 

4. Press the  button to scroll through the language choices. The choices are 

displayed in their native language (for example, English or Español). 

5. When your language choice is displayed, press the  button. The 

software processes the new language choice. After a few seconds the 

LCD screen returns to the normal display with the fully qualified domain 

name on the top line and the IP address on the bottom line. 

If you proceed through the LCD commands again, they are displayed in the new 
language. 
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 Appendix B

Product Specifications

Hardware 
The Qube 3 has the following hardware components. See http://www.cobalt.com 
for the most up-to-date information on the hardware specifications. 

The Qube 3 has the following hardware components. 

• x86-compatible superscalar processor 

• 512 KB of L2 cache 

• 32-MB to 128-MB PC-100 SDRAM DIMMs (2 slots); can support up to 
512 MB 
(3.3 v, 168-pin, non-parity, unbuffered) 

• PC-100 SDRAM 

• One or two internal Ultra ATA/33 hard drives 

• Two 10/100 BaseT ethernet network interfaces 

• Single serial console interface 

• External ultra-wide SCSI interface (mini-micro 68-pin) 40 Mb/s 

• LCD console for easy set-up and administration 

• Peripheral Component Interconnect (PCI) slot for expansion 

• Universal serial bus (USB) port 



Appendix B: Product Specifications

208 Cobalt Qube 3 User Manual

Software 
The Qube 3 has the following software features.

Features 
• Linux 2.2 multitasking operating system 

• Apache 1.3 Web server, HTTP /1.1 compliant 

• Common gateway interface (CGI) support 

• PHP 4 support 

• Perl scripting 

• FrontPage98 and FrontPage 2000 Server Extensions 3.0 

• Email protocol support: Simple Mail Transfer Protocol (SMTP), Internet 
Message Access Protocol (IMAP4), Post Office Protocol (POP3) 

• File transfer protocol (FTP) support 

• 128-bit Secure Sockets Layer (SSL)

• Telnet access

• Server Message Block (SMB)/CIFS 

• AppleShare (and AppleShare over IP) 

• Domain Name System (DNS) server: Berkeley Internet Name 
Domain (BIND) 

System management 
• Browser-based Setup Wizard 

• Browser-based Qube 3 administration 

• Online Active Assist real-time help 

• Active Monitor maintenance agents 

• Advanced management using telnet 

• Browser-based software upgrade 
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Physical data 
The Qube 3 has the following physical characteristics. 

• Dimensions: 7.5 in. x 7.63 in. x 7.75 in. (19.1 cm x 19.2 cm x 19.7 cm) 

• Weight with one hard drive: 8.3 lbs. (3.9 kg) 

• Weight with two hard drives: 9.5 lbs. (4.3 kg) 

• Power requirements: Input rating 100-240 V, 50/60 Hz 

• Power consumption: 45 watts 

• Power requirement for the PCI slot: 

• 5V @ 1A 

• +12V @ 0.5A 

• -12V @ 0.1A 

• Operating environment: 

39oF to 95oF (5oC to 35oC) 

10% to 80% humidity (non-condensing) 

• Non-operating environment: 

14oF to 122oF (-10oC to 50oC) 

5% to 93% humidity (non-condensing) 

• Light-emitting diodes (LEDs): Network Activity, Link 

Regulatory approvals
• CISPR 22B 

• VCCI-B 

• UL 

• C-UL 

• TUV 

• CE 

• Austel 

• BSMI 
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 Appendix C

Upgrading the Qube 3

Components 
Your Qube 3 comes equipped with two Dual Inline Memory Module (DIMM) 
slots, one of which is used for existing memory, one available PCI slot, and one 
or two hard disk drives. You can add components to enhance your Qube 3. 

The Qube 3 automatically detects a new DIMM, PCI card or hard disk drive. 

Before you purchase a component to add to the Qube 3, ensure that the 
component is of the right type and that it will fit in the allocated space. 

• The DIMM modules must be PC100 SDRAM. They must be less than 
2.5 inches (63.5 mm) tall and less than 0.4 inches (10.1 mm) thick. 

• PCI cards must be less than 5.5 inches (139 mm) long. 

• Hard disks must be IDE or ATA and should support UDMA/33. They must 
be 3.5 inches (88.9 mm) wide, and 1 inch (25.4 mm) tall. This is commonly 
known as a 3.5 inch, half-height drive. 

Memory 
The Qube 3 comes equipped with two Dual Inline Memory Module (DIMM) 
slots, one of which is used for existing memory. The Qube 3 supports a 
maximum of 512 MB of memory, using two DIMM modules of 256 MB each. 

You can have mismatched sizes of memory modules (for example, you can install 
a 128 MB module and a 64 MB module together). If you have mismatched 
module sizes, install the larger module in slot 1. See Figure 108. 
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Hard disk drives 
The Qube 3 and Qube 3 Business Edition ship with one hard drive disk; the 
Qube 3 Professional Edition ships with two hard disk drives and offers RAID-1 
disk mirroring. 

If you have a Qube 3 Professional Edition and one of the hard drive fails, the 
failed hard disk drive (Drive A or Drive B) is indicated in the Server Desktop 
under the Active Monitor function. If you are replacing a failed hard disk drive, 
remove the guide rails from the old hard disk drive and attach them to the new 
drive. See Figure 106, #4. 

Precautions  

Keep in mind the following items while upgrading your Qube 3:

• DIMMs, PCI cards and hard disk drives are sensitive electronic devices. Be 
careful not to damage them or other components during the upgrade. 

• Do not force the insertion of an electronic device. If it does not insert 
properly with moderate effort, check all alignments and insertion directions. 
Forcing a component can damage both the device and the Qube 3, and can 
void your warranty. 

!
Caution: The Qube 3, like all electronics, is extremely sensitive to 
electro-static shocks. Ground yourself by touching a piece of metal, 
such as the Qube 3 chassis, before handling any electronics.
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Figure 106.   Exploded view of the Qube 3  
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Figure 107.   Qube 3 I/O board  
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Figure 108.   Qube 3 CPU riser board  
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Opening the Qube 3  

To open the Qube 3: 

1. Power down the Qube 3. See “Power down” on page 203. 

2. Unplug the Qube 3. 

3. Remove the power cord from the rear panel of the Qube 3. The power 
connector is located at the bottom right corner. See Figure 1 on page 2. To 
remove the cord, simply hold the Qube 3 in place and gently pull the 
connector out. 

4. Remove the single screw at the top of the back panel to release the blue 
plastic top cover from the system chassis. 

5. Carefully remove the blue plastic top cover. See Figure 106, #1.

6. Carefully lift the sheet metal top cover by lifting the tabs at the back of the 
Qube 3. See Figure 106, #2. 

Adding components to the Qube 3 
To add memory or a PCI card, you must remove the CPU riser board. If your 
Qube 3 has an external SCSI connector, you must detach the external SCSI 
connector itself from the back panel of the Qube 3 and remove it along with the 
CPU riser board. 

Due to the size of the heat sink on the CPU riser board, you must remove the hard 
disk drive(s) and the drive bay in order to detach the external SCSI connector. 

To add a component to your Qube 3: 

1. If you are just replacing a failed hard disk drive, go to “Replacing a hard disk 
drive” below. 

If you are changing the DIMMs or adding a PCI card, continue with the next 
step.

2. Remove the hard disk drive(s). Detach the power cable(s) and IDE ribbon 
cable(s) from the drive(s). 

!
Caution: You MUST power down the Qube 3 before opening the 
unit.
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3. Unscrew the thumbscrews that hold the drive(s) in place. See Figure 106, #3. 

4. Slide the drive(s) out of the drive bay. 

5. Remove the four screws that attach the drive bay to the system chassis. 

6. Carefully lift the drive bay out of the chassis.

7. If your Qube 3 has an external SCSI connector, detach the external SCSI 
port from the back panel and slide it through the opening. 

Removing the CPU riser board 

1. Locate the screw on the back panel which holds the bracket for the CPU riser 
board in place, and remove this screw. See Figure 106, #5. 

2. Carefully remove the bracket for the CPU riser board, and then the CPU riser 
board from its slot in the I/O board. Lift the board out of the system chassis 
(along with the SCSI connector if necessary). 

Adding DIMM 

1. Once the CPU riser board is removed, insert the new DIMM module on the 
board.  

To insert the DIMM: 

• Push the locking arms on both sides of the DIMM slot to the down 
(unlocked) position.

• Align the guide marks on the DIMM with the guides on the DIMM slot. 
The DIMM fits into the slot one way only. If the marks do not align, try 
turning the DIMM over. 

• Gently push the DIMM into the slot. The locking arms should close 
around the DIMM and you should hear a “click”.

2. Visually verify that you have properly inserted the DIMM and locked it fully.

� Important: If your Qube 3 has two hard disk drives, make careful 
note of which drive is installed in Slot A and which is installed in 
Slot B of the drive bay. 

✍ Note: If the new DIMM module is larger than the existing DIMM 
module, remove the existing module and install it in slot 2. You 
must install the larger module in slot 1; see Figure 108. 
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Adding a PCI expansion card 

1. With the CPU riser board out of the system chassis, remove the screw 
holding the PCI slot cover in place and remove the PCI slot cover. See 
Figure 1 on page 2. 

2. Install the PCI card into the PCI slot on the I/O board. Match the PCI card 
alignment marks with the alignment guides on the slot. See Figure 107. 

3. Fasten the PCI card in place with the screw that was holding the PCI slot 
cover. Save the PCI slot cover, in case you want to remove the PCI card later. 

Replacing the CPU riser board 

1. Carefully slide the CPU riser board back into the system chassis (along with 
the SCSI port if necessary).  

2. If you had detached the external SCSI port from the back panel of the 
Qube 3, slide it into its slot and re-attach it to the back panel. 

3. Carefully slide the drive bay back into the system chassis. 

4. Re-attach the drive bay to the chassis with the four screws. 

✍ Note: Insert the CPU riser board with the DIMM modules next to 
the front of the Qube 3; the expansion slot is oriented toward the 
inside of the unit. Forcing the CPU riser board into the wrong slot 
will damage the system and void your warranty.
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Replacing a hard disk drive 

1. If you are simply replacing the drive(s) that you removed in order to remove 
the CPU riser board, re-install the drive(s) in the drive bay. 

If you are re-installing a single drive, it goes in slot A.

If you are re-installing two drives, install the correct drive in slot B first, and 
then the other drive in slot A second.  

2. If you are replacing a failed hard drive, locate the bay in which the failed 
drive is installed. The slots in the drive bay are stamped with “A” and “B”.  

3. Remove the power and IDE ribbon cables from the failed drive. 

4. Remove the thumb screws holding the drive in place and slide the drive out. 
See Figure 106, #3. 

5. Remove the guide rails from the sides of the failed drive and attach them to 
the replacement drive. Position the rails so that the drive will be inserted 
properly and can receive the power cable and IDE ribbon cable. See 
Figure 106, #4. 

6. Once the rails are attached to the replacement drive, slide the drive into the 
selected slot on the drive bay. 

7. Tighten the thumb screws to secure the drive in place. 

8. Attach the power cable and the IDE ribbon cable to the drive.  

9. Close the Qube 3; see “Closing the Qube 3” on page 220. 

� Important: If your Qube 3 has two hard disk drives, ensure that you 
re-install the drives in the same slot from which you removed them. 

If you re-install the drives in the wrong slots, your Qube 3 will not 
function.

✍ Note: If you have a Qube 3 Professional Edition with RAID-1 disk 
mirroring and one of the hard drive fails, the failed hard disk drive 
is indicated in the Server Desktop under the Active Monitor 
function. 

✍ Note: The power cable has a “D” shape and fits in one direction 
only. The IDE ribbon cable has an alignment notch. 
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Closing the Qube 3 
To close the Qube 3, perform the steps for opening the Qube 3 in reverse order. 

1. Carefully replace the sheet metal top cover, locating the tabs to the back of 
the Qube 3. See Figure 106, #2. 

2. Carefully replace the blue plastic top cover, snapping all sides into place. See 
Figure 106, #1. 

3. Re-attach the single screw which holds the blue plastic top cover to the 
system chassis. 

4. Insert the power cord into the power supply connector at the bottom right of 
the rear panel. 

5. Plug in the Qube 3. 

6. Power up the Qube 3. 
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 Appendix D

Advanced Information

High-speed serial port
For information on using the high-speed serial port, see “Configuration for an 
analog modem or ISDN” on page 169. 

High-speed serial port as a serial 
console port 
You can use the high-speed serial port to establish a terminal connection to the 
Qube 3. 

To use the high-speed serial port as a serial console port, you must change the 
current state of the console function to on or off. To do this, you must reboot the 
Qube 3 while holding in the recessed Reset Password button on the back panel of 
the Qube 3. See Figure 1 on page 2. 

To reboot the Qube 3 from the LCD panel, see “Reboot” on page 202. 

When you reboot the Qube 3 in this manner, the LCD screen displays either: 

CONSOLE ON 

or 

CONSOLE OFF 
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The first message indicates that the serial port can function as a serial console 
port. If this message is displayed, allow the bootup process to continue. 

The second message indicates that the serial port cannot function as a serial 
console port. If this message is displayed, allow the bootup process to continue. 
Repeat this bootup process so that the LCD screen displays the first message. 

Terminal settings 
The terminal can be either an ASCII terminal or a personal computer running 
terminal software. Set the communications parameters on the console terminal to 
the following values: 

• 115 200 Baud 

• 8 data bits 

• no parity 

• 1 stop bit 
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Enabling the serial console port 

To use the high-speed serial port as a serial console port:   

1. Hold in the recessed Reset Password button on the back panel and reboot 
the Qube 3. See Figure 1 on page 2. 

2. The LCD screen displays either: 

CONSOLE ON 

or 

CONSOLE OFF 

3. If the LCD screen displays: 

CONSOLE ON 

allow the bootup process to continue. 

If the LCD screen displays: 

CONSOLE OFF 

allow the bootup process to continue. Return to Step 1 and repeat. 

4. Attach a null modem cable to the serial port of the Qube 3 and the terminal 
(or the personal computer running the terminal software). 

5. Set the communications parameters on the terminal or in the terminal 
software (see “Terminal settings” on page 222).

✍ Note: This procedure can require rebooting the Qube 3 twice. as 
there is no way to tell if the console function is enabled or disabled 
through the Server Desktop or LCD screen.

✍ Note: While the Qube 3 is in the CONSOLE ON mode, you cannot use 
an analog modem or an Integrated Services Digital Network 
(ISDN) terminal adapter. 
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Directory structure 
The disk on the Qube 3 is partitioned into four segments. Most of the available 
disk space is on the partition mounted from /home/. It is recommended to do 
most of your work under this partition. By default, quotas are turned on in this 
partition and are used extensively by the system software. 

Default home page for the Qube 3 
Once the Qube 3 has been configured, you can access the default home page 
from the following directory: The document root for the Web server is the 
Qube 3’s main site: 

/home/groups/home/web/ 

This page appears when a user accesses the URL http://<hostname>/. The default 
home page file is “index.html.xx”, where “xx” represents a particular language. 
For example, “index.html.de” is the default home page for German and 
“index.html.fr” is the default home page for French. 

If you want to replace the default home page, name your home-page file 
“index.hmtl”, save it in this directory and delete all of the “index.html.xx” files. 

Users can continue to access the Cobalt Qube 3 Server Desktop by accessing the 
URL http://<hostname>/login/. 

Web content in the directory 

/home/groups/home/web/ 

is associated with the URL http://<IP address>/. 

For example, a file saved as: 

/home/groups/home/web/testdir/test.html 

is accessed through the URL http://<IP address>/testdir/test.html.  

✍
Note: <IP address> refers to the IP address or the fully qualified 
domain name of the Qube 3. 
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User home page 
When Qube 3 Administrator creates a user through the Server Desktop, the home 
directory for that user is created in: 

/home/users/username/ 

User must upload files for their Web pages to: 

/home/users/username/web/ 

Users can view their Web pages at: 

http://<IP address>/users/<username>/ or http://<IP address>/~ <username>/ 

CGI scripts 
The Qube 3 supports common gateway interface (CGI) scripts, such as those 
written in Perl or C, as well as Unix shell scripts. 

CGI scripts allow you to develop highly interactive, powerful Web-based 
applications by building server-side CGI scripts that generate Web pages in 
response to specific user inputs. These applications range from simple scheduling 
and conferencing applications to sophisticated electronic commerce solutions. 

You can develop CGI scripts on your desktop machine and then transfer them to 
the Qube 3 through an FTP-based application that allows permission bits to be 
set to “Executable”. 

CGI scripts must use .pl or .cgi filename extensions in order to beexecuted by the 
Web server. 

Use FTP to upload .cgi and .pl files; use ASCII mode to upload CGI files. Once 
the file is on the Qube 3, use your FTP program to make the script executable. 
You can also use the telnet command: 

chmod 775 <filename>.cgi 

The path to Perl is 

/usr/bin/perl/ 

To set the access rights specifying who is allowed to run CGI scripts, see “Web 
settings” on page 141. 

PHP 
The Qube 3 is pre-configured with support for embedded PHP scripts. You can 
save PHP files in any directory on your site, provided that the file ends with 
a .php extension. 
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 Appendix E

 

Domain Name System

 

The Internet uses a distributed naming system called the Domain Name 
System (DNS). DNS allows us to refer to computers by host names as well as by 
Internet Protocol (IP) addresses. 

IP addresses are hard to remember and are inconvenient to use. DNS allows us to 
use host names and domain names which can resolved to IP addresses. DNS 
servers translate host names and domain names (for example, www.cobalt.com) 
to an associated IP address (for example, 192.168.10.10) and vice-versa.

For example, Cobalt Networks has registered the domain name “cobalt.com” for 
use by our servers “mail.cobalt.com”, “www.cobalt.com” and others. The host 
names “mail” and “www” represent different servers registered in the same 
domain. 

A domain name is a computer name suffix shared by a group of computers in the 
same organization. A domain name should be associated with an IP address 
through a Forward Lookup record. Domain names are organized in a hierarchy; 
this hierarchy includes your company or server name, and a country code (for 
example, .uk or .ca) or a top-level domain (for example, .com or .edu). 

A Web site on the server is created with one IP address, one host name and one 
domain name that together establish the identity of that Web site on the Internet. 

Each domain name requires a primary domain authority on one DNS server. A 
secondary DNS server acts as a backup to the primary. DNS information is 
configurable only on the primary server, and not on the backup server. 

There are two tabs in the DNS Settings table. The active tab is a light shade of 
gray; the inactive tab is a dark shade of gray. 

•

 

Basic

 

. You can enable the DNS server feature. 

•

 

Advanced

 

. You can configure the Start of Authority (SOA) default values 
and the server settings. 



 

Appendix E: Domain Name System

228 Cobalt Qube 3 User Manual

 

There are also two buttons on the DNS screen, available in both the Basic and 
Advanced sections. These are explained later in this appendix. 

•

 

Edit Primary Services

 

. You can configure the primary DNS server. 

•

 

Edit Secondary Services

 

. You can configure the secondary DNS server. 

 

Basic DNS 

 

Enabling the DNS server feature 

 

To enable the DNS server on the Qube 3: 

1. On the Server Desktop, select 

 

Administration > Network Services > DNS

 

. 
The Basic Settings section of the Domain Name System (DNS) Settings 
table appears; see Figure 109. 

2. Click to enable the check box for Enable server (if it is not already enabled). 

3. Click 

 

Save

 

. 

 

Figure 109.   

 

Basic DNS table  
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Advanced DNS  

 

Configuring SOA default values 

 

You can fine tune the primary domain and network authority settings—known as 
the Start of Authority (SOA) settings—independently of each other. 

To modify the SOA settings, see “Modifying the SOA record” on page 234. 

To configure the default values for the SOA settings: 

1. On the Server Desktop, select 

 

Administration > Network Services > DNS

 

. 
The Advanced Settings section of DNS Settings table appears; see 
Figure 110. 

2. Click 

 

Advanced 

 

on the right side of the table. The fields for the SOA default 
values and server settings appear. You can configure the values for the 
following parameters. The parameters are explained in the following 
paragraphs. 

• Domain administrator email address (optional) 

• Refresh interval (in seconds) 

• Retry interval (in seconds) 

• Expire interval (in seconds) 

• Time-to-live (TTL) interval (in seconds)

3. Click 

 

Save

 

. 

 

�

 

Important:

 

 Always click 

 

Save

 

 after modifying the settings in the 
Advanced section. If you do not, the changes will not take effect. 
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Figure 110.   

 

Advanced DNS table  

 

Domain administrator email address 

 

The email address defaults to the user name “admin” of the Qube 3. This email 
address is publicly available and is the administrative contact for the domain or 
network served. 

 

Refresh interval 

 

You can configure the refresh interval between updates from a secondary DNS 
server. 

• If DNS record changes occur infrequently, increase the default value.

• If DNS record changes occur often, decrease the default value. 

Tune the refresh interval to avoid wasting bandwidth and to ensure the content on 
the secondary server is accurate at all times.



 

Advanced DNS

Cobalt Qube 3 User Manual 231

 

Retry interval 

 

Due to a connection or service failure, a secondary DNS server may be unable to 
refresh data from the primary server. The secondary DNS server attempts to 
refresh data after the interval specified for trying again.

 

Expire interval

 

A secondary DNS server may be unable to refresh data from the primary server 
for a prolonged period of time. After the interval specified for expiry, the 
secondary server stops serving name requests.

 

Time-to-live period (TTL)

 

A caching DNS server other than the primary and secondary DNS servers for this 
domain or network can cache record lookups for the TTL period. During the TTL 
period, a caching DNS server does not poll the primary or secondary DNS 
servers for repeated lookups of the same record.

 

Configuring the server settings 

 

You can also configure the server settings and the zone transfer access control for 
the Qube 3 DNS server. 

 

Forwarding server 

 

If the Qube 3 is being used on a private network or in conjunction with a 
restrictive firewall, you can specify a forwarding DNS server(s) by IP address. 

 

Zone transfer 

 

A zone transfer allows another DNS server to download the complete list of hosts 
maintained by your DNS server. Zone transfers are used by secondary domain 
name servers to synchronize their records with primary domain name servers. 

By default, zone transfers are unrestricted. However, you can restrict zone 
transfers if you want. By entering a domain name in the Zone Transfer Access 
window, you automatically restrict zone transfers. Only the domain names listed 
in this window are now able to perform zone transfers. 

 

Zone file format 

 

You can select a zone file format for delegating subnets on non-octet boundaries 
which is compatible with your local reverse-delegation method. RFC2317 is the 
international standard format. Consult your ISP to determine the type of subnet 
DNS delegation they are using. 
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To configure the DNS server settings: 

1. On the Server Desktop, select 

 

Administration > Network Services > DNS

 

. 
The Domain Name System (DNS) Settings table appears. 

2. Click 

 

Advanced 

 

on the right side of the table. The fields for the SOA default 
values and server settings appear. You can specify the forwarding DNS 
servers, the Zone Transfer Access by Domain and the Zone File Format.

3. In the Forwarding Server window, enter the IP address(es) of the forwarding 
DNS server(s).

4. In the Zone Transfer Access by Domain window, enter the host names or 
domain names that are allowed to download all records maintained by this 
domain name server. 

5. Select a zone file format. RFC2317 is the international standard format. 

6. Click 

 

Save

 

. 

 

Primary services 

 

A primary DNS server maintains a list of name records and their associated 
IP addresses. This list is made available to other DNS servers if your domain is 
registered with your country-specific domain-naming organization. Your Internet 
service provider (ISP) can help you register your Internet server. 

Figure 111 shows some sample entries in the Primary Service List table. 

 

Figure 111.   

 

Sample entries in the Primary Service List table  
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To set up the primary DNS server on the Qube 3, you need to configure the 
following DNS records.

• Forward Address (A) record 

• Reverse Address (PTR) record 

• Mail Server (MX) server 

If there are no records defined, there are no authority selection options available. 

If there are records defined, two pull-down menus are available at the top of the 
screen: “Select Domain...” and “Select Network...” There are also two buttons 
available at the top of the Primary Service List table: Modify SOA and Remove 
Records. 

 

Selecting a domain 

 

To display the DNS records for a particular domain, click on the Select Domain... 
pull-down menu and select the domain.

The screen refreshes and the Primary Service List table displays the DNS records 
for that domain. The domain name shows up in the title bar.

 

Selecting a network 

 

To display the DNS records for a particular network, click on the Select 
Network... pull-down menu and select the network.

The screen refreshes and the Primary Service List table displays the DNS records 
for that network. The network shows up in the title bar.
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Modifying the SOA record 

 

You can modify the SOA record for a particular domain or network. For an 
explanation of the fields you can modify, see “Configuring SOA default values” 
on page 229. 

1. From the pull-down menu, select the domain or network for which you want 
to modify the SOA record. The defined records for that domain or network 
appear in the Primary Service List table. 

2. Click 

 

Modify SOA

 

 at the top of the Primary Service List table. The Modify 
SOA Record table appears. The first field displays either the domain name or 
the network authority that you selected.

• Primary Name Server 

Enter the fully qualified domain name of the primary name server for 
the selected domain or network authority. 

• Secondary Name Server

Enter the fully qualified domain name(s) of the secondary name 
server(s) for the selected domain or network authority. If you want to 
specify more than one secondary name server, separate the names with a 
space.

• DNS Administrator email address 

• Refresh interval 

• Retry interval 

• Expire interval 

• Time-to-live interval 

3. Click 

 

Save

 

. The screen refreshes and the Primary Service List table appears.
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Deleting all DNS records 

 

You can delete all the DNS records for a particular network or domain name from 
the Primary Service List table. 

1. From the pull-down menu, select the domain or network for which you want 
to modify the SOA record. The defined records for that domain or network 
appear in the Primary Service List table.

2. Click 

 

Remove Records 

 

at the top of the Primary Service List table. A 
confirmation dialog appears, asking you if you want to remove all of the 
DNS records displayed in the table. 

3. Click 

 

OK

 

. The screen refreshes and the Primary Service List table is now 
empty. 

 

Modifying a specific DNS record 

 

To modify an individual entry in the Primary Service List table, click on the 
green pencil icon next to that entry. The Modify Record table appears. 

Click 

 

Save

 

. The screen refreshes. 

 

Deleting a specific DNS record 

 

To delete an individual entry from the Primary Service List table, click on the red 
trash can icon next to that entry. A confirmation window appears, asking if you 
want to delete the record.

Click 

 

OK

 

. The screen refreshes and the Primary Service List table no longer 
display that record.
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Configuring a Forward Address (A) record

 

A Forward Address (A) record translates a fully qualified domain name into an 
IP address. 

To configure a Forward Address (A) record for your Qube 3:

1. Select 

 

Administration > Network Services > DNS

 

.

The DNS Settings table appears. 

2. Click 

 

Edit Primary Services 

 

above the table. The Primary Service List table 
appears. 

3. Select Forward Address (A) Record from the 

 

Add Record...

 

 pull-down 
menu. The Add New Forward Address (A) Record table appears. 

4. Enter the host name (optional) and domain name you want to serve (for 
example, www and mydomain.com). 

5. Enter the IP address (for example, 192.168.10.10) that is used by the host 
and domain names entered in the first two fields. 

6. Click 

 

Save

 

. The Primary Service List table reappears with the new entry. 

7. To add another record, select a record type from the pull-down menu again. 

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears. 
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Configuring a Reverse Address (PTR) record

 

A Reverse Address (PTR) record translates an IP address into a fully qualified 
domain name.

To configure a Reverse Address (PTR) record for your Qube 3:

1. Select 

 

Administration > Network Services > DNS

 

.

The DNS Settings table appears. 

2. Click 

 

Edit Primary Services 

 

above the table. The Primary Service List table 
appears. 

3. Select Reverse Address (PTR) Record from the 

 

Add Record...

 

 pull-down 
menu. The Add New Reverse Address (PTR) Record table appears. 

4. Enter the IP address (for example, 192.168.10.10) that you want to resolve to 
a fully qualified domain name. 

5. The Subnet Mask field holds the default value of 255.255.255.0. You can edit 
this value if necessary. 

6. Enter the host name (optional) and domain name (for example, www and 
mydomain.com) to which the IP address in the first field resolves. 

7. If you have not already created a Forward Address (A) record to resolve this 
host name and domain name to the specified IP address, you can 
automatically generate one. 

To do so, click the check box Generate Forward Address (A) Record. 

8. Click 

 

Save

 

. The Primary Service List table reappears with the new Reverse 
Address (PTR) entry. If you generated a Forward Address (A) record, that 
entry appears as well. 

9. To add another record, select a record type from the pull-down menu again.

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears.
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Configuring a Mail Server (MX) record

 

To receive mail for your domain name (for example, mydomain.com), you need 
to create a Mail Server (MX) Record. 

A Mail Server (MX) record identifies the mail server responsible for delivering 
email messages to a specified host name (optional) and domain name. An 
MX record is similar to an A record but resolves to a fully qualified domain name 
rather than an IP address.  

To configure a Mail Server (MX) record for your Qube 3:

1. Select 

 

Administration > Network Services > DNS

 

.

The DNS Settings table appears. 

2. Click 

 

Edit Primary Services 

 

above the table. The Primary Service List table 
appears. 

3. Select Mail Server (MX) Record from the 

 

Add Record...

 

 pull-down menu. 
The Add New Mail Server (MX) Record table appears. 

4. Enter the host name (optional) and domain name (for example, www and 
mydomain.com) to be served by the mail server. 

5. Enter the fully qualified domain name of the mail server (for example, 
mail.mydomain.com) that serves the domain name entered in the second 
field. 

6. Under the Delivery Priority pull-down menu, select the priority for mail 
delivery to the mail server: very high, high, low, very low. 

The value of the delivery priority specifies the order in which a series of mail 
servers is contacted for mail delivery. The Delivery Priority setting is useful 
only if more than one MX record is configured for a domain or network. 

7. Click 

 

Save

 

. The Primary Service List table reappears with the new entry. 

8. To add another record, select a record type from the pull-down menu again.

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears.

 

�

 

Important: 

 

It is critical that the MX record resolve to a fully 
qualified domain name that has a corresponding A record.
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Configuring an Alias (CNAME) record

 

An Alias (CNAME) record provides the translation from one fully qualified 
domain name to another fully qualified domain name. 

The source domain name is known as the alias and the target domain name is 
known as the canonical name or real name. The target host name does not need to 
be a member of the local domain. For example, you can create an Alias 
(CNAME) record of “news.domain.com” resolving to “uucp.isp.net”.  

To configure an Alias (CNAME) record for your Qube 3:

1. Select 

 

Administration > Network Services > DNS

 

. 

The DNS Settings table appears. 

2. Click 

 

Edit Primary Services 

 

above the table. The Primary Service List table 
appears. 

3. Select Alias (CNAME) Record from the 

 

Add Record...

 

 pull-down menu. 
The Add New Alias (CNAME) Record table appears. 

4. Enter the host name (optional) and domain name (for example, news and 
mydomain.com) of the alias. 

5. Enter the host name (optional) and domain name (for example, news and 
otherplace.com) of the real domain name. 

6. Click 

 

Save

 

. The Primary Service List table reappears with the new entry. 

7. To add another record, select a record type from the pull-down menu again. 

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears. 

 

�

 

Important: 

 

Do not use an Alias (CNAME) record to cause a 
domain name to resolve to a host name.

For example, do not create an Alias (CNAME) record for 
mydomain.com that resolves to www.mydomain.com. Instead, add 
a Forward Address (A) record for mydomain.com to the IP address 
used by www.mydomain.com. 

See “Configuring a Forward Address (A) record” on page 236.
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Secondary services 

 

The Qube 3 Administrator can configure a secondary DNS server to provide 
redundant DNS service to your computers. If the primary DNS server is 
unavailable, the secondary DNS server takes over. 

Figure 112 shows some sample entries in the Secondary Service List table. 

 

Figure 112.   

 

Sample entries in the Secondary Service List table  

 

Secondary service for a domain 

 

To add a secondary name-server authority for a domain: 

1. Select 

 

Administration > Network Services > DNS

 

. The DNS Settings table 
appears. 

2. Click 

 

Edit Secondary Services 

 

above the table. The Secondary Service List 
table appears. 

3. Select Domain Secondary Service from the 

 

Add Secondary Service...

 

 
pull-down menu. The Add Secondary Service table appears; see Figure 113. 

4. In the first field, enter the domain name for which DNS information is served 
by the IP address in the second field. 

5. In the second field, enter the IP address of the primary DNS server for the 
domain name specified in the first field. 

6. Click 

 

Save

 

. The Secondary Service List table reappears with the new entry. 

7. To add another secondary service, select a service from the pull-down menu 
again. 

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears. 
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Figure 113.   

 

Add Secondary Domain table  

 

Secondary service for a network 

 

To add a secondary name-server authority for a network: 

1. Select 

 

Administration > Network Services > DNS

 

.

The DNS Settings table appears. 

2. Click 

 

Edit Secondary Services 

 

above the table. The Secondary Service List 
table appears. 

3. Select Network Secondary Service from the 

 

Add Secondary Service...

 

 
pull-down menu. The Add Secondary Service table appears; see Figure 114. 

4. In the first field, enter the IP address of a member on the network (for 
example, 192.168.1.1) whose DNS information is served by the IP address 
in the third field. 

5. In the second field, enter the subnet mask corresponding to the IP address for 
the specified network authority. 

6. In the third field, enter the IP address of the primary DNS server for the 
specified network.

7. Click 

 

Save

 

. The Secondary Service List table reappears with the new entry. 

8. To add another secondary service, select a service from the pull-down menu 
again. 

To apply the changes to the DNS settings, click 

 

Apply Changes Now

 

. The 
DNS Settings table appears. 

 

Figure 114.   

 

Add Secondary Network table  
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Sample setup of DNS service 

 

This sample setup of DNS service on your Qube 3 assumes that you have already 
registered your domain with InterNIC or another registration service. If you have 
not, refer to the FAQ section on Cobalt’s web site 
(http://www.cobalt.com/support/ under the Knowledge Base link) for 
information on registering your domain name. 

For more information on registering a Web site, visit the Internet Corporation for 
Assigned Names and Numbers (ICANN) at http://www.icann.org. 

In the following examples, we will configure a sample domain called 
“mydomain.com” for Web service and email service using a sample IP address 
192.168.10.10.  

The recommended minimum configuration for Web and email service requires 
the following records. These records allow anyone on the Internet to type either 
“mydomain.com” or “www.mydomain.com” to access your Web site. 

• A Reverse Address (PTR) record for 192.168.10.10 which resolves to 
mydomain.com 

• A Forward Address (A) record for mydomain.com which resolves to 
192.168.10.10 (You can generate this record automatically from the PTR 
record.) 

• A Forward Address (A) record for www.mydomain.com which resolves to 
192.168.10.10 

• A Mail Server (MX) record for mydomain.com which resolves to 
www.mydomain.com 

� Important: Substitute your domain name and IP address where the 
sample domain name or sample IP address appears.
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Reverse Address (PTR) record 
First, create a Reverse Address (PTR) record.

1. Select Administration > Network Services > DNS. The DNS Settings table 
appears. 

2. Click Edit Primary Services above the table. The Primary Service List table 
appears. 

3. Select Reverse Address (PTR) Record from the Add Record... pull-down 
menu. The Add New Reverse Address (PTR) Record table appears; see 
Figure 115. 

• In the IP Address field, enter 192.168.10.10. 

• Leave the subnet mask as 255.255.255.0. 

• In the Host Name field, enter www. 

• In the Domain Name field, enter mydomain.com. 

4. Click the check box Generate Forward Address (A) Record to generate a 
Forward Address (A) record. 

5. Click Save. The Primary Service List table reappears with the new Reverse 
Address (PTR) and Forward Address (A) entries. 

Figure 115.   Add New Reverse Address (PTR) Record table  
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Forward Address (A) record 
Next, create a Forward Address (A) record. 

1. Select Administration > Network Services > DNS. The DNS Settings table 
appears. 

2. Click Edit Primary Services above the table. The Primary Service List table 
appears. 

3. Select Forward Address (A) Record from the Add Record... pull-down 
menu. The Add New Forward Address (A) Record table appears; see 
Figure 116. 

• Leave the Host Name field blank. 

• In the Domain Name field, enter mydomain.com. 

• In the IP Address field, enter 192.168.10.10. 

4. Click Save. The Primary Service List table reappears with the new Forward 
Address (A) entry. 

Figure 116.   Add New Forward Address (A) Record table  
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Mail Server (MX) record 
Finally, create a Mail Server (MX) record. 

1. Select Administration > Network Services > DNS. The DNS Settings table 
appears. 

2. Click Edit Primary Services above the table. The Primary Service List table 
appears. 

3. Select Mail Server (MX) Record from the Add Record... pull-down menu. 
The Add New Mail Server (MX) Record table appears; see Figure 117. 

• Leave the Host Name field blank. 

• In the Domain Name field, enter mydomain.com. 

• In the Mail Server Name field, enter www.mydomain.com. 

• Under the Delivery Priority pull-down menu, leave the priority as Very 
High.

4. Click Save. The Primary Service List table reappears with the new Mail 
Server (MX) entry. 

Figure 117.   Add New Mail Server (MX) Record table  

You are now finished with creating your DNS records. 

To edit another domain, select another domain from the Select Domain or 
Network... pull-down menu. You can select any domain that you have configured 
for the DNS server,  

� Important: Click Apply Changes Now. This activates the changes 
you have made. If you exit this screen without saving your changes, 
they will not become active. 
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To add a new domain, use the Add Record... pull-down menu again. In the 
Domain Name field of the type of record you select, replace the default domain 
name with the new domain name that you want to create. 

For further information, refer to the following: 

• In the Cobalt Knowledge Base, search on “DNS”. 

• http://www.dnswiz.com/dnsworks.htm (not affiliated with Cobalt Networks)

• http://www-europe.cisco.com/warp/public/787/indexDNS.html (not 
affiliated with Cobalt Networks) 

Brief history of the Domain Name 
System (DNS)
In the 1960s, the U.S. Department of Defense Advanced Research Projects 
Agency (ARPA, and later DARPA) began funding an experimental wide area 
computer network called the ARPAnet. The ARPAnet used a centrally 
administered file called HOSTS.TXT which held all name-to-address mapping 
for each host computer connected to the ARPAnet. Since there were only a 
handful of host computers at the start, HOSTS.TXT worked well.

When the ARPAnet moved to the Transmission Control Protocol/Internet 
Protocol (TCP/IP) suite of protocols and become known as the Internet, the 
population of the network exploded. HOSTS.TXT became plagued with 
problems, namely

• traffic and load

• name collisions

• consistency

A replacement for the HOSTS.TXT file was needed. The goal was to create a 
system that solved the problems inherent in a unified host table system. The new 
system should allow local administration of data and also make that data globally 
available.

In 1984, the architecture of a new system called Domain Name System (DNS) 
was designed and is the basis of the DNS service used today on the Internet. 

DNS is a distributed database that allows local administration of the segments on 
the overall database. Data in each segment of the database are available across the 
entire network through a client-server scheme consisting of name servers and 
resolvers.
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What is a DNS record? 
People are much more comfortable dealing with names rather than strings of 
numbers. A domain name such as “cobalt.com” is much easier to remember than 
the IP address which consists of four octets of numbers such as 63.77.128.100. 
Domain names must be registered with Root Domain Registration Service; visit 
the Internet Corporation for Assigned Names and Numbers (ICANN) at 
http://www.icann.org for a list accredited domain-name registrars. 

Computers, on the other hand, prefer numbers to names. Since computers have 
the final say when a user is looking for a company Web site, a mechanism is 
needed to convert the human-friendly domain name to the computer-friendly IP 
address. 

DNS records on a DNS server perform this function. The records translate a 
domain name to an IP address; a record equates a domain name such as 
“cobalt.com” to an IP address such as 207.91.131.30. Once the domain name has 
been converted or “resolved” to an IP address, then (and only then) can the user 
connect to your Web site. 

Without DNS and domain names, the user would be required to remember the IP 
address of every site they wanted to visit. With DNS servers and DNS records, 
customers and their software can easily remember how to get to your site. 

Who manages your DNS records? 
Your DNS records can reside on any Cobalt server that has the DNS service 
enabled. You or your administrator can easily configure a Cobalt server to act as a 
DNS server. To provide DNS service, InterNIC requires a site to maintain both a 
primary and a secondary server. Your Cobalt server can act as the primary server 
and a DNS server from your Internet service provider (ISP) can act as the 
secondary server.

How does DNS work? 
The basic method that allows a domain name to direct customers to your Web site 
is shown in Figure 118. This diagram describes a request made by a Web browser 
as the customer attempts to log on to your Web site. 
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To determine which primary name server contains your domain name: 

1. The local name server (the DNS resolver/browser machine) contacts the root 
domain name server maintained by the several Internet root server 
authorities. 

2. The root domain name server returns the IP address of the primary name 
server responsible for the requested domain name. 

3. The local name server contacts the primary name server. 

4. The primary name server holds the IP address information for the domain 
name in a database and satisfies the request from the local name server.

5. If the primary name server is unavailable, the local name server contacts the 
secondary name server that satisfies the request from the local name server. 
The local name server returns to the Web browser with the IP address for the 
requested domain name.

6. Using the IP address, the Web browser contacts the company Web server.

7. The company Web server sends the Web page to the local name server.

Figure 118.   Basic method of DNS  
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Licenses

The BSD Copyright
Copyright ©1991, 1992, 1993, 1994 The Regents of the University of California. 
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/
or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgment: This product includes software 
developed by the University of California, Berkeley and its contributors.

4. Neither the name of the University nor the names of its contributors may be 
used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.
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GNU General Public License
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION 

0. This License applies to any program or other work which contains a notice 
placed by the copyright holder saying it may be distributed under the terms of 
this General Public License. The “Program,” below, refers to any such program 
or work, and a “work based on the Program” means either the Program or any 
derivative work under copyright law: that is to say, a work containing the 
Program or a portion of it, either verbatim or with modifications and/or translated 
into another language. (Hereinafter, translation is included without limitation in 
the term “modification.”) Each licensee is addressed as “you.”

Activities other than copying, distribution and modification are not covered by 
this License; they are outside its scope. The act of running the Program is not 
restricted, and the output from the Program is covered only if its contents 
constitute a work based on the Program (independent of having been made by 
running the Program). Whether that is true depends on what the Program does. 

1. You may copy and distribute verbatim copies of the Program’s source code as 
you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; 
keep intact all the notices that refer to this License and to the absence of any 
warranty; and give any other recipients of the Program a copy of this License 
along with the Program. 

You may charge a fee for the physical act of transferring a copy, and you may at 
your option offer warranty protection in exchange for a fee. 
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2. You may modify your copy or copies of the Program or any portion of it, thus 
forming a work based on the Program, and copy and distribute such 
modifications or work under the terms of Section 1 above, provided that you also 
meet all of these conditions: 

a. You must cause the modified files to carry prominent notices stating that 
you changed the files and the date of any change. 

b. You must cause any work that you distribute or publish, that in whole or 
in part contains or is derived from the Program or any part thereof, to be 
licensed as a whole at no charge to all third parties under the terms of 
this License. 

c. If the modified program normally reads commands interactively when 
run, you must cause it, when started running for such interactive use in 
the most ordinary way, to print or display an announcement including an 
appropriate copyright notice and a notice that there is no warranty (or 
else, saying that you provide a warranty) and that users may redistribute 
the program under these conditions, and telling the user how to view a 
copy of this License. (Exception: if the Program itself is interactive but 
does not normally print such an announcement, your work based on the 
Program is not required to print an announcement.) 

These requirements apply to the modified work as a whole. If identifiable 
sections of that work are not derived from the Program, and can be reasonably 
considered independent and separate works in themselves, then this License, and 
its terms, do not apply to those sections when you distribute them as separate 
works. But when you distribute the same sections as part of a whole which is a 
work based on the Program, the distribution of the whole must be on the terms of 
this License, whose permissions for other licensees extend to the entire whole, 
and thus to each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to 
work written entirely by you; rather, the intent is to exercise the right to control 
the distribution of derivative or collective works based on the Program. 

In addition, mere aggregation of another work not based on the Program with the 
Program (or with a work based on the Program) on a volume of a storage or 
distribution medium does not bring the other work under the scope of this 
License. 
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3. You may copy and distribute the Program (or a work based on it, under 
Section 2) in object code or executable form under the terms of Sections 1 and 2 
above, provided that you also do one of the following: 

a. Accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 
and 2 above on a medium customarily used for software interchange; or, 

b. Accompany it with a written offer, valid for at least three years, to give 
any third party, for a charge no more than your cost of physically 
performing source distribution, a complete machine-readable copy of 
the corresponding source code, to be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software 
interchange; or, 

c. Accompany it with the information you received as to the offer to 
distribute corresponding source code. (This alternative is allowed only 
for noncommercial distribution and only if you received the program in 
object code or executable form with such an offer, in accord with 
Subsection b above.) 

The source code for a work means the preferred form of the work for making 
modifications to it. For an executable work, complete source code means all the 
source code for all modules it contains, plus any associated interface definition 
files, plus the scripts used to control compilation and installation of the 
executable. However, as a special exception, the source code distributed need not 
include anything that is normally distributed (in either source or binary form) 
with the major components (compiler, kernel, and so on) of the operating system 
on which the executable runs, unless that component itself accompanies the 
executable. 

If distribution of executable or object code is made by offering access to copy 
from a designated place, then offering equivalent access to copy the source code 
from the same place counts as distribution of the source code, even though third 
parties are not compelled to copy the source along with the object code. 

4. You may not copy, modify, sublicense or distribute the Program except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense or distribute the Program is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated, so 
long as such parties remain in full compliance. 
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5. You are not required to accept this License, since you have not signed it. 
However, nothing else grants you permission to modify or distribute the Program 
or its derivative works. These actions are prohibited by law if you do not accept 
this License. Therefore, by modifying or distributing the Program (or any work 
based on the Program), you indicate your acceptance of this License to do so, and 
all its terms and conditions for copying, distributing or modifying the Program or 
works based on it. 

6. Each time you redistribute the Program (or any work based on the Program), 
the recipient automatically receives a license from the original licensor to copy, 
distribute or modify the Program subject to these terms and conditions. You may 
not impose any further restrictions on the recipients’ exercise of the rights 
granted herein. You are not responsible for enforcing compliance by third parties 
to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or 
for any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of 
this License, they do not excuse you from the conditions of this License. If you 
cannot distribute so as to satisfy simultaneously your obligations under this 
License and any other pertinent obligations, then as a consequence you may not 
distribute the Program at all. For example, if a patent license would not permit 
royalty-free redistribution of the Program by all those who receive copies directly 
or indirectly through you, then the only way you could satisfy both it and this 
License would be to refrain entirely from distribution of the Program. 

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply and the section as a 
whole is intended to apply in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the 
sole purpose of protecting the integrity of the free software distribution system, 
which is implemented by public license practices. Many people have made 
generous contributions to the wide range of software distributed through that 
system in reliance on consistent application of that system; it is up to the author/
donor to decide if he or she is willing to distribute software through any other 
system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a 
consequence of the rest of this License. 
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8. If the distribution and/or use of the Program is restricted in certain countries 
either by patents or by copyrighted interfaces, the original copyright holder who 
places the Program under this License may add an explicit geographical 
distribution limitation excluding those countries, so that distribution is permitted 
only in or among countries not thus excluded. In such case, this License 
incorporates the limitation as if written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the 
General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or 
concerns. 

Each version is given a distinguishing version number. If the Program specifies a 
version number of this License which applies to it and “any later version”, you 
have the option of following the terms and conditions either of that version or of 
any later version published by the Free Software Foundation. If the Program does 
not specify a version number of this License, you may choose any version ever 
published by the Free Software Foundation. 

10. If you wish to incorporate parts of the Program into other free programs 
whose distribution conditions are different, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, 
write to the Free Software Foundation; we sometimes make exceptions for this. 
Our decision will be guided by the two goals of preserving the free status of all 
derivatives of our free software and of promoting the sharing and reuse of 
software generally. 
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NO WARRANTY 

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE 
IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED 
BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING, THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO 
THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. 
SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST 
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

12. IN NO EVENT, UNLESS REQUIRED BY APPLICABLE LAW OR 
AGREED TO IN WRITING, WILL ANY COPYRIGHT HOLDER, OR ANY 
OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE 
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO 
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE 
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF 
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
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SSL License 
Copyright (c) 1998-1999 Ralf S. Engelschall. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/
or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must 
display the following acknowledgment: 

“This product includes software developed by Ralf S. Engelschall 
<rse@engelschall.com> for use in the mod_ssl project 
(http://www.engelschall.com/sw/mod_ssl/).”

4. The name “mod_ssl” must not be used to endorse or promote products 
derived from this software without prior written permission. For written 
permission, please contact rse@engelschall.com. 

5. Products derived from this software may not be called “mod_ssl” nor may 
“mod_ssl” appear in their names without prior written permission of Ralf S. 
Engelschall.

6. Redistributions of any form whatsoever must retain the following 
acknowledgment:

“This product includes software developed by Ralf S. Engelschall 
<rse@engelschall.com> for use in the mod_ssl project 
(http://www.engelschall.com/sw/mod_ssl/).”

THIS SOFTWARE IS PROVIDED BY RALF S. ENGELSCHALL “AS IS” AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL RALF S. 
ENGELSCHALL OR HIS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE. 
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10/100 BaseTX 

An Ethernet connection over twisted-pair cables with a throughput of 
10 Mb/s or 100 Mb/s. 

10BaseT

A 10-Mb/s baseband Ethernet specification using two pairs of twisted-pair 
cabling (Category 3, 4, or 5): one pair for transmitting data and the other for 
receiving data. 10BaseT (part of the IEEE 802.3 specification) has a distance 
limit of approximately 328 feet (100 meters) per segment.

100BaseTX

A 100-Mb/s baseband Fast Ethernet specification using two pairs of either 
unshielded twisted pair (UTP) or shielded twisted pair (STP) wiring. The 
first pair of wires is used to receive data; the second pair is used to transmit. 
To guarantee proper signal timing, a 100BaseTX segment cannot exceed 328 
feet (100 meters) in length. 100BaseTX is based on the IEEE 802.3 standard.

Authentication 

The process whereby a user or information source proves they are who they 
claim to be; in other words, the process of verifying the identity of a user, 
device or other entity in a computer system, often as a prerequisite to 
allowing access to resources in a system. Authentication is any technique 
enabling the receiver to automatically identify and reject messages that have 
been altered either deliberately or by channel errors. 

See also Encryption and Secure Sockets Layer (SSL). 

AppleShare

A file-sharing protocol in Apple system software that allows sharing of files 
and network services through a file server in the Apple Macintosh 
environment.

Carrier sense 

In a local area network (LAN), an ongoing activity of a data station to detect 
whether another station is transmitting. 
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Carrier sense multiple access with collision detection (CSMA/CD)

A protocol that requires carrier sense and in which a transmitting data station 
that detects another signal while transmitting stops sending, sends a jam 
signal and then waits for a variable period of time before sending again. 
Used in ethernet LAN technology.

CGI

See Common gateway interface (CGI).

Common gateway interface (CGI)

A set of rules that describe how a Web server communicates with another 
application running on the same computer and how the application (called a 
CGI program) communicates with the Web server. Any application can be a 
CGI program if it handles input and output according to the CGI standard.

Collision 

In an ethernet network, a collision is the result of two devices attempting to 
transmit data at exactly the same time. The network detects the “collision” of 
the two transmitted packets and discards them both. Collisions are a natural 
occurrence on an ethernet network.

Ethernet technology uses carrier sense multiple access/collision detect 
(CSMA/CD) to allow devices to take turns using the signal carrier line. 
When a device wants to transmit, it checks the signal level of the line to 
determine whether another device is already using it. If the line is already in 
use, the device waits and tries again, perhaps in a few seconds. If the line is 
not in use, the device transmits.

However, two devices can transmit at the same time in which case a collision 
occurs and both devices detect it. Each device then waits a random amount 
of time and retries until successful in getting the transmission sent. 

CSMA/CD

See carrier sense multiple access with collision detection (CSMA/CD).

DHCP

See Dynamic Host Configuration Protocol (DHCP).
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Digital Subscriber Line (DSL)

A technology for bringing high-bandwidth information to homes and small 
businesses over ordinary copper telephone lines. The term xDSL refers to 
different variations of DSL, such as asymmetric DSL (ADSL), 
high-bit-rate DSL (HDSL) and rate-adaptive DSL (RADSL). If your home 
or small business is close enough to a telephone company central office that 
offers DSL service, you may be able to receive data at rates of up to 
6.1 Mb/s. More typically, individual connections provide from 512 Kb/s to 
1.544 Mb/s downstream and about 128 Kb./s upstream. A DSL line can carry 
both data and voice signals and the data part of the line is continuously 
connected. 

DNS

See Domain Name System (DNS).

Domain name 

The location of an organization or other entity on the Internet. For example, 
the address www.cobalt.com locates an Internet address for the domain 
name “cobalt.com” at a particular IP address and a particular host server 
named “www.”

Domain Name System (DNS)

The Internet service responsible for translating a human-readable host name 
such as cobalt.com into a numeric IP address (111.123.45.67) for TCP/IP 
communications. 

DSL

See Digital Subscriber Line (DSL).

Dynamic Host Configuration Protocol (DHCP)

A protocol that provides a mechanism for allocating IP addresses 
dynamically so that an address can be reused when a host no longer needs it.

Encryption 

The transformation of data into a form unreadable by anyone without a 
secret decryption key. Its purpose is to ensure privacy by keeping the 
information hidden from anyone for whom it is not intended. In the area of 
security, encryption is the ciphering of data by applying an algorithm to plain 
text to convert it into cipher text. 

See also Authentication and Secure Sockets Layer (SSL). 

ESMTP 

See Extended Simple Mail Transfer Protocol (ESMTP). 
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Ethernet 

The most widely used technology for local area networks (LANs). Standard 
ethernet runs at 10 Mb/s, 100 Mb/s or 1000 Mb/s. It balances speed, price, 
ease of installation and availability. 

ETRN 

ETRN (Extended Turn) is an extension to the Simple Mail Transfer Protocol 
(SMTP) that allows an SMTP server to send a request to another SMTP 
server to send any email messages it has. Typically, SMTP is used with two 
other protocols, Post Office Protocol 3 (POP3) or Internet Message Access 
Protocol (IMAP), to request messages from a server; SMTP by itself cannot 
request mail to be sent. 

ETRN is designed for use by anyone who is traveling and wants to access 
their email. ETRN can only be used with Internet service providers (ISPs) 
that support ETRN. 

Extended Simple Mail Transfer Protocol (ESMTP)

The Extended Simple Mail Transfer Protocol specifies extensions to the 
original SMTP protocol for sending email that supports graphics, audio and 
video files, and text in various national languages. ESMTP provides the 
capability for a client email program to inquire of a server email program 
about which capabilities it supports and then communicate accordingly. 

File sharing 

The public or private sharing of computer data or space in a network with 
various levels of access privileges. 

File Transfer Protocol (FTP) 

A standard Internet protocol and a way to exchange files between computers 
connected to the Internet. FTP is an application protocol that uses TCP/IP 
protocols. FTP is commonly used to transfer Web page files from the 
computer that was used to create the files to the computer that acts as the 
server for these files. It is also used to download programs and other files to 
your computer from other servers. 

Using FTP, you can update—delete, rename, move and copy—files at a 
server. You need to log on to an FTP server. However, publicly available files 
are easily accessed using anonymous FTP. 

FTP 

See File Transfer Protocol (FTP). 
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Gateway 

A network device that acts as an entrance to another network. A gateway can 
also be any device that passes packets from one network to another network 
across the Internet. 

HTML 

See HyperText Markup Language (HTML). 

HTTP 

See HyperText Transfer Protocol (HTTP). 

HyperText Markup Language (HTML) 

A set of “markup” symbols or tags inserted in a text file intended for display 
on a World Wide Web browser. The markup tags tell the Web browser how to 
display a Web page’s content, words, and images. HTML is a subset of 
Standardized Generalized Markup Language (SGML). 

HyperText Transfer Protocol (HTTP) 

A set of rules for exchanging files (text, graphic images, sound, video and 
other multimedia files) on the World Wide Web. 

ICANN 

See Internet Corporation for Assigned Names and Numbers (ICANN).

IEEE 802.3 

IEEE local area network (LAN) protocol that specifies an implementation of 
the physical layer and the media access control (MAC) sublayer of the data 
link layer. IEEE 802.3 uses CSMA/CD access at a variety of speeds over a 
variety of physical media. Extensions to the IEEE 802.3 standard specify 
implementations for Fast Ethernet. Physical variations of the original IEEE 
802.3 specification include 10Base2, 10Base5, 10BaseF, 10BaseT and 
10Broad36. Physical variations for Fast Ethernet include 100BaseT, 
100BaseT4 and 100BaseX. 

IMAP 

See Internet Message Access Protocol (IMAP). 
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Integrated Services Digital Network (ISDN) 

A system of digital telephone connections. This system allows data to be 
transmitted simultaneously across the world using end-to-end digital 
connectivity. 

With ISDN, voice and data are carried by bearer channels (B channels) 
occupying a bandwidth of 64 Kb/s (some switches limit B channels to a 
capacity of 56 Kb/s). A data channel (D channel) handles signaling at 
16 Kb/s or 64 Kb/s, depending on the type of service. 

There are two basic types of ISDN service: Basic Rate Interface (BRI) and 
Primary Rate Interface (PRI). BRI consists of two 64 Kb/s B channels and 
one 16 Kb/s D channel for a total of 144 Kb/s. This basic service is intended 
to meet the needs of most individual users. 

PRI is intended for users with greater capacity requirements. Typically, the 
channel structure is 23 B channels plus one 64 Kb/s D channel for a total of 
1536 Kb/s. In Europe, PRI consists of 30 B channels plus one 64 Kb/s 
D channel for a total of 1984 Kb/s. 

Internet Corporation for Assigned Names and Numbers (ICANN) 

The private (non-government) non-profit corporation that has been formed to 
assume responsibility for the IP address space allocation, protocol parameter 
assignment, domain name system (DNS) management and root server 
system management functions. These functions were previously performed 
by the Internet Assigned Numbers Authority (IANA). The U.S. government 
is essentially turning over control of the Internet to ICANN, although 
domain name registration performed by Network Solutions, Inc. (NSI) will 
continue to be under U.S. government contract for a limited time. 

Internet domain 

An Internet domain is a host naming convention used to ensure that no two 
individual hosts on the global Internet have the same host name. An Internet 
domain should not be confused with an NT Domain. 
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Internet Message Access Protocol (IMAP) 

Internet Message Access Protocol is a standard protocol for accessing email 
from your local server. IMAP is a client/server protocol in which email is 
received and held for you by your Internet server. You (or your email client) 
can view just the heading and the sender of the letter and then decide 
whether to download the mail from the server. You can also create and 
manipulate folders or mailboxes on the server, delete messages or search for 
certain parts or an entire note. IMAP requires continuous access to the server 
during the time that you are working with your mail. 

IMAP can be thought of as a remote file server. Another protocol, Post Office 
Protocol (POP), can be thought of as a store-and-forward service. 

POP and IMAP deal with receiving email from your local server; Simple 
Mail Transfer Protocol (SMTP) is a protocol for transferring email between 
points on the Internet. You send email with SMTP and a mail handler 
receives it on your recipient’s behalf. Then the mail is read using POP or 
IMAP. 

See also “Post Office Protocol 3 (POP3)” on page 267 and “Simple Mail 
Transfer Protocol (SMTP)” on page 270.

Internet Protocol (IP) 

A network-layer protocol in the TCP/IP stack offering a connectionless 
internetwork service. IP provides features for addressing, 
type-of-service specification, fragmentation and reassembly, and security. IP 
is defined in RFC 791. 

InterNIC 

The former organization responsible for registering and maintaining the 
com, edu, gov, net and org domain names on the World Wide Web. Domain 
name registration is now performed by Network Solutions, Inc. who will 
continue to be under U.S. government contract for a limited time. 

IP address 

A 32-bit address assigned to hosts using Transmission Control Protocol/
Internet Protocol (TCP/IP). An IP address belongs to one of five classes (A, 
B, C, D or E) and is written as four octets separated by periods (for example, 
192.168.10.10), also called the dotted decimal format. Each address consists 
of a network number, an optional subnetwork number and a host number. 
The network and subnetwork numbers together are used for routing, while 
the host number is used to address an individual host within the network or 
subnetwork. A subnet mask is used to extract network and subnetwork 
information from the IP address. Also called an Internet address.
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ISDN 

See Integrated Services Digital Network (ISDN). 

LAN 

See local area network (LAN). 

Leased IP address 

An IP address assigned by the Dynamic Host Configuration Protocol 
(DHCP) to an unrecognized computing device. This method involves setting 
up a leased pool of IP addresses that are allocated dynamically when new 
devices are booted and recognized on the network.

Local area network (LAN) 

A high-speed, low-error data network covering a relatively small geographic 
area (up to a few thousand meters). A LAN connects workstations, 
peripherals, terminals and other devices in a single building or other 
geographically limited area. LAN standards specify cabling and signaling at 
the physical and data link layers of the Open Systems Interconnection (OSI) 
model. Widely used LAN technologies include Ethernet, fiber distributed 
data interface (FDDI) and token ring. 

See also wide area network (WAN). 

Logical memory 

See virtual memory. 

Media access control (MAC) sublayer 

The lower of the two sublayers of the data link layer defined by the IEEE. 
The MAC sublayer handles access to shared media, such as whether token 
passing or contention is used. 

Media access control (MAC) address 

A standardized data-link-layer address that is required for every port or 
device that connects to a LAN. Other devices in the network use these 
addresses to locate specific ports in the network, and to create and update 
routing tables and data structures. MAC addresses are six bytes long and are 
controlled by the IEEE. Also known as a hardware address, a MAC-layer 
address and a physical address. 

When your computer is connected to the Internet, a correspondence table 
relates your IP address to your computer's physical (MAC) address on the 
network 
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Name server 

A program that constitutes the server half of the DNS client-server 
mechanism. A name server contains information about a segment of the 
DNS database and makes it available to a client called a resolver. A resolver 
is often just a library routine that creates queries and sends them across a 
network to a name server. 

NAT 

See Network Address Translation (NAT). 

Netmask

See subnet mask.

Network Address Translation (NAT) 

A mechanism for reducing the need for globally unique IP addresses. NAT 
allows an organization with addresses that are not globally unique to connect 
to the Internet by translating those addresses into globally routable address 
space. Also known as Network Address Translator. 

Network Time Protocol (NTP) 

A protocol built on top of the Transmission Control Protocol (TCP) that 
synchronizes the time of a local computer client or server to radio clocks and 
atomic clocks located on the Internet. This protocol is capable of 
synchronizing distributed clocks within milliseconds over long time periods. 
Some configurations include cryptographic authentication to prevent 
accidental or malicious protocol attacks. 

NTP 

See Network Time Protocol (NTP).

Packet 

The unit of data that is routed between an origin and a destination on the 
Internet or any other packet-switched network. The packet includes a header 
containing control information and (usually) user data. Packets are most 
often used to refer to network layer units of data. 

PCI 

See Peripheral Component Interface (PCI). 
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Peripheral Component Interconnect (PCI) 

Peripheral Component Interconnect (PCI) is an interconnection system 
between a microprocessor and attached devices in which expansion slots are 
spaced closely for high-speed operation. PCI is designed to be synchronized 
with the clock speed of the microprocessor, in the range of 20 MHz to 
33 Mhz. 

PCI transmits 32 bits at a time in a 124-pin connection (the extra pins are for 
power supply and grounding) and 64 bits in a 188-pin connection in an 
expanded implementation. PCI uses all active paths to transmit both address 
and data signals, sending the address on one clock cycle and data on the 
next. Burst data can be sent starting with an address on the first cycle and a 
sequence of data transmissions on a certain number of successive cycles. 

Point-to-Point Protocol (PPP) 

A protocol for communication between two computers using a serial 
interface, typically a personal computer connected by telephone line to a 
server. For example, your Internet server provider may provide you with a 
PPP connection so that the provider’s server can respond to your requests, 
pass them on to the Internet and forward your requested Internet responses 
back to you. PPP uses the Internet protocol (and is designed to handle 
others). 

PPP is a full-duplex protocol that can be used on various physical media, 
including twisted pair, fiber optic lines or satellite transmission. It uses a 
variation of High Speed Data Link Control for packet encapsulation. PPP 
can handle synchronous as well as asynchronous communication. 

Point-to-Point Protocol over Ethernet (PPPoE) 

A specification for connecting multiple computer users on an ethernet to a 
remote site through common customer-premises equipment such as a 
modem and similar devices. PPPoE can be used to allow an office or 
building full of users share a common digital subscriber line (DSL), cable 
modem or wireless connection to the Internet. PPPoE combines the 
Point-to-Point Protocol (PPP), commonly used in dial-up connections, with 
the ethernet protocol, which supports multiple users in a local area network 
(LAN). PPP information is encapsulated within an Ethernet frame. 

POP3 

See Post Office Protocol (POP3).
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Post Office Protocol 3 (POP3) 

Post Office Protocol (POP) is a standard protocol for receiving email. POP is 
a client/server protocol in which email is received and held for you by your 
Internet server. When you read your mail, all of it is immediately 
downloaded to your computer and no longer maintained on the server. POP3 
is built into the Netscape Navigator and Microsoft Internet Explorer 
browsers. 

POP can be thought of as a store-and-forward service. Another protocol, 
Internet Message Access Protocol (IMAP), can be thought of as a remote file 
server. 

POP and IMAP deal with receiving email from your local server; Simple 
Mail Transfer Protocol (SMTP) is a protocol for transferring email between 
points on the Internet. You send email with SMTP and a mail handler 
receives it on your recipient’s behalf. The mail is then read using POP or 
IMAP. 

See also “Internet Message Access Protocol (IMAP)” on page 263 and 
“Simple Mail Transfer Protocol (SMTP)” on page 270. 

PPP 

See Point-to-Point Protocol. 

PPPoE 

See Point-to-Point Protocol over Ethernet. 

RAID 

See Redundant Array of Independent Disks (RAID) 
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Redundant Array of Independent Disks (RAID) 

A redundant array of independent disks is a way of storing the same data in 
different places (thus, redundantly) on multiple hard disks. A RAID appears 
to the operating system to be a single logical hard disk. 

There are a variety of different types and implementations of RAID, each 
with its own advantages and disadvantages. RAID Level 1 (RAID-1), also 
known as disk mirroring, consists of at least two drives that duplicate the 
storage of data. 

Although RAID can protect against disk failure, it does not protect against 
operator and administrator (human) error, or against loss due to 
programming bugs. 

RAID can be implemented in hardware or in software. Hardware RAID is 
always a “disk controller”, that is, a device to which one can cable up the 
disk drives. Software RAID is a set of kernel modules, together with 
management utilities that implement RAID purely in software, and require 
no extraordinary hardware. 

Root name server

On the Internet, the root name server system is the manner in which an 
authoritative master list of all top-level domain names (such as .com, .net, 
.org and individual country codes) is maintained and made available.

SCSI

See Small Computer System Interface (SCSI). 

Secure Sockets Layer (SSL) 

Secure Sockets Layer is a program layer created by Netscape 
Communications for managing the security of message transmissions in a 
network. Netscape’s idea was that the programming for keeping your 
messages confidential ought to be contained in a program layer between 
higher-level protocols (such as HTTP or IMAP) and the TCP/IP layers of the 
Internet. The “sockets” part of the term refers to the sockets method of 
passing data between a client and a server program in a network or between 
program layers in the same computer. 

SSL allows an SSL-enabled server to authenticate itself to an SSL-enabled 
client, allows the client to authenticate itself to the server, and allows both 
machines to establish an encrypted connection. 
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These capabilities address fundamental concerns about communication over 
the Internet and other TCP/IP networks:

• SSL server authentication allows a user to confirm the identity of a 
server. SSL-enabled client software can use standard techniques of 
public-key cryptography to check that a server’s certificate and public ID 
are valid and have been issued by a certificate authority (CA) listed in the 
client’s list of trusted CAs. This confirmation can be important if, for 
example, the user is sending a credit card number over the network and 
wants to check the receiving server’s identity. 

• SSL client authentication allows a server to confirm a user’s identity. 
Using the same techniques as those used for server authentication, SSL-
enabled server software can check that a client’s certificate and public ID 
are valid and have been issued by a certificate authority (CA) listed in the 
server’s list of trusted CAs. This confirmation can be important if, for 
example, the server is a bank sending confidential financial information 
to a customer and wants to check the recipient’s identity. 

• an encrypted SSL connection requires all information sent between a 
client and a server to be encrypted by the sending software and decrypted 
by the receiving software, thus providing a high degree of 
confidentiality. Confidentiality is important for both parties to any 
private transaction. In addition, all data sent over an encrypted SSL 
connection is protected with a mechanism for detecting tampering—that 
is, for automatically determining whether the data has been altered in 
transit. 

See also Authentication and Encryption. 

Server 

A system program that awaits requests from client programs in the same 
computer or across a network, and services those requests. A server can be 
dedicated, in which case this is its sole function, or non-dedicated, where the 
system can be used in other ways, such as a workstation. 

Server Message Block (SMB) 

A protocol that enables client applications in a computer to read and write 
files on a computer network and to request services from server programs in 
a computer network for systems running Microsoft Windows.
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Simple Mail Transfer Protocol (SMTP) 

The TCP/IP standard protocol for transferring electronic mail messages 
between points on the Internet. SMTP specifies how two mail systems 
interact and the format of control messages they exchange to transfer mail. 

SMTP is a protocol for transferring email between points on the Internet; 
Post Office Protocol (POP) and Internet Message Access Protocol (IMAP) 
deal with receiving email from your local server. You send email with SMTP 
and a mail handler receives it on your recipient’s behalf. The mail is then 
read using POP or IMAP. 

See also “Internet Message Access Protocol (IMAP)” on page 263 and “Post 
Office Protocol 3 (POP3)” on page 267.

Simple Network Management Protocol (SNMP) 

A network management protocol used almost exclusively in TCP/IP 
networks. SNMP provides a means to monitor and control network devices, 
and to manage configurations, statistics collection, performance and security 
on a network.

Small Computer System Interface (SCSI) 

A parallel interface standard used by Apple Macintosh computers, PCs and 
many Unix systems for attaching peripheral devices to computers. SCSI 
interfaces provide for faster data transmission rates (up to 80 Mb/s) than 
standard serial and parallel ports. In addition, you can attach many devices to 
a single SCSI port, so that SCSI is really an input/output bus rather than 
simply an interface. Although SCSI is an ANSI standard, there are many 
variations, so two SCSI interfaces can be incompatible. For example, SCSI 
supports several types of connectors. 

SMB

See Server Message Block (SMB).

SMTP

see Simple Mail Transfer Protocol (SMTP).

SNMP 

See Simple Network Management Protocol (SNMP).

SSL

See Secure Socket Layer (SSL).
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Subnet mask 

A number that, in conjunction with an IP address, defines the set of 
IP addresses that are considered “local.” For example, if your IP address is 
192.168.25.77 and your subnet mask is 255.255.255.0, then addresses 
between 192.168.25.1 and 192.168.25.255 are considered local. Also known 
as netmask. 

Swap file 

A space on a hard disk used as the virtual memory extension of a computer’s 
random access memory (RAM). Having a swap file allows the computer’s 
operating system to pretend that it has more RAM than it actually does. The 
least-recently-used files in RAM are “swapped out” to your hard disk until 
they are needed later; in their place, new program segments or data can be 
“swapped in” to RAM. 

Transmission Control Protocol (TCP) 

A connection-oriented transport-layer protocol that provides reliable full-
duplex data transmission. TCP is part of the TCP/IP protocol stack. 

Transmission Control Protocol/Internet Protocol (TCP/IP) 

A common name for the suite of protocols developed in the 1970s to support 
the construction of worldwide internetworks. TCP and IP are the two best-
known protocols in the suite. The TCP/IP protocols enable computers and 
networks to connect to an intranet or Internet. 

Virtual memory 

A concept that, when implemented by a computer and its operating system, 
allows programmers to use a very large range of memory or storage 
addresses for stored data. 

WebMail 

The integrated email client on the Qube 3. 

Wide area network (WAN)

A data communications network that serves users across a broad geographic 
area and often uses transmission devices provided by common carriers. 
Asynchronous transfer mode (ATM), frame relay, Switched Multimegabit 
Data Service (SMDS) and X.25 are examples of WANs.

See also local area network (LAN).
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